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Learn to manage the life of the generated order before it creates or updates an asset.



Release Notes

Review the latest TurboEngines release notes that describe the system requirements and
supported platforms, new features, enhancements, resolved issues, and known issues.

- Spring 21 Release Notes

Spring 21 Release Notes

Conga Release Notes contain the following information about the Conga Order
Management Spring 21 Release.

For more information on new features, enhancements, and document improvements
refer to
- What's New in Administrator Guide in Conga Order Management Spring 21
Administrator Guide or
- What's New in User Guide in Conga Order Management Spring 21 User Guide or
- What's New in SOAP API Guide in Conga Order Management Spring 21 SOAP AP/
Guide.

- Packages: Lists packages that are required to upgrade to this release of the product

- System Requirements and Supported Platforms: Lists requirements and recommendations
for installing this release

- New Features: Provides high-level descriptions of new features introduced in this
release, with links to more detailed information

- Enhancements: Provides high-level descriptions of enhancements to existing features

- Data Model Changes: Lists changes to the data model

- Resolved Issues: Lists customer-reported issues that are resolved in this release or
known issues resolved from previous releases

- Known Issues: Lists known issues that are applicable in this release

This documentation may contain descriptions of software features that are
optional and for which you may not have purchased a license. As a result, your
specific software solution and/or implementation may differ from those described in
this document. Please contact your CSM or AE for information on your specific

features and licensing.


https://documentation.conga.com/display/COMSPR21/What%27s+New+in+Administrator+Guide
https://documentation.conga.com/display/COMSPR21/What%27s+New+in+User+Guide
https://documentation.conga.com/display/COMSPR21/What%27s+New+in+SOAP+API+Guide

Packages

The following packages and dependent packages are required to upgrade to this release

to utilize all the new features of this release. These are the minimum required versions; later

versions are also supported. Separate prerequisites for each feature can be found in the

respective guides. The packages marked as (New) are new packages in this release.

Product

Conga Order Management

Conga Approvals Management (New)
(Required if you are using Approvals)

Conga Base Library (New)
Conga Configuration & Pricing (New)
Conga Contract Lifecycle Management (New)

Conga Contract-Configuration Integration
(Required if you are using CLM)

Conga CPQ API (New)

Conga CPQ Setup (New)
(Required if you are using CPQ Admin Console)

Conga CPQ Approvals Management (New)
(Required if you are using Approvals on CPQ
objects)

Conga Promotion Management
(Required if you are using Promotions)

Conga Proposal Management (New)

(Required if you are using Proposal Management)

Conga Quote Approvals

Latest Certified Version

(Version Name | Version Number)

1.0.0000 1.0
12.0.0221[12.221
2.0.14812.148

13.0.1882[13.1882

12.0.0605 | 12.605

12.0.0136 [ 12.136

13.0.0120 [ 13.120

13.0.97 | 13.97

12.0.0020 [ 12.20

1.0.0000 [ 1.0

11.0.0242 | 11.242

6.5.0004 | 6.4



Product Latest Certified Version

(Version Name | Version Number)

Conga Quote Asset Integration 6.5.0014 | 6.14
Conga Quote CLM Integration (New) 10.0.0069 | 10.69

Conga Quote/Proposal-Configuration Integration 13.0.0354 | 13.354
(New)

(Required if you are using CPQ and Proposal

Management)

Before installing or upgrading Conga managed packages, you must review the
dependency matrix for each managed package. You can refer to the package
dependency matrix at Conga Packages Dependency Matrix.

System Requirements and Supported Platforms

System Requirement Minimum Supported Version
Operating System Standard Salesforce.com requirements. See Salesforce PDF.
Browser Conga supports the following browsers:

-+ Microsoft Edge Chromium
+ Apple Safari

Conga recommends the latest stable version of the
browser for the best performance.

Internet Explorer is not supported.

New Features

There are no new features in this release. keep checking the Conga documentation portal
for updates.


http://salesforce.com/
http://na9.salesforce.com/help/doc/en/salesforce_technical_requirements.pdf
https://documentation.conga.com/display/TECHNOTES/Managed+Packages+Dependency+Matrix

Enhancements

The following section describes existing features that are changed (or are no longer

supported) in this release.

Enhancements to the order status when performing
Order Split

- When the order is split using criteria fields, the status of the parent order is updated
to 'Superseded..

- When the order is split, the child orders are created with the parent order status. For
example, if the status of the parent order is 'Pending’, then the child orders are

created with the status 'Pending’.

Data Model Changes

The following objects and fields are introduced to or changed in the system or data model
in this release.

Object Field Description System/ New/
User Changed
OrderSystemPrope Changed
rties__c
InitiateBillingOnOrd | It initiates the billing User New
erCreation__c on creating an order

Resolved Issues

There are no resolved issues in this release

Known Issues

The following table provides the cumulative Llist of known issues up to this release.



Conga Description
Internal
ID

OM-1034 | Partial orders cannot be created from Customer Purchase Orders when the CPO is in
"Partially Processed" status.

DOC ID: COMSPR21RN20210303



About Order Management

An order is a document that serves as a confirmation of a purchase created for a customer
before delivering goods or services. Conga Order Management allows customer sales and
customer support representatives to manage the life of the generated order before it
creates or updates an asset. Order Lifecycle Management offers a common, streamlined
process for managing orders regardless of the channel used for their creation — direct
sales, partner sales, telesales, digital commerce, and Electronic Data Interchange EDI —
through the lifecycle of the order through fulfillment.

The three main stages of the lifecycle are:

- Order Capture: In this stage, users can create direct orders through the Order
Management interface, create customer purchase orders from a quote, and create
digital commerce orders.

- Order Change: In this stage, users can make changes to the configuration, pricing,
shipping, promotions, change or cancel in-flight orders, and reorder before the order
has created or updated an asset.

- Order Fulfillment Tracking: In this stage, the order is released to multiple fulfillment
systems and locations. Order fulfillment can be tracked and managed at the order
and order line item Llevel.

Conga Order Management allows users to integrate with external systems, including ERP,
logistics and manufacturing, accounting and finance, and warehouse management.

Advanced features within Order Management include the design of custom validation and
enrichment rules for purchase orders, as well as automation of in-flight order changes.

The following diagram shows the interaction with different entities at various stages in the
omni-channel sales process.



Order Management
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Conga Order Management allows a user to perform the following tasks:

Managing order lifecycle and status
- Creating direct orders
- Creating partial orders from a customer price agreement (Quote/Agreement)
- Managing in-flight order changes and cancellation
Managing distributed order fulfillment
- Activating an order
- Billing for an order
- Managing customer purchase orders
- Creating partial and split sales orders from customer purchase orders
- Creating data enrichment and validation rules for partial orders

Conga currently supports order creation through direct and partner sales and digital
commerce interfaces. From the Order Management interface, customer support
representatives can create orders on behalf of customers.

Key Terminology

It is important to understand how terms are used when working with Conga CPQ.

12 Copyright ©2023 Apttus Corporation. All rights reserved.



Term

ABO

Administrators

Assets

Amend Order

Attributes

Bundled Products

Cart

Catalog

Clone

Clone Order

Contract Price List

Description

Asset-based ordering (ABO) functionality enables the customers to
manage their existing subscriptions or install base using actions
such as change, renew, swap, and terminate.

Individual responsible for installing, configuring, and maintaining
Order Management software, including creating direct orders,
customer purchase orders, and managing partial order fulfillment
and automation.

Assets define a purchased product or service. An asset is associated
with an account. After being processed and fulfilled, the line items
associated with new quotes, agreements, or orders result in the
creation of new assets, which can then be viewed or managed from
the customer’s account.

An action a user can take from the order record page. You can use
Amend Order to create a new version of the Order classified as an
amendment with changes to the field values of the order.

Features of a product, such as color, size, weight, and more.

A combination of standalone products that offer added value to
the customer while increasing overall sales.

A product and pricing view for the user to review all configuration
and pricing information at a glance.

A view that allows hierarchical categorization of products for users
to search through and add to their configuration.

To replicate a field, record, template, etc.

An action a user can take from the order record page which creates
a copy of the order record.

A price list that helps the customer keep track of specific price
agreements as applicable for that account.



Term

Customer Purchase Order

In-Flight Order

Order

Order Fulfillment Line Items

Order Line Item

Order Line Item Status

Order Number

Order Source

Order Status

Description

A customer document that represents the initial offer of negotiated
types, quantities, and prices for products or services. Customer
Purchase Orders can be created by sales users or administrators as
sales orders for long-term contracts.

The flow status of an order that is in the process of fulfillment.

A document that serves as a confirmation of a purchase created for
a customer before delivering goods or services. The Order object is
used in Order Management to capture and track orders created
from quotes, agreements, or other sources, such as customer
purchase orders.

A line item on the order record that comprises order fulfillment
information for the record. Order fulfillment line items are displayed
in the Order Fulfillment Line Items related Llist.

A line item on the order record corresponding to a product, bundle,
or service that is part of the order. Order line items are displayed in
the Order Line Items related list.

A column on the Order Line Items related list. This status refers to
the current status of the corresponding line item. The possible
status values are: PartiallyFulfilled, InFulfilment, Pending, Draft,
Accepted, In-Amendment, BeingAmended, Superseded, Activated,
Pending Cancellation, BeingCancelled, Cancelled, and Fulfilled.

The unique ID of an order.

A field on the order record that specifies the source from which an
order is created. For example: Account, Quote, or an Agreement.

A field on the order record that denotes the status of an order that
you have created or updated. The possible status values are:
PartiallyFulfilled, InFulfilment, Pending, Draft, Accepted, In-
Amendment, BeingAmended, Superseded, Activated,
PendingCancellation, BeingCancelled, Cancelled, and Fulfilled.



Term

Partial Order

Price Agreement

Price Lists

Price Matrix (Matrices)

Price Rule

Price Rule Sets

Product

Product Attribute Group

Product Attribute Value

Product Group

Description

An order placed against a price agreement or customer purchase
order for a partial amount of the committed quantities captured for
an order.

An agreement associated with a generated contract price list that
represents the negotiated pricing and quantity commitments for
one or more configurations of products and services.

Containers of items that are grouped in a price list. A price list
controls which products are visible to the end user. A price list
contains several price list items; each linked to a product. A product
can be set up with one or more price list items.

These are an advanced pricing concept used to define tiered pricing
paradigms, or complex pricing structures with multiple criteria.
Common examples are pricing tiers for a product based on user
count or particular customer or transactional dimensions.

Represents a single rule in a price ruleset.

Price Rulesets are a mechanism to allow particular families,
categories or groupings of products to have either line item pricing
adjustments applied or summary pricing adjustments applied.
Typical examples of these are volume discounting rules or
promotional pricing rules.

A product or service that can be sold on its own as a standalone
item, an option of other products, or as part of a bundled product.

Represents a product attribute group that contains attributes
shared by products.

Represents the attribute values for a product class. For example,
color has attribute values such as red, green, blue, orange and so
on.

A logical grouping of one or more product records. This construct
allows you to create combinations of products with similar
characteristics/qualities for use in a Rule.



Term Description

Quote or Proposal A structured definition of a prospective sale that contains product
configurations, pricing, and customer opportunity information.

Standalone Products Refers to a device or software that is self-contained, one that does
not require any other devices or software to function.



What's New in Order Management
Documentation

The following table lists changes in the documentation to support each release.

Spring ‘21
Docum  Topic Description
ent
Spring Configuring Order Updated the Order System Properties table with a new custom
21 Management setting (Initiate Billing On Order Creation).
Custom Settings
Summer ‘20
Docume Topic Description
nt
Summer | Splitting an Order Updated the description of the Manual Split.
2020

REV A



Docume
nt

Summer
2020

Topic

Configuring Order
Management Custom

Settings

Upgrading Apttus Order

Management

Configuring Order workflow
Rule for Split Order

Splitting an Order

Creating Order Workflows
to Automate Split Order

Integrating Apttus with

External Systems

Splitting an Order

Splitting an Order by criteria

Splitting an Order by
threshold

Creating an Order

Creating a Cart for an
Order

Synchronizing a Cart to an
Order

Order Web Service

Accepting an Order

Description

Updated the Order System Properties table with new
custom settings (Split Order Criteria Fields & Split Order
Threshold).

Updated topic with the specific upgrade information.

New Topic describing how to add Split Order
to the Action field in the Order Workflow Rule Detail page.

New Topic.

New Topic.

New Topic.

New Topic.
New Topic.

New Topic.

Updated Topic.

Updated Topic.

Updated Topic.

Updated Topic.

Updated Topic.


https://documentation.conga.com/display/OMSFSUM20AG/Configuring+Order+Management+Custom+Settings
https://documentation.apttus.com/display/OMSFSUM20AG/Upgrading+Apttus+Order+Management
https://documentation.apttus.com/display/OMSFSUM20AG/Configuring+Order+workflow+Rule+for+Split+Order
https://documentation.apttus.com/display/OMSFSUM20APIG/Integrating+Apttus+with+External+Systems
https://documentation.apttus.com/display/OMSFSUM20APIG/Splitting+an+Order
https://documentation.apttus.com/display/OMSFSUM20APIG/Splitting+an+Order+by+criteria
https://documentation.apttus.com/display/OMSFSUM20APIG/Splitting+an+Order+by+threshold
https://documentation.apttus.com/display/OMSFSUM20APIG/Creating+an+Order
https://documentation.apttus.com/display/OMSFSUM20APIG/Creating+a+Cart+for+an+Order
https://documentation.apttus.com/display/OMSFSUM20APIG/Synchronizing+a+Cart+to+an+Order
https://documentation.apttus.com/display/OMSFSUM20APIG/Order+Web+Service
https://documentation.apttus.com/display/OMSFSUM20APIG/Accepting+an+Order

Docume
nt

Spring '20

Topic

Cancelling an Order
Reverting a Cancelled Order
Cloning an Order

Customer Purchase Order
(CPO) Web Service

Accepting Customer

Purchase Orders

Amending Customer

Purchase Orders

Reverting Amended

Customer Purchase Orders

Cancelling Customer

Purchase Orders

Reverting Cancelled

Customer Purchase Orders

Creating Orders from PO

Description

Updated Topic.

Updated Topic.

Updated Topic.

Updated Topic.

Updated Topic.

Updated Topic.

Updated Topic.

Updated Topic.

Updated Topic.

Updated Topic.


https://documentation.apttus.com/display/OMSFSUM20APIG/Cancelling+an+Order
https://documentation.apttus.com/display/OMSFSUM20APIG/Reverting+a+Cancelled+Order
https://documentation.apttus.com/display/OMSFSUM20APIG/Cloning+an+Order
https://documentation.apttus.com/display/OMSFSUM20APIG/Customer+Purchase+Order+%28CPO%29+Web+Service
https://documentation.apttus.com/display/OMSFSUM20APIG/Accepting+Customer+Purchase+Orders
https://documentation.apttus.com/display/OMSFSUM20APIG/Amending+Customer+Purchase+Orders
https://documentation.apttus.com/display/OMSFSUM20APIG/Reverting+Amended+Customer+Purchase+Orders
https://documentation.apttus.com/display/OMSFSUM20APIG/Cancelling+Customer+Purchase+Orders
https://documentation.apttus.com/display/OMSFSUM20APIG/Reverting+Cancelled+Customer+Purchase+Orders
https://documentation.apttus.com/display/OMSFSUM20APIG/Creating+Orders+from+PO

Docume
nt

Spring
20

Topic

Upgrading Apttus Order

Management

Displaying Order Fulfillment

Line Items for an Order

Configuring Order Workflow

Rulesets

About Order Management

Creating Order Workflows
to Automate In-Flight Order
Changes

Creating Data Enrichment

and Validation Rules

Order Management for

Users

About Order Management
Getting Started

AP| Supported Packages
AP| Reference

Creating an Order

Creating a Cart for an
Order

Synchronizing a Cart to an
Order

Description

Updated topic with specific upgrade information and

cross-reference to CPQ topic.

Updated task topic steps.

New topic describing how to add the required buttons for
configuring workflow rulesets.

Updated topic with additional key terminology.

Updated topic with additional contextual information
and tasks. Added a workflow ruleset use case.

Updated topic to include a detailed use case.

Updated topic.

Updated topic.

Renamed topic from "Overview." Updated topic.
Deleted topic.

Updated topic.

Updated topic.

Updated topic.

Updated topic.


https://documentation.conga.com/display/OMSFSUM20AG/Upgrading+Apttus+Order+Management
https://documentation.conga.com/display/OMSFSUM20AG/Displaying+Order+Fulfillment+Line+Items+for+an+Order
https://documentation.conga.com/display/OMSFSUM20AG/Configuring+Order+Workflow+Rulesets

Docume
nt

Topic

Accepting an Order

In-Flight Order Changes and
Cancellation

Amending an Order using
API

Reverting an Amendment to

an Order

Cancelling an Order using
API

Reverting a Cancelled Order

Cloning an Order using
SOAP API

Fetching Price Agreements

Fetching Price Agreement

[tems

Creating a Partial Order

from a Quote or Agreement
Creating a Direct Order
Executing Order Workflow

Customer Purchase Order
(CPO) Web Service

Accepting Customer

Purchase Orders

Amending Customer

Purchase Orders

Description

Updated topic.

New contextual parent topic for Amend Order, Undo

Amend Order, and Cancel Order APIs.

Updated topic.

New topic. Content is taken from "Amending an Order."

Updated topic.

New topic. Content is taken from "Cancelling an Order."

Updated topic.

Updated topic.

Updated topic.

Renamed topic. Updated topic.

Updated topic.
Updated topic.

Updated topic.

Updated topic.

Updated topic.



Docume Topic Description

nt
Reverting Amended Updated topic.
Customer Purchase Orders
Cancelling Customer Updated topic.
Purchase Orders
Reverting Cancelled Updated topic.
Customer Purchase Orders
Creating Orders from PO Updated topic.
Winter '19
Docume Topic Description
nt
Winter Order Management for Update topic.
2019 Administrators
(1903)

About Order Management Updated topic.

Getting Started Deleted topic.

Setting Up Order New topic to replcce deleted topic "Getting Started."
Management Updated topic content.

Installing Order Updated topic. Moved topic under "Setting Up Order
Management Management.”

Logging in to Order New topic.

Management

Configuring Order New topic.

Management


https://documentation.conga.com/display/OMSFSUM20AG/Setting+Up+Order+Management
https://documentation.conga.com/display/OMSFSUM20AG/Installing+Order+Management
https://documentation.conga.com/display/OMSFSUM20AG/Logging+in+to+Order+Management
https://documentation.conga.com/display/OMSFSUM20AG/Configuring+Order+Management

Docume
nt

Topic

Configuring Order
Management Custom

Settings

Configuring Order

Management Status

Upgrading Apttus Order

Management
Partial Order Fulfillment

Displaying Order Fulfillment

Line Items for an Order

Configuring In-Flight Order

Changes and Cancellation

Automation of In-Flight
Order Changes

Configuring the Direct Order
Workflow

Setting Up Partial Orders

from Price Agreements

Configuring the Contract
Price List for Orders With

Commitment Compliance

Setting Up Customer

Purchase Orders

Setting Up Purchase Order
Admin

Description

New topic.

New topic.

New topic.

Deleted topic.

New topic.

Topic renamed from "In-Flight Order Changes." Updated
topic. Merged content that was previously part of the
deleted topic "Automation of In-Flight Order Changes."

Deleted topic.

Topic renamed from "Direct Order Configurations.”
Updated topic.

Topic renamed from "Generating Partial Orders from
Quote or Agreement." Update topic.

Topic renamed from "Generating Contract Price List."
Updated topic.

Topic renamed from “Create Customer Purchase Order
and Customer Purchase Order Items." Updated topic.

New topic for configuring the PO Admin (Admin Ul for
creating Enrichment and Validation Rules for Purchase
Orders).


https://documentation.conga.com/display/OMSFSUM20AG/Configuring+Order+Management+Custom+Settings
https://documentation.conga.com/display/OMSFSUM20AG/Configuring+Order+Management+Status
https://documentation.conga.com/display/OMSFSUM20AG/Upgrading+Apttus+Order+Management
https://documentation.conga.com/display/OMSFSUM20AG/Displaying+Order+Fulfillment+Line+Items+for+an+Order
https://documentation.conga.com/display/OMSFSUM20AG/Configuring+In-Flight+Order+Changes+and+Cancellation
https://documentation.conga.com/display/OMSFSUM20AG/Configuring+the+Direct+Order+Workflow
https://documentation.conga.com/display/OMSFSUM20AG/Setting+Up+Partial+Orders+from+Price+Agreements
https://documentation.conga.com/display/OMSFSUM20AG/Configuring+the+Contract+Price+List+for+Orders+With+Commitment+Compliance
https://documentation.conga.com/display/OMSFSUM20AG/Setting+Up+Customer+Purchase+Orders
https://documentation.conga.com/display/OMSFSUM20AG/Setting+Up+Purchase+Order+Admin

Docume
nt

Topic

About This Guide

About Order
Management

Order Management in the
Quote-to-Cash Process

Getting Started

Logging in to Order
Management

Navigating the Order
Management User
Interface

Understanding the Order
Management Lifecycle

Order Status
Order Line Item Status

Understanding Order
Status

Capturing Orders

Creating Orders from
Quotes

Creating E-Commerce
Orders

Creating Direct Orders for
Accounts

Description

Updated topic.

Updated topic.

Deleted topic.

Deleted topic.

New topic (replaced "Getting Started").

New topic.

Topic renamed from "Getting Around with Order Lifecycle
and Status." Updated topic.

Deleted topic.
Deleted topic.

New topic (replaced "Order Status" and "Order Line Item
Status").

Updated topic.

Deleted topic. This information refers to a CPQ process.

Deleted topic. This information is redundant and covered
in the API Guide.

Updated topic.



Docume
nt

Topic

Configuring and Pricing

Orders

Finalizing Configurations

Confirming Orders

Legal Entity on Order Line

[tem

Cloning an Order

Managing In-Flight Order

Changes and
Cancellation

Amending an Order

New Ul for Amend Order

Cancelling an Order

Creating Order
Workflows to Automate
In-Flight Order Changes

Versioning of an Order

Sample Scenarios for
Amending Orders Using
Workflow Rules

Order Management
Workflows

Agreement to Order

Description

Deleted topic. Note on configuring and pricing added

to Creating Direct Orders for Accounts.

Deleted topic.

Deleted topic. Content added to parent topic.

Deleted topic. Content added to Activating an Order.

Updated topic.

Updated topic.

Renamed topic from "Changing an In-flight Order."
Updated topic.

Deleted topic.

Updated topic.

Renamed and updated topic.

Deleted topic. Content added to "Managing In-Flight
Order Changes."

New topic. Content moved from Admin Guide.

Deleted topic.

Deleted topic. This is a CLM task.



Docume
nt

Topic

Quote to Order

Direct Order
Configuration

Asset Manager

Total Order Amount on
Order Header

Working With Customer
Price Agreements

Creating Partial Orders
from Price Agreements

View List of Quotes/
Agreements

View List of Line
Agreements from Price
Agreements

Rollup Order Line Item

Information to Agreement

Line ltem

Rollup Order Line Item

Information to Quote Line

[tem

Creating Partial Order
from Agreement
Enhancements

Working With Distributed
Order Fulfillment

Description

Deleted topic. This is a CPQ task.

Deleted topic. Content added to Creating Direct Orders for

Accounts and Releasing Orders to Fulfillment Systems.

Deleted topic.

Deleted topic. Content added to Capturing Orders.

Renamed and updated topic.

Renamed topic.

Deleted topic.

Deleted topic.

Deleted topic. Content added to Creating Partial Orders

from Price Agreements.

Deleted topic. Content added to Creating Partial Orders

from Price Agreements.

Deleted topic. Content added to Working With Customer

Price Agreements.

Updated topic.
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Topic

Releasing Orders to

Fulfillment Systems

Tracking Order
Fulfillment

Order Fulfillment

Order Fulfillment Line
[tems

Order Fulfillment Line
ltem Lifecycle

Activating an Order

Billing for an Order

Working with Customer

Purchase Orders

Understanding Customer

Purchase Order Status

Managing CPO
Validation and
Enrichment Rules

Creating Data
Enrichment and
Validation Rules

Creating Rulesets

Creating Rules

Description

Renamed topic. Updated topic.

Renamed topic. Updated topic.

Deleted topic. Content added to Releasing Orders to
Fulfillment Systems.

Deleted topic. Content added to Releasing Orders to
Fulfillment Systems.

Deleted topic. Content added to Releasing Orders to
Fulfillment Systems.

Updated topic.

Updated topic.

Updated topic.

Renamed topic from "Customer Purchase Order and PO

ltem Status Mapping." Updated topic.

Updated topic.

Renamed topic from "Creating Rulesets." Updated topic.

Deleted topic. Content added to Creating Data Enrichment

and Validation Rules

Deleted topic. Content added to Creating Data Enrichment

and Validation Rules
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Mitigating Data Updated topic.
Validation Issues

Creating Customer Updated topic.
Purchase Orders

Accepting Customer Renamed topic from "Confirming or Accepting Draft
Purchase Orders Customer Purchase Orders." Updated topic.
Amending Customer Updated topic.

Purchase Orders

Cancelling Customer Updated topic.
Purchase Orders

Creating Sales Orders Renamed topic from "Managing Customer PO." Updated
from a Customer topic.
Purchase Order

Creating a Single Order Updated topic.

Creating Multiple Sales Updated topic.
Orders

Creating Partial Orders Updated topic.

About Order Updated topic.

Management

Overview Updated topic.

Document Setup Deleted topic. Will be added back when scenarios are
documented.

API Supported Packages Updated topic. Updated table to reflect the latest
package versions.

Summer '19



Document Topic
Summer 2019 (1902) Automation of In-Flight Order
Changes

Spring 19

Documen
t

Spring
2019 (19071)

Winter '18

Documen
t

Winter
2018 (1803)

Summer '18

Creating Order Workflow to
Automate In-flight Order
Changes

Executing Order Workflow

Topic Description

Description

New topic. New feature for this
release.

New topic. New feature for this
release.

New topic. New feature for this
release.

No updates No new topics are added for this release. The guide is

updated to reflect product name changes.

Topic Description

Total Order Amount on New topic. New feature for this release.

Order Header

Legal Entity on Order Line New topic. New feature for this release.

[tem

Creating Partial Order from | New topic. New feature for this release.

Agreement Enhancements
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Summer Generating Partial Orders from Updated admin level settings for generating
2018 Quote or Agreement partial orders from agreements/quotes.
(1802)

Create Customer Purchase Order New topic. New feature for this release.
and Customer Purchase Order Items

Managing CPO Validation and New topic. New feature for this release
Enrichment Rules

Mitigating Data Validation Issues New topic. New feature for this release

Managing Customer PO New topic. New feature for this release

Order Fulfillment Line Item Lifecycle New topic. New feature for this release

Creating Customer Purchase Orders New topic. New feature for this release

Creating Particl orders from New topic. New feature for this release
Customer Price Agreement (Quote/

Contract)

Intelligent Order Assistant (Max for New topic. New feature for this release

OM)



Order Management for Administrators

This guide is designed to provide administrators with information on configuring Conga

Order Management for use by sales and customer support representatives. This guide

covers the most common use cases for Conga Order Management Administration and

assumes a level of familiarity with basic Salesforce and Conga CPQ.

Topic

What's Covered

Primary Audience

IT Environment

Updates

Other Resources

Description

This guide wallks the Order Management Administrators through the entire
process of installing and configuring Conga Order Management. It provides
conceptual information, step-by-step instructions, and use cases for the
administration tasks provided by Conga Order Management.

Order Management Administrators.

Refer to the latest Order Management Release Notes for information on
System Requirements and Supported Platforms.

For a comprehensive list of updates to this guide for each release, see the

What's New in Order Management Documentation topic.

- Conga Order Management Summer 2020 User Guide: Refer to this
guide for installing and setting up Order Management in your
organization.

- Conga Order Management Summer 2020 Release Notes: Refer to this
guide for the new feature, enhancements, resolved, and known issues.

- Conga Order Management Summer 2020 SOAP API Guide: Refer to
this guide for documentation of public-facing SOAP APIs for Order
Management.

- Conga CPQ Administrator Guide: Refer to this guide for setting up
products, price lists, and constraint rules.

This guide describes the following tasks:

- Installing Order Management

- Configuring Order Management settings

- Enabling and configuring settings for In-Flight Orders

- Automating In-Flight Order changes
- Configuring Direct Order settings (CPQ)
- Configuring settings for capturing orders from Price Agreements

- Configuring quotes and agreements to use a Contract Price List for Price Agreement

orders



- Configuring Customer Purchase Order and Customer Purchase Order Item settings
- Configuring Custom Purchase Order Admin settings

Before using Order Management, you must be familiar with the following:

- Basic Salesforce administration knowledge
- Conga CPQ and Conga CLM administration
- Salesforce and Conga terms and definitions

Select one of the following topics for more informaction:

- Setting up Order Management

-+ Configuring In-Flight Order Changes and Cancellation
- Configuring the Direct Order Workflow

- Setting Up Partial Orders from Price Agreements

- Setting Up Customer Purchase Orders

- Appendices

Setting up Order Management

Conga Order Management setup requires you to install the Order Management package
on Salesforce and configure a custom setting for Order Management. The following topics
provide step-by-step instructions for setting up Order Management.

Before You Begin

Before configuring Order Management settings, make sure you are familiar with custom
and admin settings for Conga Configure-Price-Quote (CPQ). Refer to the CPQ Administrator
Guide for details.

Installing Order Management

Refer to the latest Order Management Release Notes for information on the packages
required to install Conga Order Management.

Prerequisites

To use Conga Order Management, you must perform the following tasks prior to installing
the Order Management package:



1.

Enable Salesforce CRM Content: Refer to the CPQ Administrator Guide for steps to
perform this task.

Install other Conga packages: Conga Order Management requires packages to be
installed for Conga CPQ, as well as packages for any other Conga applications
(such as Approvals, Contract Lifecycle Management, and so on) that you plan to use
in conjunction with Order Management. Refer to the latest Order Management
Release Notes and the CPQ Administrator Guide for which packages are required.

Conga recommends downloading and upgrading Conga packages in a Salesforce
sandbox before installing them in your production environment. For information on
installing and upgrading in a sandbox, please contact Conga Support before you

install any packages.

The Conga Push Upgrade is an automated tool that upgrades packages available
in your Salesforce org (Production or Sandbox) to the latest versions. In addition, it
ensures all the Conga published managed packages are on the latest versions for
the registered orgs. To register your org for push upgrade, see Registering for Conga

Push Upgrade.

To install the Order Management package

P w N~
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Go to the Resources > Install Center tab on the Conga Community Portal.
In the My Packages navigation link, click Conga Order Management.
Click Install Now.
Select the environment where you want to install the package:
- Click Install in Production to install the packages in your production
environment.
- Click Install in Sandbox to install the package in your sandbox.
Log in to Salesforce.
On the Upgrade page, enter the password provided by Conga.
Conga recommends that you select Install for All Users.
If you want to Install for Specific Profiles, you must define the access level for all
profiles. Select from one of the following options:
- No Access: This is the default setting. Apply this access level to disable all
object permissions.
- Full Access: Apply this access level to assign users permissions to Read, Create,
Edit, Delete, View All, and Modify All for all objects in the Order Management
package.

. Click Set.
. Click Upgrade.


https://community.conga.com/

Registering for Conga Push Upgrade

You can register your org for Conga Upgrade Program to auto-upgrade Conga managed

packages. Conga Upgrade Program supports upgrading from the Spring '18 release or later

to the latest major release (n) or previous two major releases (n -1or n-2).

To register your org with Conga Upgrade Program for

auto-upgrade

This section provides a high-level flow of the org registration process and early feedback

programs. Refer to Conga Upgrade Program documentation for a comprehensive overview

of features.

1.
2.

Launch the Conga Upgrade Program's registration page.

Select your Salesforce org type (Production or Sandbox). The Salesforce login page is
displayed.

Enter your credentials and click Login. You are redirected to the connected app
called Conga Push Upgrade CA, which prompts you to allow access to the org
information.

Click Allow. The org registration form is displayed.

Click Set Package Access Control to set the accessibility for Conga packages to be
upgraded with Conga Upgrade Program.

. Click Submit.

The Early Feedback pop-up is displayed. In addition, Conga sends an email
notification to the system administrator on successful registration with a list of
packages (including dependent packages, if any) handled in the upgrade process.

The early feedback program executes a test suite to check if the
customizations in your org are compatible with the upgrade. For more
information, see the Conga Automation Early Feedback program.

Click Try Now. A Conga Automation Dashboard is displayed with a Quick Guide pop-
up. Click Yes to go through the quick tour of the dashboard.

Click Click to see the test to view a list of tests to be executed for your org, A List of
Tests pop-up is displayed.

Enter your Email ID and Organization Name. You can enter multiple email ids.

. Click Trigger Welcome Email. Conga sends a welcome email to the email ids entered

in the previous step with a list of tests performed in the early feedback program.


https://pushupgrades.congacloud.com
https://documentation.conga.com/push-upgrade/summer-21/conga-automation-early-feedback-program-152572477.html

11. Click Proceed. A Conga Services Test Automation Execution Page is displayed.
12. Click the checkbox next to the Job ID and click Begin Test Execution to run the
predefined automated test suite against your org.

For the latest information on Conga Upgrade Program, see Conga Upgrade Program

documentation.

Logging Into Order Management

Log in to your Salesforce.com org to access Conga Order Management.

Do not use the Back button on your browser when using Order Management.

Before logging in to Order Management, make sure you meet the following criteria:

- You have installed all required Order Management packages (included Conga CPQ
packages, and packages for other integrated Conga applications).

- You have administrative privileges.

- You have login credentials provided by Conga.

To log in to Order Management

1. Go to https://salesforce.com/.
Or
If your organization is using a sandbox or test environment to access Conga Order
Management (for example, if you are doing user acceptance testing), go to https://
test.salesforce.com/ instead.

2. From the toolbar at the top of the page, click Login. The login page opens.

w

Enter your user name and password, and click Log in.

4. Navigate to the Conga Order Management:

- In Salesforce Classic: Click the App Menu and select Conga Order
Management.

- In Salesforce Lightning Experience: Click the App Launcher and select Conga
Order Management.

Configuring Order Management Status

To ensure that the Order Management flow assigns the correct status for orders at
different stages of the lifecycle, you must add and configure all applicable statuses for the
Order and Order Line Item objects.


https://documentation.conga.com/push-upgrade/2022.4.0/conga-upgrade-program-193698855.html
http://Salesforce.com
https://salesforce.com/
https://test.salesforce.com/

To configure Order object status

o

From the Order tab, go to Quick Access > View Fields.
From Custom Fields & Relationships, click Status.
Click New. The Status Picklist Values page is displayed.

a. In the picklist entry field, enter the following status values: Pending, Activated,
Fulfilled, Cancelled, Superseded, Draft, Partially Fulfilled, In Fulfillment, In
Amendment, Being Amended, Pending Cancellation, Being Cancelled,
Processing, and Completed.

Click Save.

Next to the Draft status, click Edit.

From the Picklist Edit page click the check box Make this value default for the master
picklist.

Click Save.

To configure Order Line Item object status

>N~
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8.

Go to Setup > Objects > Order Line Item.

From Custom Fields & Relationships, click Status.

Click New. The Status Picklist Values page is displayed.

In the picklist entry field, enter the following status values: Pending, Activated,
Fulfilled, Cancelled, Superseded, Draft, Partially Fulfilled, In Fulfillment, In
Amendment, Being Amended, and Pending Cancellation.

Click Save.

Next to the Draft status, click Edit.

From the Picklist Edit page, select the check box Make this value default for the
master picklist.

Click Save.

For detailed descriptions of Order and Order Line Item statuses, refer to the topic

"Understanding Order Status" in the Order Management User Guide.

Configuring Order Management

Post-installation settings are part of your specific business requirements, meaning that

your implementation of Conga Order Management will work out-of-the-box, but you can

further customize the implementation using custom settings.



Refer to the topic "Recommended Post-Installation Configuration” in the CPQ Administrator

Guide for detailed post-installation configuration steps for Conga CPQ (required to support

Order Management).

Configuring Order Management Custom Settings

Use Order Management custom settings to configure various features of Order

Management.

To access Order custom settings, go to Setup > Custom Settings > Order System Properties.

Configure the following Order Management custom settings for your organization.

Setting

Initiate Billing On Order Creation

Initiate Billing On Order Activation

Create Asset On Order Activation

Enable Inflight Changes And

Cancellation

Agreement Fields For Partial Order2

Agreement Fields For Partial Order

Agreement Item Fields For Partial
Order2

Agreement Item Fields For Partial
Order

Description

Indicates whether billing should be initiated on order
creation.

Indicates whether billing should be initiated on order
activation.

Indicates whether asset creation is delayed until order
activation.

Indicates whether inflight order changes and
cancellation are enabled.

Enter the list of field APl names from the agreement
object for display when creating partial orders. Each
field may be separated by a comma or a new line.

Enter the list of field APl names from the agreement
object for display when creating partial orders. Each
field may be separated by a comma or a new line.

Enter the list of field APl names from the agreement line
item object for display when creating partial orders.
Each field may be separated by a comma or a new line.

Enter the list of field APl names from the agreement line
item object for display when creating partial orders.
Ecch field may be separated by a comma or a new line.



Setting Description

Quote Fields For Partial Order2 Enter the list of field APl names from the quote/proposal
object for display when creating partial orders. Each
field may be separated by a comma or a new line.

Quote Fields For Partial Order Enter the list of field APl names from the quote/proposal
object for display when creating partial orders. Each
field may be separated by a comma or a new line.

Quote Item Fields For Partial Order2 Enter the list of field APl names from the proposal line
item object for display when creating partial orders.
Each field may be separated by a comma or a new line.

Quote Item Fields For Partial Order Enter the list of field APl names from the proposal line
item object for display when creating partial orders.
Each field may be separated by a comma or a new line.

Split Order Criteria Fields Enter the list of field APl names from Order line item
objects to split items added during a large order process
into multiple orders. Separate each field with a comma
or a new line.

Split Order Threshold Indicates the maximum number of a bundle or
standalone products (represented as line numbers) that
may be added to a split order. Defaults to 100.

Displaying Order Fulfillment Line Items for an Order

By default, the Order Fulfillment Line Items related list is not displayed on the Order page.
Perform the following task to add the related list to the Order page layout.

To display the Order Fulfillment and its line Items for an order

On the Order Detail page, go to Edit Layout.

In the Order Layout, select Related Lists.

Drag-and-drop the Order Fulfillment Line Items related list onto the page layout.
Click Save.

P w N —

For details about Partial Order Fulfillment, refer to Order Management User Guide.



Upgrading Order Management

This section provides information for upgrading Conga Order Management to the latest
version from the previous release.

If you have not installed Conga Order Management, you can contact Conga
Support to request an installation link, then perform the standard installation as

described in Installing Order Management.

The Conga Push Upgrade is an automated tool that upgrades packages available
in your Salesforce org (Production or Sandbox) to the latest versions. In addition, it
ensures all the Conga published managed packages are on the latest versions for
the registered orgs. To register your org for push upgrade, see Registering for Conga
Push Upgrade.

You must install the Conga Base Library package first when you upgrade Conga
Order Management to Spring 21.

Preparing for Upgrade

Before you upgrade to Order Management to Spring 21 release, you must ensure the
following:

- You have referred to the Order Management Features by Release to learn about any new
features.

- You have supported platforms and system requirements.

- You have access to the Install Center on the Apttus Community Portal.

- You have administrator privileges for your Salesforce org.

- You need not back up your configurations. All configurations you performed since you
installed the existing release will remain intact after the upgrade.

Upgrading to Order Management Spring 21 release

This section describes step-by-step instructions to upgrade from Summer 2020 to Spring21
release.

Upgrading to Conga Order Management Spring 21 release.


https://documentation.conga.com/display/OMSFDCFBR/Conga+Order+Management+Features+by+Release
https://documentation.conga.com/display/TECHNOTES/System+Requirements+and+Supported+Platforms+Matrix
https://community.apttus.com/

1. Go to Setup > Installed Packages and ensure that your current Salesforce org has the
following Summer 2020 packages installed.

Product Version Name | Version Number
Apttus Order Management 1.0.0000 | 1.0
Apttus Approvals Management 11.1.0136 | 11.136

(Required if you are using Approvals)

Apttus Base Package 1177 1177
Apttus Configuration & Pricing 12.11751 ] 12,1751
Summer 2020
Apttus Contract Management 11.1.0532 [ 11.532
Apttus Contract-Configuration Integration 12.0.0130 | 12.130

(Required if you are using CLM)
Apttus CPQ API 12.1.0101 | 12.101

Apttus CPQ Admin 12.1.61] 12.61
(Required if you are using CPQ Admin Console)

Apttus CPQ Approvals Management 11.0.0016 | 11.16
(Required if you are using Approvals on CPQ

objects)

Apttus Promotion Management 1.0.0000 1.0

(Required if you are using Promotions)

Apttus Proposal Management 10.1.0221110.221
(Required if you are using Proposal

Management)

Apttus Quote/Proposal Approvals 6.5.0004 | 6.4
Management

Apttus Quote/Proposal-Asset Integration 6.5.0014 | 6.14



Product Version Name | Version Number

Apttus Quote/Proposal-Contract Integration 9.1.0057 | 9.57

Apttus Quote/Proposal-Configuration 12.1.0325 [ 12.325

Integration
(Required if you are using CPQ and Proposal
Management)

2. Ensure that you have the following packages and dependent packages to upgrade to

Spring 21 release. These packages are required to utilize the new features and

enhancements of Spring 21.

Product

Conga Order Management

Conga Approvals Management
(Required if you are using Approvals)

Conga Base Library
Conga Configuration & Pricing
Conga Contract Lifecycle Management

Conga Contract-Configuration Integration
(Required if you are using CLM)

Conga CPQ API

Conga CPQ Setup
(Required if you are using CPQ Admin Console)

Conga CPQ Approvals Management
(Required if you are using Approvals on CPQ
objects)

Conga Promotion Management
(Required if you are using Promotions)

Latest Certified Version

(Version Name | Version Number)

1.0.0000 1.0

12.0.022112.221

2.0.148|2.148

13.0.1882 | 13.1882

12.0.0605 | 12.605

12.0.0136 | 12.136

13.0.0120 | 13.120

13.0.97113.97

12.0.0020 | 12.20

1.0.0000 1.0



Product Latest Certified Version

(Version Name | Version Number)

Conga Proposal Management 11.0.0242 | 11.242
(Required if you are using Proposal

Management)

Conga Quote Approvals 6.5.0004 | 6.4
Conga Quote Asset Integration 6.5.0014 | 6.14
Conga Quote CLM Integration 10.0.0069 | 10.69
Conga Quote/Proposal-Configuration 13.0.0354 | 13.354
Integration

(Required if you are using CPQ and Proposal
Management)

3. Perform the upgrade. The upgrade procedure is the same as the installation
procedure.
4. After the upgrade is complete, perform the post-upgrade tasks.

Performing the Post-Upgrade Tasks

Refer to the topic Upgrading CPQ in the CPQ Administrator Guide for information on required
post-upgrade tasks.

Configuring In-Flight Order Changes and
Cancellation

An In-Flight Order refers to an order that has been confirmed but has not yet reached
fulfillment. By default, Conga Order Management does not have this functionality enabled.
You can also configure Workflow Rulesets to automate the execution of workflows for In-
Flight Orders Changes and Cancellation.

To enable In-Flight Order Changes and Cancellation, you must configure and make
additions or changes to system properties, custom and object settings, and page layouts.


https://documentation.conga.com/display/CPQSPR21/Upgrading+CPQ

To configure In-Flight Order Change and

Cancellation settings

Perform the tasks in the following table in the order described:

Configuration

1. Enable In-Flight
Changes and
Cancellation

2. Change the flow for
the Amend Order

action (optional if you
want a different flow)

Description

N

o o

Go to Setup > Custom Settings > Order System Properties.
Click Manage.

Click the Edit Link to the left of System Properties.

Click the checkbox next to Enable Inflight Changes and
Cancellation.

Click the checkbox next to Create Asset on Order Activation?
Click Save.

. Go to Setup > Create > Objects > Order (Managed) > Configure

Products (NG).

Click Edit.

Under Formula Options, copy the formula.

Go back to Order object. From Custom Fields & Relationships click
New.

Click the Formula radio button, then click Next.

Enter a Field Label. Press tab to automatically populate the Field
Name based on the label you entered. Select the Text radio
button, then click Next.

Configure the Formula that defines this field. For example:

IF ( LEN( Apttus_Config2__PricelListId__c ) > 0 ,
HYPERLINK(" /apex/Apttus_Config2__OrderAmend?id=" &Id &
"&flow=NGDefault", IMAGE("/resource/
Apttus_Config2__Button_Configure'", "Configure
Products"),"_self"), NULL)

Click Check Syntax to test the formula for errors.
Click Next. The Establish field-level security page is displayed.
Make changes to field-level security as needed. Click Next.

. Select the page layout that should include this field and click

Save.

For more information about Flow Settings, refer to the latest CPQ
Administrator Guide.



Configuration

3. Display the Cancel
Order Lines action on
the cart

4. Add the Deleted
value to the Pricing
Status field in the Line
Items (Cart Line Item)
object

5. Add the Amend
Order, Undo Amend
Order, Cancel Order,
and Undo Cancel
Order actions to the
Order Detail page

6. Expose version
details information on
order and order line
items

7. Display the Change
Status field on the
Order Line items
related list

Description

Specify the Order Line Item and Order Line Status in the Config System
Properties or include them in the Display Column settings for c flow.

Go to Config Settings > System Properties > View Cart Custom Fields
and set the APl names as follows:

- Apttus_Config2__OrderLineltemld__c
- Apttus_Config2__OrderLineStatus__c
- Apttus_Config2__Quantity__c

Go to Config Settings > Display Column Settings > Select the Display
Type and Flow > Add Order Line Item and Order Line Status and Save
the custom settings.

Go to Setup > Create > Objects > Line Item (Managed).
Edit the Pricing Status field.

Under Values, click New.

Add Deleted as a picklist value and click Save.

N

Go to Order Detail page > Edit Layout > Order Layout > Buttons >
Search the required button > Drag and drop the button to the relevant
section in order to make the following buttons available on the Orders Ul
and click Save.

- Amend Order
- Undo Amend Order
- Cancel Order
- Undo Cancel Order

Go to the Order Detail page > Edit Layout > Order Layout > Fields.
Drag and drop the Next Version field onto the appropriate section.
Repeat step 2 for Previous Version, and Version Number.

Click Save.
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. Go to the Order Line Item Detail page > Edit Layout > Order Line
ltem Layout > Fields.
2. Drag and drop the Change Status field onto the appropriate
section.
3. Click Save.



Configuration Description

8. Add the In 1. Go to Setup > Create > Objects > Product Configuration
Amendment value to (Managed).

the Status field in the 2. Edit the Status field.

Product Configuration 3. Under Values, click New.

object 4. Add In Amendment as a picklist value and click Save.

Configuring Automation for In-Flight Order
Changes and Cancellation

In-Flight Order Changes and Cancellation can be automated through the use of Order
Workflow Rulesets and Rules that define when to automatically amend or cancel orders
based on specified criteria. No additional configuration is required to make Workflow
Rulesets available to users of Order Management.

Refer to the Order Management User Guide for step-by-step instructions and examples of
workflow automation rules. For detailed information on invoking the execOrderWorkflow API,
refer to the Order Management APl Guide.

Configuring Order Workflow Rulesets

You can create and define rules under Order Workflow Rulesets to automate In-Flight
Orders for certain business scenarios. The Order Workflow Ruleset object is included with
Order Management out of the box but requires some configuration in order for you to create
and manage rulesets.

Perform the following tasks to set up Order Workflow Rulesets.

For your convenience in creating rules, you can add the Order Workflow Rulesets tab
to your default view as you would add any other object tab.

Configuration Description

Add the Criteria button to the 1. Go to Order Workflow Ruleset > Edit Layout > Order
Order Workflow Ruleset Detail Workflow Ruleset Layout > Buttons.

page 2. Drag and drop the Criteria button to the Custom Buttons

area in the layout.
3. Click Save.


https://documentation.apttus.com/display/OMSFSUM20APIG/Executing+Order+Workflow

Configuration Description

Add the Item Criteria and ltem 1. Go to Order Workflow Rule Entry > Edit Layout > Order
Input buttons to the Order Workflow Rule Entry Layout > Buttons.
Workflow Rule Entry Detail 2. Drag and drop the Item Criteria and Item Input buttons
page to the Custom Buttons area in the layout.

3. Click Save.

In Salesforce Lightning, go to Setup > Object Manager to edit the page layouts for
the Order Workflow Ruleset and Order Workflow Rule Entry objects.

Configuring an Order Workflow Rule for Split
Order

You can create and define rules under Order Workflow Rulesets to automate the split order
for certain business scenarios. This requires some configuration in order for you to create

and manage rulesets.

To automate the split order under Order workflow rulesets, perform the following task.

For your convenience in creating rules, you can add the Order Workflow Rulesets tab
to your default view as you would add any other object tab.

Configuration Description

Add Split Order to the 1. Go to Setup > Custom Objects > Order Workflow Rule
Action field in the Order >Custom Fields & relationships> Action.

Workflow Rule Detail page. 2. Under Values, click New.

3. Add Split Order as a picklist and click Save.

In Salesforce Lightning, go to Setup > Object Manager to edit the page layouts for
the Order Workflow Ruleset and Order Workflow Rule Entry objects.



Configuring the Direct Order Workflow

A Direct Order is placed by an Order Management user either by creating a new order from
the "Orders" tab or from the Order related list on an Account. To create an order in this
way, you must configure the Order page with the appropriate status, buttons, and
formulas to allow user to configure products and use contract pricing.

Add the Accept and Configure Products (NG) buttons to the Order page layout if they have
not already been added. When you create a new order, depending on the Price List you
select, the Configure Product (NG) button is displayed for the products associated with that
Price List.

- Configuring the Accept and Configure Products Buttons
- Changing the Flow on the Configure Products Button

- Using a Contract Price List for an Order

Configuring the Accept and Configure Products
Buttons

You can change the label and formula used for either of these buttons depending on your
individual use case.

To control the visibility of Accept and Configure
Products formula fields on the Orders page

From the Order page, go to Quick Access > View Fields.
Click New.
Click the Formula radio button and click Next.

N~

Enter a mandatory Field Label (for example, "Accept (Pending)") and press Tab on
your keyboard to auto-populate the Field Name.

o

Click the Text radio button and click Next. The Enter Formula page is displayed.

o

Enter code to be used in the formula. In this example, the Accept button is made
visible when the order and its line items is in Draft, Pending, In Amendment, and
Pending Cancellation status.



IF (OR(ISPICKVAL(Conga_Config2__Status__c, "Draft"),

ISPICKVAL (Apttus_Config2__Status__c, "Pending"),

ISPICKVAL (Conga_Config2__Status__c, "In Amendment"),

ISPICKVAL (Apttus_Config2__Status__c, "Pending Cancellation")), HYPERLINK("/
apex/Conga_Config2__OrderAccept?id="&Id, IMAGE("/resource/
Apttus_Config2__Button_Accept", "Accept"),"_self"), NULL)

7. Click Check Syntax to test the formula for errors.

8. Click Next. The Establish field-level security page is displayed.

9. Make changes to field-level security as needed. Click Next.

10. Select the page layout that should include this field and click Save.

Changing the Flow on the Configure Products
Button

To control the flow and other properties for configuring products from a direct order, you
can create a new formula field as described in the previous task. In the formula, change the
value after "&flow=" to the flow you want the formula field to use when a user clicks the
button from an order.

IF ( LEN( Conga_Config2__PricelListId__c ) > 0 , HYPERLINK("/apex/
Apttus_Config2__OrderConfiguration?id=" &Id & "&flow=NGDefault", IMAGE("/resource/
Conga_Config2__Button_Configure", "Configure Products"),"_self"), NULL)

For information on flows, cart views, and flow settings, refer to the CPQ Administrator
Guide.

Using a Contract Price List for an Order

To identify a specific Contract Price List to use when configuring products for direct order,
you can create a new formula field as described in the steps above. In the formula field,
specify the contract numbers and any field that points to the agreement.

IF ( LEN( Apttus_QPConfig__PriceListId__c ) > © , HYPERLINK("/apex/
Conga_QPConfig__ProposalConfiguration?id=" &Id& "&cntrNbr_1="&
Apttus_Proposal__Account__r.Pricing_Agreement_Number__c,IMAGE ("/resource/

Conga_QPConfig__Button_Configure", "Configure Products"),"_self"), NULL)



In the example above, the cntrNbr_1 parameter and the field which represents an
agreement number on an account are passed to the URL.

For information on contract pricing, refer to the topics "Contract Pricing” and "Defining a
Contract to be used in a Quote" in the CPQ Administrator Guide.

Setting Up Partial Orders from Price
Agreements

Sales orders are generated using Price Agreements from quotes or agreements where the
“Intent” field is equal to "Price Agreement.” This allows Order Management users to place
full or partial sales orders against a Price Agreement whose line items have been pre-
negotiated at specific quantities and pricing.

Configuring Price Agreements

Administrators are responsible for setting up the tab that navigates the user to the Price
Agreements user interface and configuring settings that customize the layout of pages in
the Ul. Complete all of the following tasks to set up Price Agreements for Order
Management.

To create the tab for managing Price Agreements

Log in to your Salesforce org.

Go to Setup > Tabs.

Under Visualforce Talbs, Click New.

Click Visualforce Page drop-down and select POPriceAgreement.
Enter a label for the tab (for example, "Price Agreement").

Press tab to autofill the tab APl name.
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(Optional) Choose a tab style.



Quick Find / Search, ?
R New Visualforce Tab
Expand All | Collapse All
Step 1. Enter the Details Step10f3
L
() Choose the page for this new tab. Fillin other details
Lightning Experience
Transition Assistant Select an existing page or create a new page now.
Move to the new, more productive
Salesforce Visualfores Page | POPriceAgreement [Apttus_Config2_ POPriceAgreement]

Tab Label |Pr|ceAgreemem
TabName  |price_Agreement i
e [ I

(Optional) Choose a Home Page Custom Link to show as a splash page the first time your users click on this tab.

Salesforce Mobile Quick Start

Home Splash Page Custom Link | _None—

h
Sy atamiOTerTiow Enter a short description

Description
Personal Setup
*) My Personal Information
») Email
»/ Import
») Desktop Integration

*I My Chatter Settings
+ My Connected Data

App Setup

Help for this Page @

Next | Cancel

8. Click Next.
9. Select tab visibility for profiles and click Next.
10. Select which apps will have access to this tab. Click Save.

To configure Order System Properties for Price

Agreements

1. Go to Setup > Custom Settings > Order System Properties

2. Click Manage.

3. Click Edit to the left of System Properties.

4. Enter values for the properties described in the following table:

Property Description
Agreement Enter the list of field APl names from the Agreement
Fields for object to display as columns on the agreement list

Partial Order | view page under Price Agreements.

Example Value

Conga__Account__c,
Apttus__Account__r.
Name,
Apttus_CMConfig__P
riceListld__c,
Apttus_CMConfig__P
riceListld__r.Name,
Apttus__FF_Agreeme
nt_Number__c




Property Description Example Value

Agreement Use this field to list additional Agreement field API
Fields for names when the total number of characters for the
Partial Order2 | "Agreement Fields for Partial Order" property is

exceeded.
Agreement Enter the list of field APl names from the Agreement = Apttus__Agreementl
ltem Fields for | Line Item object to display as columns on the d__c,
Partial Order | agreement line item list view page under Price Apttus__Productld__r
Agreement Details. .Name,
Apttus_CMConfig__
OrderedQuantity__c,
Apttus__Quantity__c
Apttus_Approval__A
pproval_Status__c,
Apttus_CMConfig__B
illLToAccountld__r.Na
me,
Apttus_CMConfig__S
hipToAccountld__r.N
ame
Agreement Use this field to list additional Agreement Line ltem

ltem Fields for | field APl names when the total number of
Partial Order | characters for the "Agreement Item Fields for
Partial Order" property is exceeded.



Property

Quote Fields
for Partial
Order

Quote Fields
for Partial
Order2

Quote Item
Fields for
Partial Order

Quote Item
Fields for
Partial Order2

Description

Enter the list of field APl names from the Quote/
Proposal object to display as columns on the quote
list view page under Price Agreements.

Use this field to list additional Quote/Proposal field
APl names when the total number of characters for
the "Quote Fields for Partial Order" property is
exceeded.

Enter the list of field APl names from the Quote/
Proposal Line Item object to display as columns on
the quote line item list view page under Price
Agreement Details.

Use this field to list additional Quote/Proposal Line
[tem field APl names when the total number of
characters for the "Quote Item Fields for Partial
Order" property is exceeded.

Example Value

Apttus_Proposal__A
ccount__c,
Apttus_Proposal__A
ccount__r.Name,
Apttus_QPConfig__P
riceListld__c,
Apttus_QPConfig__P
riceListld__r.Name,
Apttus_Proposal__A
pproval_Stage__c,
Apttus_QPConfig__In
tent__c,
Apttus_QPConfig__S
hipToAccountld__r.N
ame

Apttus_QPConfig__E
ndDate__c,
Apttus_QPConfig__S
tartDate__c,
Apttus_Proposal__Pr
oduct__r.Name,
Apttus_Proposal__Pr
oposal__c,
Apttus_QPConfig__Q
uantity2__c,
Apttus_QPConfig__O
rderedQuantity__c



Field values must be comma-separated.

5. Click Save.

To configure fields sets for displaying information in

the Price Agreement Ul

1. Go to Setup > Objects > Order.
2. Under Field Sets, click Edit next to the field set you want to configure. Refer to the
following table for the list of configurable field sets and their purpose:

Field Set

Manage Customer
PO Basic Info

Manage Customer
Additional Info

Purpose

This field set is used to display the list of
fields in the header of the Create Sales
Order screen.

This field set is used to display additional
fields on the Create Sales Order screen.

Notes

Fields are displayed
in the order they are
added to the field
set.

Fields are displayed
in the order they are
added to the field
set.



Field Set Purpose Notes

Manage Customer This field set is used to determine which Price Agreements
PO List View columns are displayed in the Price can be sorted or
Agreement Detail screen. filtered by column.

"

3. When you are done adding fields to a field set, click Save to save your changes. Go to
the appropriate page under Price Agreements to verify the fields are displayed.

Configuring the Contract Price List for Orders
With Commitment Compliance

When setting up partial orders, you must configure the Quote/Proposal and Agreement
objects to generate a Price List that refers to the product, bundle, and service line item
pricing information on the quote or agreement originating the order. In this case, when the
quote is accepted or the contract is finalized, a Contract Price List is generated that is part
of the Price Agreement. Users can then create partial orders to fulfill quantities at the
negotiated price for product and service line items (on the quote or contract). As an
administrator, you need to add the "Price Agreement” option to the /ntent picklist custom
field on the Quote/Proposal and Agreement objects. When a quote or contract with “Intent
= Price Agreement" is accepted or finalized, a new Price List is generated with the type
"Contract." Price List Items (PLIs) store information on the products and services copied over
from the original quote or agreement.

- For PLIs with the list price, the new net unit price is copied to contract price field of the
new PLI.

- For PLIs with matrix pricing (recurring), the matrix is copied from original PLI to the new
PLI.

- For PLIs with matrix pricing (usage), the matrix is copied from usage price tiers of the
line item to the new PLI.



To configure the Quote/Proposal object for partial
orders

From Salesforce, click Setup > Objects > Quote/Proposal.
Under Custom Fields and Relationships, click Intent.
Under Values, click New.
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Add the new picklist value "Price Agreement.” Click Save.

To configure the Agreement object for partial orders

From Salesforce, click Setup > Objects > Agreement.
Under Custom Fields and Relationships, click Intent.
Under Values, click New.
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Add the new picklist value "Price Agreement.” Click Save.

Setting Up Customer Purchase Orders

A Customer Purchase Order (PO) is a document that represents the initial offer of
negotiated types, quantities, and prices for products or services. Customer Purchase Orders
can be created by sales users or administrators as sales orders for long-term contracts.

Configuring Customer Purchase Orders and
Purchase Order Items

Administrators are responsible for setting up Order Management to allow users to work
with Customer Purchase Orders. To configure Order Management for Customer Purchase
Orders, perform the following tasks in order.

To create a tab for managing Customer Purchase
Orders and Items

1. Log in to your Salesforce org.

2. Go to Setup > Tabs.

3. Under Visualforce, click New.

4. Click the Visualforce Page drop-down and select ManageCustomerPO.



Enter a label for the tab (for example, "Customer Purchase Orders").
Press tab to autofill the tab APl name.
(Optional) Choose a tab style.
Quick Find / Search. NeW Visualforce Tab Help for this Page @
Q;xpzndA\l\Cnl!zpseAll T T
A4 , Choose the page for this new tab. Fillin other details

Lightning Experience
Transition Assistant

Move to the new, more productive
Salesforce.

Tab Label | Customer Purchase Order
Get Started
TabName | Customer_Purchase_Orde i

mosyie | I X

Select an existing page or create  new page now.

Visualforee Page | Manage Customer PO [Apttus_Config2__ManageCustomerPO]

Salesforce Mobile Quick Start
(Optional) Choose a Home Page Custom Link to show as a splash page the first time your users click on this tab.
Home Splash Page Custom Link | __None--

Sy atamiOyertiow Enter a short description

Description
Personal Setup

*) My Personal Information
») Email 4

»/ Import

»] Desktop Integration = e
*I My Chatter Settings

+ My Connected Data

App Setup

Click Next.
Select tab visibility for profiles and click Next.

. Select which apps will have access to this tab and click Save.

To enable default draft status for Customer Purchase
Orders

ook wn

Repeat this task for the Customer Purchase Order Items object.

Go to Setup > Objects > Customer Purchase Order (In Lightning, Setup > Object
Manager < Customer Purchase Order).

From Custom Fields & Relationships, click Status.

Click New. The Status Picklist Values page is displayed.

In the picklist entry field, enter the values Draft. Click Save.

Next to the Draft status, click Edit.

From the Picklist Edit page click the check box Make this value default for the master
picklist and click Save.

The default status must be "Draft” to make the Edit PO button visible.

Click Save.



To configure field sets for displaying information on
Customer Purchase Orders

Configure field sets to display required fields in the PO Admin Ul. For example, if a CPO
needs to be validated against a quote, ensure that the quote and quote line item fields are
present in the appropriate field set.

1. Go to Setup > Objects > Customer Purchase Order.
2. Under Field Sets, click Edit next to the field set you want to configure. Refer to the
following table for the list of configurable field sets and their purpose:

Field Set Purpose Notes

Manage Customer Add fields to this fields set to display field Fields are displayed

PO Basic Info values in the "Order Basic" section of the in the order they are
New Purchase Order screen. added to the field
T — set.

Manage Customer Add fields to this field set to display field Fields are displayed
PO Additional Info values in the "Order Customer" section of in the order they are
the New Purchase Order screen. added to the field

set.

APTTUS | oustome Puchase e




Field Set Purpose Notes

Manage Customer Add fields to this field set to determine which | Customer Purchase

PO List View columns are displayed in the list of purchase | Orders can be sorted
orders on the Customer Purchase Order or filtered by column.
screen.

APTTUS | Custorr Prrchase e

3. When you are done adding fields to the field set, click Save to save your changes.
Click on the Customer Purchase Order tab to verify fields have been added correctly.

To configure field sets for displaying information on
Customer Purchase Order Items

1. Go to Setup > Objects > Customer PO Item.
2. Under Field Sets, click Edit next to the field set you want to configure. Refer to the
following table for the list of configurable field sets and their purpose:

Field Set Purpose Notes

Manage Customer Add fields to this fields set to display field Fields are displayed

PO Basic Info values in the "Basic" section of the PO Line in the order they are
ltem Summary > Customer Purchase Order added to the field
Detail screen. set.

APTTUS | Costomer Pachase Order o Dot
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Field Set Purpose Notes

Manage Customer Add fields to this field set to display field Fields are displayed

PO Additional Info values in the "Additional" section of the PO in the order they are
Line Item > Customer Purchase Order Detail | added to the field
screen. set.

sssss

Manage Customer Add fields to this field set to determine which | Customer Purchase

PO List View columns are displayed in the list of purchase | Order Items can be
order items on the Customer Purchase Order | sorted or filtered by
> Customer PO Items screen. column.

APTTUS | Costorme pachase o

sssss
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3. When you are done adding fields to the field set, click Save to save your changes.
Click on the Customer Purchase Order tab to verify fields have been added correctly.

Setting Up Purchase Order Admin

Administrators are responsible for setting up Order Management to allow users to create
Enrichment and Validation rules for Customer Purchase Orders. Enrichment and Validation
rules are created using the Purchase Order Admin (PO Admin) angular user interface. The
PO Admin Ul provides a step-by-step wizard that allows you to create Data Enrichment
and Validation Rulesets which contain one or more Data Validation and/or Data
Enrichment rules. For more information on Enrichment and Validation rules, refer

to Managing CPO Validation and Enrichment Rules in the Order Management on
Salesforce User Guide.



To create a tab for managing Customer Purchase
Order Enrichment and Validation rules

Log in to your Salesforce org.

Go to Setup > Tabs.

Under Visualforce, click New.

Click the Visualforce Page drop-down and select PO Admin.
Enter a label for the tab (for example, "PO Admin®).

Press tab to autofill the tab APl name.

(Optional) Choose a tab style.
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‘ Quick Find / Search New Visualforce Tab Help for this Page @

Expand All | Collapse All
Step 1. Enter the Details Step 10f 3

a5
A ch
00se the page for this new tab. Fil in other details
Lightning Experience
Transition Assistant

Move to the new, more productive
Salesforce.

TabLabel PO Admin
Get Started
TabName | PO_Admin i
T o T

(Optional) Choose a Home Page Custom Link to show as a splash page the first time your users click on this tab.

Select an existing page or create a new page now.
Visualforce Page | POAdmin [Apttus_Config2__POAdmin]

Salesforce Mobile Quick Start

Home splash Page Custom Link [ __None-—

Sy etomiOy ertiow Enter a short description

Description
Personal I Setup
*I My Personal Information
») Email 4
») Import

8. Click Next.
9. Select tab visibility for profiles and click Next.
10. Select which apps will have access to this tab and click Save.

To configure the Enrichment/Validation object for
Customer Purchase Orders

1. Go to Setup > Objects > Data Enrichment/Validation Ruleset (in Lightning, Setup >
Object Manager > Data Enrichment/Validation Ruleset).

2. Go to Fields & Relationships > Source Data Object.

3. Ignore the initial picklist values. Click New and enter the following with the correct
namespace: Conga_Proposal__Proposal__c,
Conga_Proposal__Proposal_Line_ltem__c, Conga__APTS_Agreement__c,
Apttus__AgreementLineltem__c, Conga_Config2__Order__c,
Conga_Config2__OrderlLineltem__c. Click Save.

4. Go to Fields & Relationships > Target Object to Validate.



5. Ignore the initial picklist values. Click New and enter the following with the correct

namespace: Conga_Config2__CustomerPurchaseOrder__c,

Apttus_Config2__CustomerPOltem__c. Click Save.
6. Go to Fields & Relationships > Target Object Parent.
7. Ignore the initial picklist values. Click New and enter the following with the correct

namespace: Conga_Config2.

CustomerPurchaseOrder__c,

Apttus_Config2__CustomerPOltem__c. Click Save.

Appendices

Order System Properties

You can access these settings from Setup > Develop > Custom Settings > Order System

Properties.

Setting

Initiate Billing On Order Creation

Initiate Billing On Order Activation

Create Asset On Order Activation

Enable Inflight Changes And

Cancellation

Agreement Fields For Partial Order2

Agreement Fields For Partial Order

Agreement Item Fields For Partial
Order2

Description

Indicates whether billing should be initiated on order
creation.

Indicates whether billing should be initiated on order
activation.

Indicates whether asset creation is delayed until order
activation.

Indicates whether inflight order changes and
cancellation are enabled.

Enter the list of field APl names from the agreement
object for display when creating partial orders. Each
field may be separated by a comma or a new line.

Enter the list of field APl names from the agreement
object for display when creating partial orders. Each
field may be separated by a comma or a new line.

Enter the list of field APl names from the agreement line
item object for display when creating partial orders.
Ecch field may be separated by a comma or a new line.



Setting

Agreement Item Fields For Partial

Order

Quote Fields For Partial Order2

Quote Fields For Partial Order

Quote Item Fields For Partial Order2

Quote Item Fields For Partial Order

Split Order Criteria Fields

Split Order Threshold

Description

Enter the list of field APl names from the agreement line
item object for display when creating partial orders.
Each field may be separated by a comma or a new line.

Enter the list of field APl names from the quote/proposal
object for display when creating partial orders. Each
field may be separated by a comma or a new line.

Enter the list of field APl names from the quote/proposal
object for display when creating partial orders. Each
field may be separated by a comma or a new line.

Enter the list of field APl names from the proposal line
item object for display when creating partial orders.
Each field may be separated by a comma or a new line.

Enter the list of field APl names from the proposal line
item object for display when creating partial orders.
Ecach field may be separated by a comma or a new line.

Enter the list of field APl names from Order line item
objects to split items added during a large order process
into multiple orders. Separate each field with a comma
or a new line.

Indicates the maximum number of a bundle or
standalone products (represented as line numbers) that
may be added to a split order. Defaults to 100.



Order Management for Users

The Order Management User Guide is designed to provide customer sales and support

representatives with information for managing the life of a generated order before it
creates or updates an asset. This guide covers the major features that are provided with
the Conga Order Management license, including changes to in-flight orders, partial orders

from contract price agreements, and management of customer purchase orders. Many of

the topics in this guide cover tasks that can be considered part of an overall workflow for
Conga purchase and revenue management products — therefore familiarity with Conga
Configure Price Quote (CPQ) products are highly encouraged to understand and execute
Order Management concepts and tasks.

Topic

What's Covered

Primary Audience

IT Environment

Updates

Description

This guide walks sales users through the Order Management
workflow and lifecycle, from the generation of order to creation
of assets, fulfillment tracking, and integration with downstream
services. It provides conceptual information, step-by-step
instructions, and use cases for the features provided by Conga
Order Management.

- Customer Support Representative
- Sales Representative

Refer to the latest Order Management on Salesforce Release
Notes for information on System Requirements and Supported
Platforms.

For a comprehensive list of updates to this guide for each
release, see the What's New in Order Management Documentation
topic.



Topic Description

Other Resources - Conga Order Management Summer 2020 Administrator
Guide: Refer to this guide for installing and setting up
Order Management in your organization.

- Conga Order Management Summer 2020 Release Notes:
Refer to this guide for the new feature, enhancements,
resolved, and known issues.

- Conga Order Management Summer 2020 SOAP API Guide:
Refer to this guide for documentation of public-facing
SOAP APIs for Order Management.

- CPQ Administrator Guide: Refer to this guide for setting
up products, price lists, and constraint rules.

This guide describes the following tasks:

- Managing orders in the Quote-to-Cash Process

- Managing order lifecycle and status

- Creating direct orders for accounts

- Creating partial orders from customer price agreements (quote/contract)
- Managing in-flight order changes and cancellation

- Managing distributed order fulfillment

- Activating an order

- Billing for an order

- Creating customer purchase orders

Before using Order Management, you must be familiar with the following:

- Basic Salesforce Administration knowledge
- Conga CPQ and Conga CLM administration
- Salesforce and Conga terms and definitions

Select one of the following topics for more information:

- Logging in to Order Management

- Navigating the Order Management User Interface

-+ Understanding the Order Management Lifecycle

- Capturing Orders

+ Managing In-Flight Order Changes and Cancellation
- Working With Customer Price Agreements

- Splitting an Order

- Working With Distributed Order Fulfillment



- Activating an Order

- Billing for an Order

- Working with Customer Purchase Orders
- Intelligent Order Assistant (Max for OoM)

Logging in to Order Management

Log in to your Salesforce.com org to access Conga Order Management.

Do not use the Back button on your browser when using Order Management.

Before logging in to Order Management, make sure you meet the following criteria:

- All required Order Management packages (included Conga CPQ packages, and
packages for other integrated Conga applications) have been installed by an
administrator.

- You have login credentials provided by Conga.

To log in to Order Management

1. Go to https://salesforce.com/.
Or
If your organization is using a sandbox or test environment to access Conga Order
Management (for example, if you are doing user acceptance testing), go to https://
test.salesforce.com/ instead.

2. From the toolbar at the top of the page, click Login. The login page opens.

w

Enter your user name and password, and click Log in.

4. Navigate to Conga Order Management:

- In Salesforce Classic: Click the App Menu and select Conga Order
Management.

- In Salesforce Lightning Experience: Click the App Launcher and select Conga
Order Management.

Navigating the Order Management User
Interface

The Order Management User Interface (Ul) is presented to the user similarly to many other
Conga applications on Salesforce. The default landing page for Order Management takes


https://salesforce.com/
https://test.salesforce.com/

you to the Order tab, which displays a list of Recent Orders and links and options in the

Salesforce sidebar to the left (Salesforce Classic).

You can use standard Salesforce functionality such as global search, dashboard controls,

tabs, and menus to navigate to various Order Management pages. Refer to Salesforce

documentation for any differences in navigation using Salesforce Classic versus the

Lightning Experience.

Conga Order Management provides a number of tabs to use its various features. Refer to

the following table for brief descriptions of each tab:

Note: Configuration of certain tabs require administrator privileges or user

permissions. Contact your administrator if you do not have access to any of the

tabs described below.

Tab

Orders

Order Workflow
Rulesets

Order
Fulfillments

Order Fulfillment
Line ltems

Price Agreement

Description

Default landing page for the Order
Management application. View, manage, and
create new direct orders from this page.

Use this tab to view, create, and manage Order
Workflow Rulesets.

Use this tab to view and manage Order
Fulfillments.

Use this tab to view, create, and manage Order
Fulfillment Line Items.

Use this tab to view Price Agreements created
from Quote/Proposals and/or Agreements.
Create partial orders from Contract Price List
ltems.

Help Topic(s)

Capturing Orders, Creating

Direct Orders for Accounts

Creating Order Workflows to
Automate In-Flight Order
Changes

Working With Distributed
Order Fulfillment, Releasing
Orders to Fulfillment Systems

Working With Distributed
Order Fulfillment, Releasing
Orders to Fulfillment Systems

Working With Customer Price

Agreements



Tab Description Help Topic(s)

Customer Use this tab to view and manage Customer Working with Customer

Purchase Orders Purchase Orders. Create and manage purchase | Purchase Orders, Creating
orders and purchase order items, and create Sales Orders from a Customer
sales orders, split, and partial orders from Purchase Order

purchase orders. View and add attachments to
purchase orders.

Config Settings Use this tab to manage config settings and
system properties. Refer to the CPQ on
Salesforce Administrator Guide for more

information.
Data Validation/ | Use this tab to create and manage Data Managing CPO Validation
Enrichment Enrichment and Validation rulesets for and Enrichment Rules
Rulesets Customer Purchase Orders.
PO Admin Use this tab to create and manage Data Managing CPO Validation
Enrichment and Validation rules for Customer and Enrichment Rules

Purchase Orders.

Working in the Conga User Interface

Several features of Order Management use a custom user interface provided by Conga. The
following provides a brief summary of Ul controls and features:

- To search for records using a type-ahead field (marked by the lookup (Q) icon), enter
text in the field and select a result to refresh the Llist.

- Click a column header name to sort the list by that column.

- Click the filter (7) icon in the column header, enter a filter string, and click Apply to
filter the list by column value.

- Use the pagination controls to change the number of rows per page or to move
between pages.

- When working with forms, use the date picker ( 8 ) to select a date value for the field.



Understanding the Order Management
Lifecycle

Using Order Management, customer support representatives can track an order through its
entire lifecycle to asset creation. Order fulfillment status can be tracked at the order level
or at the individual line item Level.

The following diagram represents a high-level lifecycle flow for orders created in Conga
Order Management.

Order Life Cycle and Versioning
Amendment Initiate Cancellation /

Version Accepted ] New Version Created Pending Cancellation
Mew Order Accepted —> {New Version)
In Amendment
New Ve rsmn Pending
Initiate Cafcellation /
Send fo! Fulfillment

New Versign Created
Some lines

fulfilled

Initiate Aghendment [/

M

Initiate Amendment
/ Create New Version

Being Amended
(Existing Version)

Being Cancelled
(Existing Version)

Amendmet Version  Pending Canceflation Version

Accepted

Pending Cafcellation
Versipn
Accepfed

T «—
APTTUS

Superseded

Ready for Activation
Date Set

Orders begin in Draft status, either through direct order creation or conversion from a
Quote or Agreement (in Conga CPQ or CLM). From here, a Pending order can be confirmed
or Amended. After an order is confirmed, it moves to fulfillment status, either as a Partially
Fulfilled order, or Fulfilled and Activated. Orders can also be Cancelled, either initiated
manually, or superseded by a new version.

Understanding Order Status

Order and Order Line Item status work as a mechanism to integrate with downstream
systems and processes including fulfillment systems, asset management, billing, and
revenue recognition.



« Order Header Status

« Order Line ltem Status

The majority of actions described in this topic that assign status to an order or order

line items can also be executed using Order Service APIs. For information on how to
use Order Service APIs, refer to the Conga Order Management SOAP APl Guide.

Order Header Status

The following table describes Order Status at the order level and the events and actions

that assign status to an order.

Order Status Description

Draft When an order is initially created, its
default status is "Draft."

Event / Action

New Order

Creating a new order from the
Order page or a related Llist will
create the order in "Draft"
status. Draft orders are work-in-
progress orders and can be
opened and edited without
creating new versions.

Ensure that "Draft" is the default
status when creating orders and
order line items.

You can change the quantity of
an order from the cart even
when the order is in "Draft"
status.

You can also clone an existing
order to create a new order. For
more information, see Cloning an
Order.



Order Status

Pending

Description

When an order is confirmed by a customer
but is pending for validation. Such orders
and all the order line items have a
"Pending" status.

Event / Action

Accept Order / Accept Quote /
Activate Agreement

An order is confirmed when the
Accept button is clicked on the
Order or Quote record, or when
an Agreement is Activated.
Accepting an order will change
the status of the order and order
line items to "Pending” if Auto
Activation is not enabled.

To generate orders in "Pending"
status from quotes and
agreements, ensure:

- Auto Create Orders for
quotes is set to "True"

Go to Custom Settings >
Proposal System
Properties to apply this
property.

- Auto Create Order for
agreements is set to "True"
Go to Custom Settings >
Comply System
Properties to apply this
property.

- Auto Activate Order is set
to "False"

You are allowed to cancel an
order when it is in "Pending"
status.

Undo Cancel Order

When you click Undo Cancel
Order, the order reverts the new
version to the previous version,
which then displays "Pending”
status.



Order Status

In Fulfillment

Description

The Order and Order Line Item status
changes to "In Fulfillment “when order
fulfillment begins. This means that one or
more line items are in ('In Fulfillment’) AND
other line items are in “Pending” status

Event / Action

Send for Fulfillment

You can set the status to "In
Fulfillment" when the Order and
Order line items are exported to
fulfillment systems to initiate
the fulfillment process.

It indicates that the order has
been released to the fulfillment
systems and the fulfillment
process has begun.

You are allowed to cancel an

order when it is in "In Fulfillment
status.

Undo Cancel Order

When you click Undo Cancel
Order, the order reverts the new
version to the previous version,
which then displays "In
Fulfillment" status.



Order Status Description

Partially Fulfilled | When one or more line items are in
"Partially Fulfilled" status.

OR

If one or more line items are IN (‘Activated!,
'Fulfilled’) status AND one or more IN (In
Fulfillment' OR 'Pending’) status.

Event / Action

Create Order Fulfillment Line
ltems

You can manage and track
partial fulfillment for an order
by creating order fulfillment Lline
items against a given order line
item. This updates the "Fulfilled
Quantity" on the order line item
level and also updates the
status of the order line item to
"Partially Fulfilled" or "Fulfilled"
or "Activated.”

Activate a Subset of Order Line
Items

A subset of order line items can
also be manually activated by
setting the "Ready for Activation
Date" field on the corresponding
line items. When a subset of the
order line items is activated, the
overall order status is set to
"Partially Fulfilled."



Order Status

In Amendment

Description

This status is set on an "In-Flight" order (in
"Pending"”, "
Fulfilled" status) when changes have been

made to the existing order.

In Fulfillment", or "Partially

This status represents work-in-progress
changes to the order that have not yet
been confirmed (similar to a "Draft" order).

Event / Action

Amend Order

Amending an order creates a
new version of the order to make
and track changes and a
reference to the previous version.
The previous version of the order
and order line items are
"Superseded," once the work-in-
progress (In Amendment)
changes are confirmed on
"Accept” of the "In Amendment"
order.

Amending an In-Flight order
allows you to make the
following changes:

- Change the start date or
end date of subscription
on one or more order line
items that are in
"Pending," "In Fulfillment,"
or "Partially Fulfilled"
status.

- Make subscription date
changes on the
standalone item, bundles,
and multiple charge line
items.



Order Status

Description

Event / Action

- Cancel or add new line
items, and change their
quantities, pricing, and
discounts.

The change in subscription start
and/or end date will recalculate
the price for the line item or
bundle after the changes are
applied.

The changes to the order line
items are also reflected in the
corresponding assets. When /n-
Flight Order Changes is enabled,
assets are only created on
activation of the order line item.

Note: Any order configured
directly or generated from a
quote, agreement, or E-
Commerce can be amended.

To change order line item
quantities, the field "Is Quantity
Modifiable" must enable at the
line item level for product
configuration.

Undo Amend Order

If you proceed with Undo Amend
Order, it reverts the new version
to the previous version, which
then displays the status of the
original order (for example,
"Partially Fulfilled").



Order Status

Being Amended

Fulfilled

Activated

Description

This status is set when an "In-Flight" order

(in "Pending," "In Fulfillment," or "Partially

Fulfilled" status) is in the process of being

amended.

This status is assigned to the previous

version of the order when an existing order
version is in the process of being amended.

This status represents that this version is
being amended and, once the new

changes are confirmed, this version will be

superseded by the new order.

All line items in "Fulfilled" status
OR

One or more line items are IN (‘Fulfilled’)
status

AND

One or more line items are IN (‘Activated’)
status

The order fulfillment process is complete
and ready for the initiation of additional
related downstream processes (billing,
revenue management, and so on).

Event / Action

N/A

N/A

Auto Activate Order

Orders can be automatically
activated by configuring the
Auto Activate Order setting, or
by providing a "Ready for
Activation Date" on the Order or
Quote header before accepting
the corresponding order or
quote.

Activating All Order Line Items
If all Order Line Items are
independently fulfilled and
activated, the entire Order will
be activated.



Order Status

Superseded

Cancelled

Pending
Cancellation

Being Cancelled

Description

This status is set on the previous version of
the order when the order version with the
status "In Amendment” or "Pending
Cancellation" is accepted.

This status is set when an order is
cancelled and accepted. Only orders in
"Pending"” or "In Fulfillment" status can be
cancelled.

You cannot "Undo Cancel Order" when an
order has "Cancelled" status.

This status is set on the new version of the
order that is created for cancellation. The
status of the order and its line items is set
to "Pending Cancellation.”

This status is set on the original order
when an order is cancelled. Line items
remain in "Pending" status. When order
cancellation is accepted, the original order
status along with its order line items is
changed to "Superseded.”

Event / Action

Accept Order

When an order with the "In
Amendment" or "Pending
Cancellation" status is
accepted, the previous version
status is set to "Superseded.”

N/A

Cancel Order

When you cancel an order, a
new version is created for
cancellation. This version is set
to "Pending Cancellation” for
both the order and its line items.
To complete cancellation, click
Accept. The status of the order
is then set to "Cancelled."

The order line items also
undergo versioning when you
cancel or amend an order.

N/A



Order Line Item Status

The following table describes each Order Status at the order line item level. The status of
orders and order line items can differ based on the stage of the order fulfillment.

Order Line Description
Status
Draft The Order Line Item is initially created and

the Order Status is "Draft.”

Pending The Order is confirmed by a customer but
is "Pending" for validation.

In Fulfilment The Order Line Item has been sent for
fulfillment. This Status helps in tracking
the fulfillment process at the Order Line
ltem level.

Partially Fulfilled | The Fulfilled Quantity is less than the
Delta Quantity and the value is greater
than zero.

Event / Action

Creating a New Order.

Accepting Quote/Order.

When you perform the following
actions, the order line item
status changes to "Pending:”

- Undo Cancel Order
- Undo Amend Order

Sending/Releasing Order to
Fulfillment systems.

Tracking Fulfillment for each
Order Line Item by creating a
corresponding Order Fulfillment
Line Item.



Order Line Description Event / Action
Status

In Amendment A change has been made to the Order Line - Changes to order line
[tem. items are also reflected in
the corresponding assets.

+ When the "In-Flight" order
change capability is
enabled, assets are only
created on activation of
the order line item.

- Amending an order
creates a new version of
the order to make and
track changes and has
reference to the previous
version. The previous
version of the order and
order line items have their
status changed to
"Superseded,” once the
work-in-progress ("In
Amendment") changes are
confirmed on Accept of
the "In Amendment order".

Being Amended This status is set when an "In-Flight" order | Amend Order
line item (order in "Pending," "In Fulfillment,"
or "Partially Fulfilled") is in the process of
being amended.

This status is assigned to the previous
version of the order line item when an
existing order version is in the process of
being amended. This status represents
that this version is being amended and,
once the new changes are confirmed, this
version will be superseded by the new
order line item.



Order Line Description
Status
Superseded This status is set on the previous version of

the order when the order related to the "In
Amendment" order version is accepted, or
when an order with the "Pending
Cancellation” status is accepted.

Fulfilled If the Fulfilled Quantity on the Order Line
ltem is equal to the Delta Quantity.

Activated The Order Line ltem's status is set to
Activated in any of the following three
scenarios:

Scenario 1: Line item activation is initiated
once the order line item is "Fulfilled."
Scenario 2: The Order is auto-activated.
Scenario 3: The Order line item is manually
activated.

When Order Line ltems are activated, the
system initiates activation of the
corresponding asset.

Pending This status is set when an order is

Cancellation cancelled.

Cancelled This status is set when the cancelled order
is accepted.

Capturing Orders

Event / Action

Accept Order

When the Accept action is used
on an "In Amendment" or
"Pending Cancellation" order,
then the previous version is
"Superseded.”

For the following events/actions:

- On fulfillment of all Order
Line Items.

- Directly updating the
status of Order Line Item
to "Fulfilled."

On Fulfillment of all Order Line
[tems.

Providing a value for the Ready
for Activation Date field on the
Order.

Cancel Order

Accept Order

Conga Orders are captured using a number of processes, usually depending on which sales
channel the order is originating from. The table below describes at a high level what types
of orders are generally tied to which type of sale channels. In some cases, a sales channel,



such as direct sales, may capture orders using one or more different processes. The table
below covers the most common use cases.

In all cases, orders are captured and stored in Salesforce as Order records. Product, service,

and bundle data is stored in Orders as Order Line Items.

Sales Channel(s) Order Management Process

Direct Sales, Partner Sales - Captures an order from a Quote/Proposal
- Captures an order from an Agreement (Contract)
- Creates a direct order for an Account (Order Management Ul)

Customer Service - Creates a direct order for an Account (OM UI)
Representatives (CSR),

Telesales

E-Commerce, Partner - Creates an order using Order Management APls
Commerce - Creates an order from a Customer Purchase Order

Total Order Amount on the Order Header

At any time during the ordering process, the total amount of the order is calculated
and displayed in the Order Amount field on the order header.
Order Amount = SUM(Net Price) from order line items based on the following
conditions:
- Any line item in "Cancelled" or "Pending Cancellation" status is not considered.
- If an option or child bundle price is rolled up to the parent bundle, the system
considers the parent bundle net price to avoid double-counting.

The order amount is recalculated whenever the net price on an order line item is
updated or when the status of the order line item is changed (to any status other
than "Cancelled" or "Pending Cancellation”).

Order Management Scope

It is important to consider that the most common use case for generating an order is
through a Quote or Agreement. In these cases, orders are almost always automatically
activated, meaning that the Order Management application plays a limited or no role in
managing the order as it is usually automatically converted into an asset.



Order Management primarily focuses on providing users with the capability to make in-
flight order changes, create partial orders from price agreements, and manage and create
orders from customer purchase orders. You can create a direct order using Order
Management, but even a direct order is mainly initiated by a CPQ or CLM user from the
Quote or Agreement record.

For more information on creating and managing orders and assets from a quote, refer to
the CPQ User Guide and supporting documentation.

For more information on creating and managing orders and assets from an agreement
(contract), refer to the CLM User Guide and supporting documentation.

Creating Direct Orders for Accounts

Customer service representatives or telesales person can directly create an order for a
given account rather than going through the quoting process. Customers typically request
for creating orders directly instead of going through the quote creation process in the
following scenarios:

Request for Order Creation Detail

Channel partners placing orders against Channel partners (Retailers, distributors) generally

the channel price list. have standard channel price lists. Channel partners
can call customer service/telesales to place new
orders.

Customers requesting new Orders at a Customers can call customer service/telesales to

standard price list. place new orders against the standard price list.

Order against pre-negotiated agreement/ | Customer can place orders against an already

rate card/price list. negotiated price list, rate card, or agreement. In this
case, orders will be priced based on the pre-
negotiated price.

Add-on/change orders for previously Customers can place add-on orders, change orders,
purchased products. or renewal orders against previously purchased
products /services/subscriptions.

- To create a new order from the Orders tab

- To create a new Order from the Account page



To create a new order from the Orders tab

1. Click the Orders tab. A list of recent orders is displayed.

2. Click New. The New Order page is displayed.

3. Enter values for the fields listed in the following table:

Field

Type

Status

Source

Sold To

Price List

Order Date

Auto Activate Order?

Single Transaction
Adjustment

Description

Click the drop-down and select the order type: New, Add-On, or
Renewal.

Click the drop-down and select Draft status.

Click the drop-down and select Account.

Type the name of the Account in the search box and select it or click
the lookup icon and search and select the account for this order.

Type the name of the Price List in the search box and select it or
click the lookup icon and search and select the relevant Price List for
this order.

Click this field and select a date for the order from the date picker.

Click the check box to automatically activate the order when it is
accepted.

Check this to indicate whether the Single transaction adjustment is
effected to the order or not.

4. Click Save. A new order is created.

5. Click the Configure Products button to open the Product Catalog. After finalizing the

cart, order line items are created for the order.

For step-by-step help customizing the Configure Products button to your

business needs, and other tasks and information about creating and finalizing

product configurations, refer to the CPQ Administrator and User Guides.

6. Click Accept. The following changes are made depending on whether or not you

decided to automatically activate the order:



- If Auto Activate Order = False

- The status of Order and Order Line Items is set to “Pending.”

- Asset Line Items are created in the “Pending” status.

- If "Ready for Billing Date" is set, billing schedules are generated.
- If Auto Activate Order = True

-+ The status of Order and Order Line Items is set to “Activated.”

- Asset Line Items are created in the “Activated” status.

- If "Ready for Billing Date" is set, billing schedules are generated.

To create a new Order from the Account page

In order to create an order from an Account, the Orders (Sold To) related list must be
added to the page layout. For more information, refer to the Order Management
Administrator Guide.

1. Go to the Accounts tab (All Tabs > Accounts). The Accounts home page is displayed.

2. Find the Account for which you want to place an order. Click the Account Name. The
Account Details page is displayed.

3. Hover over the Orders (Sold To) link above the Order header and click New Order.

4. Enter values for the Order fields as described in the previous task. The Sold To field is
already populated with the Account Name.

Do not forget to ensure that the order is in "Draft" status.

5. Click Save.

6. Click the Configure Products button to open the Product Catalog. Refer to the CPQ
User Guide for complete steps on configuring products, applying pricing, quantity,
promotions, and discounts, and finalizing the cart. After finalizing the cart, order line
items are created for the order.

7. Click Accept. The following changes are made depending on whether or not you
decided to automatically activate the order:

- If Auto Activate Order = False

- The status of Order and Order Line ltems is set to “Pending.”

- Asset Line Items are created in the “Pending” status.

- If "Ready for Billing Date" is set, billing schedules are generated.
- If Auto Activate Order = True

- The status of Order and Order Line Items is set to “Activated.”

- Asset Line Items are created in the “Activated” status.

- If "Ready for Billing Date" is set, billing schedules are generated.



Creating Orders from Quotes and Agreements

You can also create direct orders from the quote or agreement page, however, in most
cases, you will want to follow the Auto-Create Order workflow for generating orders in this
way. Refer to the CPQ and CLM User Guides for these tasks and information on Asset-
Based Ordering (ABO).

Cloning an Order

Clone an order when you want to save time to create a new order with existing data, order
line items, and cart configuration (this is called a "deep clone").

Ensure that you or an administrator have added the Clone button to the Order
page layout. Refer to the Order Management Administrator Guide for more details.

To clone an order

1. Go to the Order Detail page of the order you want to clone.
2. Click Clone Order With Line Items. A new order is created. The following changes are
made:
- The status of the order and order line items are set to "Draft.”
- The fields Read for Activation Date and Ready for Billing date on the order
header, and Asset Line Item on the order line item is reset.
- Product Configurations are cloned along with corresponding cart and cart line
items. Cart line items can then be configured and changed similar to drafting a
new order.

Asset-Based Ordering (ABO) Line Items cannot be cloned using this process. For more
information ABO, refer to the CPQ User Guide.

Managing In-Flight Order Changes and
Cancellation

An In-Flight Order is defined as any order that has been confirmed by the customer but has
not yet reached fulfillment. In-Flight order changes can only be made to orders that are not



automatically activated on the confirmation. The two most common scenarios for In-Flight

order changes are as follows:

- Amending an order: Amend an order when you need to add, cancel, or change order
line items, change order quantities, pricings, and discounts, or modify order start/end
date and/or change subscription dates. The previous version of the order is
"Superseded” when the new order created by the amendment is accepted.

- Cancelling an order: Cancelling an order cancels the In-Flight order and its line items.
After accepting cancellation of the order, the previous version of the order is
"Superseded" and the new version is created with the "Cancelled" status.

You can use the Undo Amend Order and Undo Cancel Order actions at any time before

either is accepted to revert all changes.

- In-Flight order changes and cancellation require you to enable certain Order
System Properties. Refer to the Order Management Administrator Guide for
steps.

- When In-Flight Order Change is enabled, an asset is only created on
activation of its corresponding order line item.

Tracking Order Versions

Conga maintains a version history when you work with new or existing orders. The following
fields on the order header are populated when you amend or cancel an order:

- Previous Version: The previous version of the respective order before the order was
amended or cancelled

- Next Version: The next version of the original order that has been amended or
cancelled or is in the process of being amended or cancelled

- Original Order Number: The order number of the original order that was placed
(before any amendments).

- Version Number: The version number that is associated with the respective order. The
number increments by 1 each time the order is amended.

Automating In-Flight Order Changes

You can automate In-Flight order changes by creating Order Workflow Rulesets. Order
Workflow Rulesets comprise specific Order Workflow Rules that execute in-flight order
changes when certain criteria are met. The following are the main triggering events that
execute these rules:



- A quote is accepted and converted to an order.

- An agreement is activated and converted to an order.

- A direct order or order amendment is accepted.

- The “Ready for Workflow” field is set to true on the order header for orders in
“Pending”, “In Fulfillment,” or “Partially Fulfilled” status. (If the field is not present, add
it to the Order page layout.)

- The execOrderWorkflow APl is called directly to manually trigger one or more workflow
rules.

For more information on APIs, refer to the Conga Order Management SOAP APl Guide.

Amending an Order

You can amend an order after it is accepted by the customer but before it has reached
fulfillment. Amending an order creates a new version of the order to make and track
changes and a reference to the previous version. The previous version of the order and order
line items are "Superseded,” once the work-in-progress (In Amendment) changes are
confirmed on "Accept” of the "In Amendment" order.

You can make the following changes when you amend an In-Flight order:

- Change the start date or end date of subscription on one or more order line items that

are in "Pending,” "In Fulfillment," or "Partially Fulfilled" status.
- Make subscription date changes on the standalone item, bundles, and multiple
charge line items.

- Cancel or add new line items, and change their quantities, pricing, and discounts.

The change in subscription start and/or end date will recalculate the price for the line item
or bundle after the changes are applied.

The changes to the order line items are also reflected in the corresponding assets. When In-
Flight Order Changes is enabled, assets are only created on activation of the order line
item.

Note: Any order configured directly or generated from a quote, agreement, or E-Commerce
can be amended.

To change order line item quantities, the field "Is Quantity Modifiable" must enabled at the
line item level for product configuration.

The following diagram demonstrates the In-Flight Order Changes workflow.
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If you do not see the Amend Order button then In-Flight Order changes may not
have been configured for your product. You or an administrator must complete the
proper configuration to continue. Refer to the topic Configuring In-Flight Order Changes
and Cancellation in the Order Management Administrator Guide.

To amend an order

1. Navigate to the order from the quote, agreement, account, or Orders tab. The Order
Detail page is displayed.
2. Verify that the order is in "Pending," "In Fulfillment,” or "Partially Fulfilled" status and
click Amend Order. The Cart page is displayed.
3. Make changes to the product configuration based on your requirements. To cancel
any order line items:
a. Select one or more order line items in the cart.
b. Click the More menu under the Reprice/Finalize button.
c. Click Cancel Order Lines. The cart is refreshed to display the remaining line
items.
4. Reprice and Finalize the cart. Changes made to cart line items are copied to the order
line items. Order Management creates a new version of the order in "In Amendment”
status. The status for the previous version is changed to "Being Amended."



5. After approval of the in-flight order changes, click Accept to confirm the amended
order. The status of the new order is changed to "Pending." That status of the previous
version is changed to "Superseded.”

6. When all amendments are complete, activate the order.

- When a new line item is added to the cart associated with an amended order,
the order line item status defaults to "Draft." When the order status is updated
based on the combined status of order line items, the order is set to "Draft"
status when there is at least one order line item in "Draft" status.

- Cancel Order Lines is not available from the cart menu if it is not configured
properly in Config Settings. Refer to Configuring In-Flight Order Changes and
Cancellation in the Order Management Administrator Guide for step-by-step
information on configuring In-Flight order settings.

To undo an amend order

1. Navigate to the amended order.
2. Toroll back the amendment and all order line item changes, click Undo Amend Order.

The order is reverted to the previous version with its original status (“Pending,” “In

Fulfillment," or "Partially Fulfilled).

Cancelling an Order

You can cancel an order after it is accepted by the customer but before it is released to
fulfillment systems. When you cancel an order, the status of the order and its line items is
changed to "Pending Cancellation" and a new version is created. The previous order version
status is set to "Being Cancelled." When you decide to cancel an order, you must accept the
cancellation of the order to change the order and its line items from "Pending Cancellation®
to "Cancelled". Any order amount that was rolled up to the Order Amount on the order
header is subtracted from the total.

To cancel an order

1. Navigate to the order from the quote, agreement, account, or Orders tab. The Order
Detail page is displayed.



2. Verify that the order is in "Pending"” or "In Fulfillment" status and click Cancel Order. A
new version of the order is created with the status "Pending Cancellation.”" The status
for the previous version is changed to "Being Cancelled."

3. Click Accept to confirm order cancellation. The status of the cancelled order and its
line items is changed to "Cancelled." That status of the previous version is changed to
"Superseded.”

To undo a cancelled order

1. Navigate to the cancelled order.

2. Toroll back cancellation of the order, click Undo Cancel Order. The order is reverted
to the previous version with its original status ("Pending" or "In Fulfillment"). The order
amount is recalculated and displayed in the Order Amount field on the order header.

Creating Order Workflows to Automate In-Flight
Order Changes

When you are working with a large number of orders and you must create rules for different
business scenarios (for example, pro-rating subscriptions, or cancelling orders due to a
delay in provisioning), you can use Order Workflows to automate in-flight changes to
orders based on certain criteria.

Order Management allows you to automate in-flight order changes and cancellation using
Order Workflow rulesets and rules. Creating Order Workflows comprises two main tasks.
First, you define a Workflow Ruleset to provide the business and trigger context, and any
criteria related to the trigger. You then create a Workflow Rule and Workflow Rule Entries
within that ruleset to instruct the system which action or actions to execute based on
further criteria.

You can only create one workflow rule per ruleset. Each workflow rule can contain
one or more workflow rule entries.

When a workflow ruleset is triggered, the specified workflow rule executes based on the
criteria that triggers one or more of its rule entries. For example, you could create a
workflow rule that automatically amends the order to change the subscription date of one
or more line items when the agreement is accepted.



Executing Order Workflow Rulesets

Order Workflow Rulesets trigger based on any of the following events:

- Automatic:
- An order is created from a quote or agreement.
- A partial order is created from a price agreement.
- An order is accepted.
- Manual: Ready for Workflow is enabled and the order record is saved.

After a workflow ruleset is executed, the Ready for Workflow flag is disabled.

Perform the following tasks to set up a Workflow ruleset for automating in-flight order
changes and cancellation.

+ To create an Order Workflow Ruleset

+ To define criteria for the Workflow Ruleset

- To create an Order Workflow Rule

- To create an Order Workflow Rule Entry

-+ To define criteria for line item workflow rule entries

- To define the input for line item workflow rule entries

+ Use Case: Automatic Subscription Rollover

To create an Order Workflow Ruleset

1. Click ALl Tabs ([#]) > Order Workflow Rulesets > New (in Salesforce Lightning, go to
App Launcher > Order Workflow Rulesets > New). The New Order Workflow Ruleset
page is displayed.



. Enter the Ruleset Name.

. Click the Type drop-down and select API Execution.

. Enter a Sequence value (begins at "1"). This defines the sequence in which to execute
the ruleset when an event triggers more than one ruleset.

To avoid errors, specify a unique sequence value for every workflow ruleset.

. Click the Business Context Type drop-down and select the context object (default is
"Order").
. Depending on your requirements, click the Trigger Context Type drop-down and
select the appropriate trigger:

- Order



- Order Fulfillment
7. Depending on your requirements, add the appropriate Trigger Event(s) from the
Available box to the Chosen box.
8. Select the Active checkbox.
9. Click Save. The ruleset is created.

To define criteria for the Workflow Ruleset

Perform the following task to define the triggering criteria for a workflow ruleset.

1. From the Workflow Ruleset Detail page, click Criteria. The Order Workflow Ruleset
Edit page for Criteria Edit is displayed.
2. Click Edit. The Criteria Edit page is displayed.

Order Workflow Ruleset Edit
Order Automation Tech Pubs Test

Criteria Edit
Field Operator Map To Value Offset
--None-- v |--None-- v | | —-None-- v e

Advanced Options

OK | Cancel

3. Click the Field drop-down and select a field on the Order object.
4. Click the Operator drop-down and select an operator for the expression.
5. Click the Map To drop-down and select one of the following:
- None: Evaluate the expression based only on the Field > Operator > Value
defined.
- Function: Date fields only. Specify days or months and the offset value.
- Order: Map the field on the Order object to the value of another standard or
custom field on the Order object.
6. Enter or select a Value for the expression.
7. Click the Add Row (%) icon to add another expression. Repeat steps 3 - 6 to define
additional criteria.
8. Click Advanced Options to add filter logic if necessary (for example: "(1 OR 2) AND 3").
9. Click OK to save the criteria and return to the Workflow Ruleset Detail page.



To create an Order Workflow Rule

You can create only one workflow rule per ruleset. Each workflow rule can contain
one or more workflow rule entries.

. Click New Order Workflow Rule from the Order Workflow Ruleset page. The New

Order Workflow Rule page is displayed.
Enter a Sequence value (begins at "1").
Click the Action drop-down and select one of the following actions to be executed
when the Workflow Ruleset is triggered:
- Amend Order: Automatically amend the order. The order must be manually
accepted after it is amended.
- Amend and Accept Order: Automatically amend and accept the order.
- Cancel Order: Automatically cancel the order. The user must manually accept
the order cancellation.
- Cancel and Accept Order: Automatically cancel and accept the order
cancellation.
(Optional) Enter a Description.
Click the lookup icon and select the ruleset to associate with the rule (automatically
filled when the rule is created from a ruleset detail page.)
Click Save.

To create an Order Workflow Rule Entry

1.

Click New Order Workflow Rule Entry from the Order Workflow Rule page. The New
Order Workflow Rule Entry page is displayed.
Enter a Sequence value (begins at "1"). This defines the sequence in which to execute
the workflow rule entries when the workflow ruleset is triggered.
Click the Context Type drop-down and select Order Line ltem.
Click the Action drop-down and select one of the following actions to be executed
when the rule entry criteria is fulfilled:
- Amend Order Items: Amend the order line item specified by the rule entry
criteria.
- Cancel Order Items: Cancel the order line item specified by the rule entry
criteria.
Click Save.



To define criteria for line item workflow rule entries

Perform the following task to define the criteria that determine which Order Line Items are

amended or cancelled when the workflow rule is executed.

1.
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From the Order Workflow Rule Entry page, click Item Criteria. The Order Workflow
Rule Entry Edit page for Criteria Edit is displayed.
Click Edit. The Criteria Edit page is displayed.

Order Workflow Rule Entry Edit

ORE-0000005

Criteria Edit

Field Operator Map To Value Offset

--None-- v | --None-- v | --None-- v +

Advanced Options

OK| |Cancel

Click the Field drop-down and select a field on the Order Line Item object. Standard
and custom fields on the Order Line Item object are available for selection.
Click the Operator drop-down and select an operator for the expression.
Click the Map To drop-down and select one of the following:
- None: Evaluate the expression based only on the Field > Operator > Value
defined.
- Function: Date fields only. Specify days or months and the offset value.
- Order Line Item: Map the field on the Order Line Item object to the value of
another standard or custom field on the Order Line Item object.
Enter or select a Value for the expression.
Click the Add Row (%) icon. Repeat steps 3 - 6 to define additional criteria.
Click Advanced Options to enter filter logic (for example, “(1 OR 2) AND 3").
Click OK to save the Item Criteria. and return to the Order Workflow Rule Entry page.

To define the input for line item workflow rule entries

Perform this task to define the action taken on one or more Order Line Items defined by the
ltem Criteria when the workflow rule is executed.

1.

From the Order Workflow Rule Entry page, click ltem Input. The Order Workflow Rule
Entry Edit page for Input Edit is displayed.



2. Click Edit. The Input Edit page is displayed.

Order Workflow Rule Entry Edit

ORE-0000005

Input Edit

Field Operator Map To Value Offset
~None- v -

OK| |Cancel

3. Click the Field drop-down and select a field on the Order Line Item object.
4. Click the Operator drop-down and select an operator for the expression.
5. Click the Map To drop-down and select one of the following:
- None: Evaluate the expression based only on the Field > Operator > Value
defined.
- Function: Date fields only. Specify days or months and the offset value.
- Order Line Item: Map the field on the Order Line Item object to the value of
another standard or custom field on the Order Line Item object.
Enter or select a Value for the expression.
Click the Add Row () icon. Repeat steps 3 - 6 to add another input.
Click Advanced Options to enter filter logic (for example, "(1 OR 2) AND 3").
Click OK to save the Item Input and return to the Order Workflow Rule Entry page.
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Use Case: Automatic Subscription Rollover

Description: This use case describes how to create a Workflow Ruleset to handle automatic

subscription rollover for in-flight order changes.

Prerequisite: In-Flight Order Changes and Cancellation must be configured in Order
Management Settings. Refer to the Order Management Administrator Guide for more
information.

You are tasked with modifying an in-flight order for subscription products. The product
originally sold from January Ist to December 31st at a $1200 price point for a quantity of 10.
However, fulfillment order the order is complete on January 3l1st. You need the subscription
term to roll over, meaning that the order must be automatically modified to start on
February Ist and end on January 3lst the next year.

To create the Order Workflow Ruleset
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Click All Tabs () > Order Workflow Rulesets > New (in Salesforce Lightning, go to
App Launcher > Order Workflow Rulesets > New). The New Order Workflow Ruleset
page is displayed.

Enter "Autoroll” as the Ruleset Name.

Click the Type drop-down and select API Execution.

Enter "1" for the Sequence.

From the the Business Context Type drop-down, select Order.

Click the Trigger Context Type drop-down and select Order.

Select the Active check box.

Click Save. The ruleset is created.

To create the Order Workflow Rule

1.
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Click New Order Workflow Rule from the Order Workflow Ruleset page. The New
Order Workflow Rule page is displayed.

Enter "1" for the Sequence.

Click the Action drop-down and select Amend and Accept Order.

Enter "Auto Rollover Subscription on Fulfillment" in the Description field.

Click the lookup icon and select the Autoroll ruleset you created in the first task.
Click Save.

To create the Order Workflow Rule Entry and define criteria

1.

ook wn

Click New Order Workflow Rule Entry from the Order Workflow Rule page. The New
Order Workflow Rule Entry page is displayed.

Enter "1" for the Sequence value.

Click the Context Type drop-down and select Order Line Item.

Click the Action drop-down and select Amend Order Items.

Click Save.

From the Order Workflow Rule Entry page, click Item Criteria. The Order Workflow
Rule Entry Edit page for Criteria Edit is displayed.

. Click Edit. The Criteria Edit page is displayed.

Click the Field drop-down and select Status.
Click the Operator drop-down and select equal to.

. Enter "Fulfilled" for the Value.
. Click OK to save the Item Criteria and return to the Order Workflow Rule Entry page.

To define input for the Order Workflow Rule Entry



For the input, perform the following tasks to shift the start date by a fixed number of days

while keeping the end date the same.

1.
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From the Order Workflow Rule Entry page, click Item Input. The Order Workflow Rule
Entry Edit page for Input Edit is displayed.

Click Edit. The Input Edit page is displayed.

Click the Field drop-down and select Start Date.

Click the Operator drop-down and select equal to.

Click the Map To drop-down and select Function.

Click the drop-down to the right of Map To and select Today.

Click the Add Row (%) icon to add another line.

On the new row, click the Field drop-down and select End Date.
Click the Operator drop-down and select equal to.

Leave the Map To value as --None-- and leave the Value field blank.

. Click OK.

Result:

- The "Auto Roll" Order Workflow Ruleset is created.
- The corresponding rule and rule entry is created. Criteria and inputs are specified to

ensure that when a subscription order line item is fulfilled, the start term is modified
to automatically rollover the subscription term without changing the end date.

Sample Scenarios for Amending Orders Using Workflow

Rules

Refer to the following sample scenarios for amending orders using workflow rules.

1.

2.

Auto Roll
a. To shift the start date and end date of the order by a fixed number of days/
months while keeping the length of the subscription term same. In this case, just
set the “Start Date” to a new date, set “End Date to Null” and do not modify the
term using workflow rule entries.
b. For example, Start Date = Today, End Date = Null.
c. For example, Start Date = Provisioning Date, End Date = Null.

Input Edit

Field Operator Map To Value Offset
Start Date v Function v Today v||--None-- v AND

End Date v --None-- v -

OK | |Cancel

Pro Rata



a. To move the start date of the subscription while keeping the end date
unchanged. In this case, just specify the new start date and do not set End Date
or Term.

b. For example, Start Date = Provisioning Date + 2 Days.

c. For example, Start Date = Provisioning Date, End Date = Previous End Date.

Input Edit

Field Operator Map To Value Offset
Start Date v Order Line Item ¥ Provisioning Date(custom field) v | Offset(+)Days v 2 +

OK | |Cancel

3. Quantity Changes
a. To increase/decrease ordered quantity based on provisioning fulfillment inputs.
b. For example, Quantity = InventoryAvailableQuantity.
c. For example, Quantity = Provisioned Quantity.

Input Edit

Field Operator Map To Value Offset
Quantity v Order Line Item v \ Available Quantity(Custom field) v +

OK | |Cancel

4. Cancelling Order Lines

a. To cancel order lines as inventory is not available for fulfillment. In this case, set
the status to “Pending Cancellation”.

Input Edit

Field Operator Map To Value Offset

Status v --None-- v Pending Cancellation ¥ +

OK | |Cancel

Working With Customer Price Agreements

When business needs cannot be met by converting a quote or contract into a single order,
you can use Order Management to create partial orders against a negotiated Price
Agreement. In this case, when the quote is accepted or the contract is finalized, a Contract
Price List is generated that is part of the Price Agreement. Users can then create partial
orders to fulfill quantities at the negotiated price for product and service line items (on the
quote or contract). Using Price Agreements, you can also track commitment compliance —
how many line items were initially commited to the order initially versus how many have

already been ordered or fulfilled — so that you can then take action based on that
information.

Contract Price Lists are created from a quote or agreement where Intent = Price Agreement.
You can then create partial orders from the line items stored in that Price List.




The Price List and Price List Item (PLI) objects store line item information from the quote or

agreement in the following ways:

- For PLIs with the list price, the new net unit price is copied to the contract price field of

the new PLI.
- For PLIs with matrix pricing (recurring), the matrix is copied from the original PLI to the

new PLI.
- For PLIs with matrix pricing (usage), the matrix is copied from the usage price tiers of
the line item to the new PLI.

When a partial order is generated, product attributes and related line information is copied

from the source line item (quote or agreement) to the target line item:

- Quote to order: When attributes are present on the quote line items, the order is
created from the quote, and CopyBundleConfigurationFromSource = true, the
attributes are copied to the order line items.

- Agreement to order: When attributes are present on the agreement line items, the
order is created from the agreement, and CopyBundleConfigurationFromSource =
true, the attributes are copied to the order line items.

Creating partial orders from Price Agreements allows you to:

- Select one or more line items and the subset of quantity
- Select items from one or multiple quotes or contracts

- Track committed quantity and ordered quantity

- Track commitment compliance

Navigating the Price Agreements User Interface

You can create partial orders using the Price Agreements Ul. Click the Price Agreement tab

to open the Price Agreements page.



APTTUS | Price Agreements

Quotes v

Search Price Agreements Q 5 - 1> ofn
Rows Per Page 1-50f54

Proposal D T Currency IS0 Code T Account Name T Price ListName T Approval Stage ¥ Intent ¥ Ship To Name T

Q-00003486 usD AP Pricelist Accepted Price Agreement

Q-00003425 SEK PKS Accounts PKS Price List Accepted Price Agreement

Q-00003713 usD PKS Price List Accepted Price Agreement

Q-00003715 usD PKS Price List Accepted Price Agreement

Q-00003739 usD PKS Price List Accepted Price Agreement

The default view of the Price Agreements page displays a list of Quotes with Intent=Price
Agreement. Click the drop-down from the upper left-hand corner of the page to switch
between Quotes and Agreements.

You can perform the following actions on the Price Agreements page:

- Use the Search Price Agreements type ahead to filter the list of price agreements by
keyword.

- Click the filter icon () next to a column heading to filter the list of price agreements
by that field.

- Click a column heading to sort the list of price agreements by that column.

- Click the drop-down in the upper right-hand corner to change the number of price
agreements displayed in the list per page.

- Use the pagination controls in the upper right-hand corner to navigate the list of price
agreements.

If you cannot locate the Price Agreements tab, then it is not configured for your org.
Refer to the Order Management Administrator Guide for configuration steps.
Administrators can also configure which columns are displayed in the list of price
agreements.



Creating Partial Orders from Price Agreements

Perform the following task to create a partial order from a Price Agreement (quote or
agreement).



To create a partial order

1. Click the Price Agreement Tab. The Price Agreements page is displayed.

2. Search for and click the Proposal/Agreement ID. The Price Agreement Detail page is
displayed. The Price Agreement Line Items tab is displayed under the price agreement
summaury. Each Price List item displays, start date, end date, the negotiated quantity,
remaining quantity to order, and the quantity to order.

3. Use the Search Products type ahead to filter the list of line items.

4. Enter the Qty to Order for a line item. After you enter any quantity, the Create
Partial Order button is enabled.

5. Click Create Partial Order. The Create Sales Order page is displayed.

6. Enter values in the fields displayed on the page to create the partial order.

7. Click Create Order. The Price Agreement Detail page is displayed. The Order List is
displayed with the newly-created partial order and any other partial orders made
against this price agreement.

8. Click the Home icon () to return to the Price Agreements page. If required, repeat
this task to create another partial order.

Refer to the Order Management Administrator Guide for steps to configure which
fields are displayed in the partial order form, price agreement list, and order list.

Rolling Up Order Line Item Information to Quote and
Agreement Line Items

Prerequisite: Order Line Item must be linked to Quote Line Item or Agreement Line Item.

Information is rolled up from the order line items to the quote or agreement line items when
a partial order is created from the quote or agreement. For example: Whenever there is a
change in the ordered line item for a given agreement line item, the Ordered Quantity is
updated. If there is 1 ordered line item for a given agreement line item, the Ordered Quantity
is 1. As per this feature:

- Quantity from the order line item is rolled up to the ordered Quantity on the proposal
line item.

- Fulfilled quantity is rolled up from the order line item to the fulfilled quantity on the
agreement line item when the fulfilled quantity is updated on the order line item

- Fulfillment status is updated on the agreement line item when the fulfilled quantity is
updated on the order line item as stated below:



a. Fulfilled Quantity = 0: Not Fulfilled
b. Fulfilled Quantity < Quantity and > O : Partially Fulfilled
c. Fulfilled Quantity > = Quantity: Fulfilled

- Order line items in all status except (Cancelled, Superseded, Being Amended, Being
Cancelled) are rolled up.

Splitting an Order

This feature allows you to divide an existing order (parent order) into multiple orders (child
orders) during the provisioning process. You can split any large order that was created from
a Quote, Agreement, or Direct order that has not been amended.

Using this feature you can:

- Split the order on the initiation of acceptance based on customer needs.

- Split the order post creation and before activation using a select set of criteria.

- Split the order before it is activated and track the original order id on the split order.
- Split the order manually by selecting the order lines.

- Amend or cancel the orders that have been split.

Consider the following scenarios when deciding to split an order:

- You have a requirement for handling orders comprising different products.
- Splitting the order based on product availability and delivery timeline.
- Splitting the order to expedite the provisioning process.

Use one of the following methods to perform order split:

1. Manual Split: You can perform the manual split only through API. For more
information, refer to the Splitting an Order using APl topic in Order Management SOAP
APl Guide.

2. Auto Split on Accept: To automate the order split using the criteria on order
acceptance. You can perform split automation using one of the following criteria.

a. Using Global Criteria
b. Using Select workflow Level Criteria
3. Order Workflow Ruleset

- When the order is split, all its child orders should have the same status as the
parent order. For example, If the order with the status '‘pending'is split, then
all its child orders are created with '‘pending’ status.



- When the order is split using criteria fields, the status of the parent order is
updated to '‘Superseded..

Auto Split on Accept

You can automate the order split on acceptance using one of the following criteria.

- Splitting the order on accepting using Global criteria: This splits the order on Quote
acceptance, Agreement activation, or order acceptance based on the global criteria
defined in the Order System Properties.

- Splitting the order on accepting using the selected workflow level criteria: This split
the specific order on Quote acceptance, Agreement activation, or Order acceptance
based on the selection of order lines defined in the order workflow rule criteria.

Splitting the order on accepting using global criteria

To split the order using global criteria:

- Create an Order Workflow Ruleset and Order Workflow Rule. Refer to Creating Order
Workflows to Automate In-Flight Order Changes for step-by-step instructions.

Note:

- When creating an Order Workflow Ruleset, ensure that Record Updated is
chosen as a Trigger Event.

- If the Order Workflow Rule Entry is not defined, the split order action is
performed based on the Global criteria defined in the Custom settings > Order
System Properties.

Usecase: Using Global criteria

Description: This use case describes how to create a Workflow Ruleset to handle the split
order using global criteria.

A large manufacturing company that sells hardware and software products. Its backend
process is handled in different fulfillment systems for the product lines. Sales
representative quotes for 10 hardware items and 5 software items for one enterprise in a
single quote. But, expecting to generate two individual orders for each Line of Business for
fulfillment.



To create the Order Workflow Ruleset:

1. Click All Tabs (+) > Order Workflow Rulesets > New (in Salesforce Lightning, go to
App Launcher > Order Workflow Rulesets > New). The New Order Workflow Ruleset
page is displayed.

Enter "Split Rule" as the Ruleset Name.

Click the Type drop-down and select APl Execution.

Enter "1" for the Sequence.

From the Business Context Type drop-down, select Order.

Click the Trigger Context Type drop-down and select Order.

Add the Order Updated Trigger Event(s) from the Available box to the Chosen box.
Select the Active checkbox.

Click Save. The ruleset is created.
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To create the Order Workflow Rule:

p—

Click New Order Workflow Rule from the Order Workflow Ruleset page. The New
Order Workflow Rule page is displayed.

Enter "1" for the Sequence.

Click the Action drop-down and select Split Order.

Enter "Split order on accepting using <criteria name>" in the Description field.
Click the lookup icon and select the Split Rule ruleset you created in the first task.
Click Save.

Go to Order custom settings, go to Setup > Custom Settings > Order System
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Properties, and enter Line_of_Business__c in the Split Order Criteria fields.

Refer to the following screens for the sample setup for the given use case.

At WWorh fcrm bttt
Split rule-ST
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w Trigger Criteria
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Order System Properties Edit

Provide values for the fields you created. This data is cached with the application.

Edit Order System Properties Save | Save & New Cancel

Order System Properties Information

Name | System Properties i
Initiate Billing On Order Activation ?

Create Asset On Order Activation ?

Enable Inflight Changes And Cancellation

Agreement Fields For Partial Order2

Agreement Fields For Partial Order Apttus__Account -
c.Apttus__Account_ ¢

Agreement ltem Fields For Partial Order2

b

Agreement Item Fields For Partial Order Apttus__Agreementl  ~
d__c Apttus__Produ 2

Quote Fields For Partial Order2

s

Quote Fields For Partial Order ) [anttys Proposal__ A ~
ccount__c Apttus P 2

Quote Item Fields For Partial Order2 Apttus_QPConfig__ .~
EndDate__c Apttus i
Quote Item Fields For Partial Order | |
! ]
Split Order Criteria Fields Line_of_Business__c ‘
A

Spit Order Threshold | |

Result: The above setup triggers the parent order first and then splits into two new child
orders. The parent order remains empty.

Splitting the order on accepting using the selected
workflow level criteria

To split the order using select workflow level criteria:



- Create an Order Workflow Ruleset and Order Workflow Rule. Refer to Creating Order
Workflows to Automate In-Flight Order Changes for step-by-step instructions.

Use Case: Splitting an order using the selected
workflow level criteria

A large Hitech company sells perpetual licenses, software, and professional services. Their
professional services deliverables are managed using a PSA tool. Sales representative
quotes for 100 different licenses, 10 software, 3 professional services offerings in a single
quote. On quote acceptance, the expectation is that the professional service items should
carve out as a separate order for integration with the PSA system.

To create the Order Workflow Ruleset:

1. Click All Tabs (+) > Order Workflow Rulesets > New (in Salesforce Lightning, go to App
Launcher > Order Workflow Rulesets > New). The New Order Workflow Ruleset page is
displayed.

Enter "Split Rule" as the Ruleset Name.

Click the Type drop-down and select APl Execution.

Enter "1" for the Sequence.

From the Business Context Type drop-down, select Order.

Click the Trigger Context Type drop-down and select Order.

Select the Active checkbox.

Click Save. The ruleset is created.
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To create the Order Workflow Rule:

1. Click New Order Workflow Rule from the Order Workflow Ruleset page. The New
Order Workflow Rule page is displayed.

2. Enter "" for the Sequence.

Click the Action drop-down and select Split Order.

4. Enter "Split order on accepting using select workflow level criteria” in the Description
field.

5. Click the lookup icon and select the Split Rule ruleset you created in the first task.

6. Click Save.

w

To create the Order Workflow Rule Entry and define criteria:

1. Click New Order Workflow Rule Entry from the Order Workflow Rule page. The New
Order Workflow Rule Entry page is displayed.

2. Enter "" for the Sequence value.

Click the Context Type drop-down and select Order Line Item.

4. Click Save.

w



5. From the Order Workflow Rule Entry page, click Item Criteria. The Order Workflow
Rule Entry Edit page for Criteria Edit is displayed.

6. Click Edit. The Criteria Edit page is displayed.

7. Click the Field drop-down and select Type of Product.

8. Click the Operator drop-down and select equal to.

9. Click the Map To drop-down and select None.

10. Click the Value drop-down and select Professional Service.

11. Click OK to save the Item Criteria and return to the Order Workflow Rule Entry page.

Refer to the following screens for the sample setup for the given use case.

PR
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Result:

- The "Split Rule" Order Workflow Ruleset is created.

- The corresponding rule and rule entry is created. Criteria and inputs are specified to
create a child order with professional service products. The license and software lines
remain on the parent order.



Creating Order Workflows to Automate Split
Order

The Order Workflow Rulesets enables the automatic triggering of the split action on quote
acceptance, Agreement Activation (Agreement Flow), or Order acceptance ( Direct Order
Flow) for a specific selection of order lines as defined by the criteria on the workflow rule.

Perform the following tasks to set up a Workflow Rule for automating the split order
process.

- To create an Order Workflow Rule for a Split Order
- To create an Order Workflow Rule Entry

To create an Order Workflow Rule for a Split Order

You can create only one workflow rule per ruleset. Each workflow rule can contain
one or more Workflow Rule Entries.

1. Create an Order Workflow Ruleset and define the criteria for the workflow ruleset.
Refer to To create a new Order Workflow Ruleset and To define criteria for the Workflow
Ruleset for step by step instructions.

2. Click New Order Workflow Rule from the Order Workflow Ruleset page. The New
Order Workflow Rule page is displayed.

3. Enter a Sequence value (begins at "1").

4. Click the Action drop-down and select Split Order.
- Split Order: Automatically split an order as per the flow defined in the order
workflow rule.
5. Enter a Description (Optional).
6. Click the lookup icon and select the ruleset to associate with the rule (automatically
filled when the rule is created from a ruleset detail page.)
7. Click Save.

To create an Order Workflow Rule Entry

1. Click New Order Workflow Rule Entry from the Order Workflow Rule page. The New
Order Workflow Rule Entry page is displayed.

2. Enter a Sequence value (begins at "1"). This defines the sequence in which to execute
the workflow rule entries when the workflow ruleset is triggered.



3. Click the Context Type drop-down and select Order Line Item.
4. Click Save.

Working With Distributed Order Fulfillment

Order fulfillment refers to the order life cycle process from the time the order is confirmed
by the customer to the time the order is activated. This includes the following key processes:

- Order release to fulfillment systems
- Order fulfillment status tracking with partial order fulfillment
- Order and Order Line Item activation

The following diagram provides an overview of the data Conga captures to manage the
order and order line items through fulfillment and activation.

Account
(Customers,
Suppliers)

Order
Fulfillment

Service
Location

Order Line
Item

Order
Fulfillment
Line Item

The following objects are used in the distributed order fulfillment process to track and fulfill
order line items from the beginning of order fulfillment to activation.

Data Details

Account Location Specifies the buyer's location where the products or services
are installed. This is an optional field that can be used as
part of an integration with fulfillment systems.

Service Location Specifies the warehouse, plant, factor, fulfillment center,
service center of the seller from which the products or services
are delivered. This is an optional field that can be used as
part of an integration with fulfillment systems.



Data Details

Order Fulfillment Order Fulfillment captures the details of the fulfillment
coming from the fulfillment systems. A given fulfillment is for
one or more orders for a given account for fulfillment
completed on a specified date.

Order Fulfillment Line Item Order Fulfillment Line item captures the quantity fulfilled

against a given order line item. This is the information

provided by the fulfillment systems and is used to track the

total quantity fulfilled against the order line item. A given

order line item can have multiple order fulfillment line items

across one or more order fulfillment.

The following fields are used in the distributed order fulfillment process to track and fulfill

order line items from the beginning of order fulfillment to activation.

Data

Order Line Item > Ready for Fulfillment
Date

Order Line Item > Fulfilled Quantity

Order Fulfillment > Account

Order Fulfillment > Fulfillment Date
Order Fulfillment Line Item > Fulfilled

Quantity

Order Fulfillment Line Item >
Fulfillment In Progress?

Details

Set this field on the parent order to apply it to all order
line items associated with that order. (Note: Setting this
date does not have any effect on Order Fulfillment Line
Items or fulfillment status.

This field is automatically updated when the Order
Fulfillment Line Item > Fulfilled Quantity for the given
Order Line Item is saved.

The Account associated with one or more Order
Fulfillment Line ltems over one or more orders.

The date that corresponds to a single Order Fulfillment.

Set this field and save it to automatically updated the
Fulfilled Quantity field value on the corresponding Order
Line Item.

Enable this flag on an Order Fulfillment Line Item to
track stages of fulfillment for the corresponding Order
Line Item. The Order Line Item Fulfilled Quantity and
Status will not be changed regardless of fulfillment
quantity as long as this flag is enabled.



Data Details

Order Fulfillment Line Item > Status Set this field to indicate the fulfillment status of an
Order Fulfillment Line item. The Status is automatically
updated to "Fulfilled" when the Fulfilled Quantity is
greater than or equal to the Delta Quantity on the
corresponding Order Line Item and "Fulfillment in
Progress?" is disabled.

Releasing Orders to Fulfillment Systems

After an Order is activated, the order must be fulfilled by delivering the purchased products
or services to the customer. This process is known as Order Fulfillment. Conga Order
Management supports distributed order fulfillment. This means that a single order can be
fulfilled from different locations, warehouses, factories, or at different times in the
fulfillment process. This is represented by the Order Fulfillment object that is associated
with a specific Account.

Similarly, a single Order Fulfillment can have multiple Order Fulfillment Line Items that are
all part of the same order or from multiple orders. Fulfillment is tracked for one or more
orders in this way through the Fulfillment Line Items.

You can use the field Service Location on the Order Line Item to track from which
warehouse or fulfillment location the order will get fulfilled. Provide the value for Service
Location manually on the Order Line Item or using workflow rules.

Working with Order Fulfillment

Order Fulfillments are created based on input from fulfillment systems, such as SAP ERP,
Oracle ERP, and so on. Order Fulfillment and Order Fulfillment Line ltems can be created
manually, but in most cases, these objects will be created through integrations with
fulfillment and provisioning systems.

One Order Fulfillment can correspond to multiple orders for a given account. In this case,
the Order Fulfillment captures all order line items to be fulfilled for a given customer on a
particular date from the group.
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« Back to List: Custom Object Definitions
Order Fulfilment Line Items [5+]
Order Fulfillment Detail Edit | | Delete  Clone
Fulfillment Number  F-00000005 Owner [ [Change]
Fulfilled Date . 7/9/2019 Account
Created By 7/9/2019 2:50 AM Last Modified By 7/9/2019 2:50 AM
Edit | | Delete| | Clone
Order Fulfillment Line Items Order Fulfillment Line tems Help 2
Action Lineitem Id Line Number Order Order Line item Fulfilled Quantity
Edit | Del FI-0000000008 1 01-0000008828 1.00000
Edit | Del F1-0000000009 1 0-00003029 Q1-0000008882 1.00000
Edit | Del FE1-0000000010 1 0-00003029 01-0000008882 1.00000
Edit | Del FI1-0000000011 1 0-00003510 Q1-0000009716 2.00000
Edit | Del F1-0000000013 1 0-00003510 Q1-0000009716 8.00000
Show 5 more » | Go to list (17).2

It is important to understand that one Order Fulfillment is not related to an order in any
way. The fields to consider on the Order Fulfillment object are the Fulfilled Date and

the Account associated with the fulfillment. Fulfillment of any actual orders is completed
and tracked through the Order Fulfillment Line Items that comprise the particular Order
Fulfillment.

All order line items from a given order do not need to be fulfilled for given order
fulfillment. Order can be fulfilled through multiple order fulfillment. Refer to Tracking
Order Fulfillment.

Working with Order Fulfillment Line Items

Order Fulfillment Line Items are created based on the input from fulfillment systems as the
quantities for Order Line Items are fulfilled. A given Order Fulfillment Line Item corresponds

to a given Order Line Item. It represents the quantity fulfilled for a given Order Line Item on

a given date.

One Order Line Item can have multiple Order Fulfillment Line items across multiple Order
Fulfillments. The Fulfilled Quantity field on an Order Fulfillment Line Item is aggregated for
a given line item and is updated on the Fulfilled Quantity field for the corresponding Order
Line ltem. When the Fulfilled Quantity of an Order Fulfillment Line Item is saved, the
Fulfilled Quantity on the linked Order Line Item is updated and the status of the Order Line
ltem is updated to one of two statuses:

- If the Fulfilled Quantity is greater or equal to the Delta Quantity, the Order Line Item
status is updated to "Activated."

- If the Fulfilled Quantity is greater than zero, and less than the Delta Quantity, the
Order Line Item status is updated to "Partially Fulfilled."



Order Fulfillment Line ltem Edit Layout | Print3y
FI-0000000008

« Back to List: Custom Object Definitions

Order Fulfiliment Line Item Detail Edit | Delete| Clone
Lineltem Id FI-0000000008 Order Fulfillment F-00000005
Line Number 1 Order
Fulfillment In Progress? Status  Fulfilled
Fulfilled Quantity 1.00000 Order Line Item 01-0000008828
Created By 7/19/2019 5:15 AM Last Modified By 7/22/2019 3:30 AM

Edit | Delete| Clone

Tracking Order Fulfillment

The Order fulfillment process calls for differing lifecycles for each of its order fulfillment
line items depending on how the order is being fulfilled. As a result, Conga Order
Management provides a partial order fulfillment to control this process at different levels,
such as:

- The entire order is activated and fulfilled as a whole.

- Some of the line items in the order are activated while other line items are still
undergoing fulfillment.

- Individual line items are partially fulfilled at different times (for example, part of the
quantity for a given order line item is fulfilled and tracked as partially fulfilled).

Scenarios for Partial Order Fulfillment:

- Company X receives an Order for 40 'platinum configuration' servers. The
warehouse has only 30 units available. In this case, the Order is partially
fulfilled with 30 units ready for delivery.

- A company producing Automobile spare parts has two production units for its
products. It receives an Order for 10 different products. Since each product is
manufactured at a different time in the production unit, the Order is fulfilled
as and when the products complete the production process from start to
finish.

As fulfillment line items are created and fulfilled, order line items associated with one or
more orders are fulfilled, eventually resulting in the activation of order line items and
orders as part of the process.



Extending Order Fulfillment Tracking

For most cases, the fulfillment of line item quantities followed by activation of the order
line item is not sufficient for integration with fulfillment systems. When fulfillment scenarios
require a series of intermediate steps in the fulfillment process you can enable the
Fulfillment in Progress? field on the Order Fulfillment Line Item object. When this flag is
enabled, any update to the Fulfilled Quantity on that fulfillment line item will not roll up to

the corresponding order line item.

The Status field on the Fulfillment Order Line Item object designates the current stage of
the fulfillment process. When all intermediate steps of the fulfillment process are complete,
disable the Fulfillment in Progress? flag. This sets the status of the Fulfillment Line Item to
“Fulfilled," which then triggers an update in the status of the corresponding Order Line Item.

Order Fulfillment Line Item Edit Layout | Printable
F1-0000000008

« Back to List: Custom Object Definiticns

Order Fulfillment Line Item Detail Save | Cancel
Lineltem Id FI-0000000008 Order Fulfillment F-00000005

Line Number 1 QOrder

Fulfillment In Progress? Status Shipped .

Fulfilled Quantity  1.00000 Order Line Item —-None—
Created By  OM QA (Summer 18), 7/19/2019 5:15 AM Last Modified By e e 19), 7/22/2019 3:30 AM
ippe
Save | Cancel Delivered
Prepared

The Status field is not present on the Order Fulfillment Line Item page by default. An
administrator must add it to the page layout to make any manual changes to

status.

Using Service Locations to Track Partial Order Fulfillment

You can use the field Service Location on the Order Line Item object to track partial order
fulfillment by shipping or service location. When you extend order fulfillment in this way, set
the Service Location as part of the fulfillment process using workflow rules. For example,
you may want to set a rule that help you to categorize order related to the USA under

dollar ($) currency price lists and not under INR currency price lists.

The Service Location field is not present on the Order Line Item page by default. An
administrator must add it to the page layout to make any manual changes to

Service Location.




Activating an Order

Activating an order and its associated order line items indicates completion of the order
fulfillment process and initiation of additional related downstream processes. Downstream
processes include asset activation, billing initiation, revenue recognition, and so on.

Orders and Order Line Items are activated in the following ways:

- Auto Activate the order on generation from a quote/proposal: The Auto Activate
Order flag is set to "true" on the quote/proposal. This generates an order with the
status "Activated.”

- Auto Activate the order on generation from an agreement: The Auto Activate
Order flag is set to "true" on the agreement. This generates an order with the status
"Activated.”

- Set the Ready for Activation Date on the order: The Ready for Activation Date is
specified on the order. This activates the order and its line items and initiates any
downstream processes (if enabled), such as billing.

- Set the Ready for Activation Date on the order line item: The Ready for Activation
Date is specified on an order line item. This activates the order line item but does not
activate the corresponding order unless all of its line items are activated.

- Auto Activate the order on confirmation (Accept action) of a direct order: The Auto
Activate Order? field is set to "true" on the order header.

- Activate order and order line items based on the line item fulfilled quantity:

- Once the Fulfilled Quantity for a given line item is greater than or equal to
the Delta Quantity, the Order Line Item status is set to "Fulfilled."
- Once all the Order Line Items are "Activated”, the corresponding order is also

marked as "Activated.”

Providing a Legal Entity for Downstream
Processes

The Legal Entity field on the Order object can be specified to enable billing and revenue
recognition for related legal entities. When an order line item is activated and an asset is
created, the Legal entity value specified in the order header is copied to the Legal Entity
field for the corresponding Asset Line Item.



When a quote or agreement has a value for Legal Entity, that value is
automatically copied when the quote or agreement is converted to an order. When
you place a direct order or the field is not present in the quote or agreement record,
you must specify a Legal Entity to enable any downstream processes.

Billing for an Order

Conga billing and invoicing can be initiated for the orders either before or after activation
of the order. When billing is initiated depends on Order Management settings.

To create billing schedules on activation of an
order

1. Go to Setup > Custom Settings > Order System Properties

2. Click Manage.

3. Click Edit.

4. Click the check box next to Initiate Billing On Order Activation? and click Save.

To create billing schedules manually

Prerequisite: The custom setting Initiate Billing On Order Activation? must be disabled.

1. Go to the order record and set the Ready for Billing Date field.
2. Click Save.

If the Ready for Billing Date is set to a date before the order is activated, the billing
schedules are created when the order becomes active.



Use Case: Billing for Standalone Recurring product

Tierl system sells ‘SecureDevice’ ($100/unit) which is billed monthly for a contract

period of one year. The contract is in effect from 04/20/2016. The customer wants an

invoice on 15th of every month.

Steps:

1.

~

Add a product ‘SecureDevice’ with List Price as $/00 and Price Type as
Recurring.

Under the Tax and Billing tab on PLI, set the Billing Rule as Bill in Advance and
Billing Frequency as Monthly.

Create a new Billing Preference and set Billing Cycle Start to Billing Day of
the month.

Set Billing Day of the month to 15th of the month.

Create a Quote/Proposal. Set Start Date as 04/20/2016 and End Date as
04/19/2017.

Add the product to your cart and Finalize.

Present the proposal and Accept it after the reviews.

Order and Asset are created when the proposal is accepted. Activate the
order.

Resulting Billing Schedules

Period Start Date Period End Date Ready for Invoice Amount
Date

4/20/2016 5/14/2016 4/20/2016 $83.33

5/15/2016 6/14/2016 5/15/2016 $100

6/15/2016 7/14/2016 6/15/2016 $100

Working with Customer Purchase Orders

In Order Management, a Customer Purchase Order is a customer document (usually PDF or

email) that represents the initial offer of negotiated types, quantities, and prices for

products or services. Customer Purchase Orders can be created by sales users or

administrators as sales orders for long-term contracts.

The following diagram illustrates the customer purchase order lifecycle.
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When a customer places a purchase order, they submit a document that references the
quote or agreement line item numbers from an associated customer price agreement. When
Conga Order Management receives that purchase order the purchase order is validated
against the line items and negotiated pricing in the price agreement, and any data
enrichment rules are applied. The user must then mitigate any of the existing validation
errors or warnings and accept the purchase order. Sales orders can then be placed against
the purchase order and follow the same lifecycle from that point as with any other order
processed by Conga Order Management.




Customer Purchase Order End-to-End Process
Seller | Buyer
. 1
Customer . Customer | Receive I send PO Create
_Validate / < < Purchase |
Price ~Enrith Purchase Acknowledge I Recei Ord l
3 g ‘ | eceive . rder
reement Genera?erder Accept I Acknowledgment ©
Order(s) :
Sales SenclO'rder ] _ Seller Order
Order(s) Notification | “ | Confirmation
: 1
Fulfill l | -
ose
Close PO Fulfillment (s) [—2rder 1 > Order
Fulfillment Delivery
Invoice |
[T
. Sen L - | Seller Invoice
Invoice (s) Invoice : >
| Process Payment Jv
Receive !
Payment(s) <—pz menr Payment |
60 1

Refer to the following table for the tasks described in the portion of the user guide.

Function Description

Capture Customer Purchase Orders - Capture raw purchase orders from customers
- Add PDF or Email as attachments to
Customer POs

Manage Validation / Enrichment Rules - Create and manage rules to validate, match,
and enrich PO
- Add PO items against customer’s existing
contracts, Quotes, and other master data

Validate PO against Quotes/Contracts - Validate or enrich PO and PO items against

customer’s existing contracts, Quotes, or other
master data

PO Exception or Issue Logs - Capture errors or issues identified during data
validation and enrichment of customer PO
and PO Items

View PO header and line item validation - View data validation issues for header and

issues line items



Function Description

Fix data validation and match issues - Allow users to fix data validation or matching
issues
- Maintain version history of changes for audit
trail

Create or Generate Sales Orders - Convert the PO to a single sales order
- Auto convert PO to multiple sales orders
based on split criteria
- Create partial orders from a PO

Amend or Cancel Inflight Customer PO - Amend in-flight PO to add a line, change lines,
cancel lines
- Cancel in-flight PO

Track orders and fulfillment against PO - Track ordered quantity by PO items
- Track fulfilled quantity by PO items

Understanding Customer Purchase Order Status

As a Customer Purchase Order moves through the order lifecycle, the purchase order and its
line items are assigned a status. The following table describes the mapping between
Customer Purchase Order (PO) and PO Item statuses:

PO Status PO Item Status
Draft - All items are in "Draft" status.
Accepted - All items are in "Accepted" status and the Customer

PO is not in "In Amendment" status.

- One or more items are in "Accepted" status while
remaining items are in "Cancelled" status and
Customer PO is not in "In Amendment" status.

- PO Items and header may have errors.



PO Status PO Item Status

Partially Processed - Any one item is in "Partially Processed"status and
Customer PO is not in "In Amendment"” status.

- One or more items are in "Processed" status while
remaining items are in "Accepted" status and
Customer PO is not in "In Amendment" status.

Processed - AlL PO items are in "Processed" status.
- One or more items are in "Processed" status while
remaining items are in "Cancelled" status.

Rejected - ALl PO Items are in "Rejected" status.
- PO Items and header may have errors.

In Amendment - PO Is explicitly amended and the current version is
the latest one.
- PO items can be in "Draft," "In Amendment," "Pending

Cancellation," "Cancelled," "Partially Processed,” or
"Processed" statuses.

- PO Items and header may have errors.

Pending Cancellation - AlL PO Items are in "Pending Cancellation” status.
Cancelled - AWL PO Items are in "Cancelled” status.

Being Cancelled - Next version exists in "Pending Cancellation” status.
Being Amended - Next Version exists in "In Amendment” status.
Superseded - Next version in "Accepted" status.

Managing CPO Validation and Enrichment Rules

When you create a Customer Purchase Order in Order Management, you need to ensure
that the Customer Purchase Order (CPO) you create contains Purchase Order Items (PO
Items) that match line items coming from one or more referenced quotes, contracts, or price
agreements. To accomplish this, you must configure Validation rules that validate data
entered in the CPO against existing data in the price agreement, as well as Data
Enrichment rules that automatically enter data for specific fields onto the CPO rather than



having to do it manually. When these rules trigger, they display errors or warnings that can
be correct by the user creating the CPO before any orders are created.

You can create CPO Validation and Enrichment rules using the Purchase Order Admin (PO
Admin) user interface. The PO Admin Ul provides a step-by-step wizard that allows you to
create a Data Enrichment and Validation Ruleset which contains one or more Data
Validation and/or Data Enrichment rules that are triggered based on specified criteria
when you are creating your CPO. You can then review and activate these rules prior to
accepting the CPO.

Refer to Setting Up Purchase Order Admin in the Order Management Administrator Guide for
step-by-step instructions for setting up the PO Admin angular Ul.

Use the PO Admin Ul to create rulesets containing the following rule types:

- Data Enrichment Rules: Use these rules to enrich the data in your CPO. For example,
the PO item account must be the same as the Proposal Line Item or Source Object
Account. You can define the data enrichment rule in order to input this data whenever
you create a customer purchase order instead of feeding this data manually.

- Data Validation Rules: Use these rules to set up data validations for purchase orders
or their items so that whenever you specify the values for quantity or fulfilled
quantity, a data validation rule is triggered to ensure that the values fall within the
specified limits. You can have two types of validations:

- Warning: This type of data validation rule allows you to continue the operation
despite the system warning. However, it warns you to take precautions while
creating sales orders.

- Error: This type of data validation rule does not allow to bypass the error and
stops the operation until you mitigate the error before continue creating the
sales orders.

Perform the following tasks in this section to create and manage CPO Validation and

Enrichment rules.

- Creating Data Enrichment and Validation Rules

- Mitigating Data Validation Issues

Creating Data Enrichment and Validation Rules

You can use the Purchase Order Admin (PO Admin) user interface to create and manage
Data Enrichment and Validation rules for your Customer Purchase Orders.

A Data Enrichment and Validation Ruleset defines the target object (Customer PO or
Customer PO Item), the source object (Quote/Proposal, Contract, Order, Proposal Line Item,
Agreement Line Item, or Order Line ltem), the criteria to be applied to the target and source
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objects, and any additional filter logic. When criteria for a ruleset is fulfilled, the
Enrichment and Validation Rules defined in the ruleset are triggered and any actions
specified in its rules are executed. Perform the following task to create a Data Enrichment
and Validation Ruleset and its rules.

Do not click your browsers "Back" button when using the PO Admin.

- To create Enrichment and Validation rules using the PO Admin

- Use Case: Creating a Data Enrichment/Validation Ruleset for a Customer Purchase Order

To create Enrichment and Validation rules using the PO
Admin

1. Navigate to the PO Admin tab. The Customer Purchase Order Admin page is
displayed.

If you cannot find the PO Admin tab, your administrator must add the tab in
Salesforce. Refer to the Order Management Administrator Guide for steps.

2. From the upper right-hand corner in the header, click Create New Rule. The Data
Enrichment and Validation Setup wizard is displayed.

3. Enter a Ruleset Name and the Sequence, which indicates the order in which this
ruleset will be validated on confirmation of the customer purchase order (starts at
"1").

4. From the Target Object To Validate drop-down, select either Customer Purchase
Order or Customer PO Item.

5. If you selected Customer PO Item as the object to validate, click the Target Object
Parent drop-down and select Customer Purchase Order.

6. From the Source Data Object drop-down, select the source object on the price
agreement you want to match to the customer purchase order.

7. Click Next to display the Specify Target Data Filter Criteria screen.

8. Click Add and define filter criteria to be applied to the target Customer PO or PO
ltem:

a. Select a Field on the Target object (for example, Status).

b. Select an Operator.

c. Enter or select a Value for the field (for example, Draft. In this case, whenever
the system finds a status in Draft, the rule is triggered for the Customer
Purchase Order).



13.

16.

Click Add to add another filter to the target and repeat step 8. You can remove
defined filter criteria by clicking the Delete icon ().

. Add any Filter Logic as needed.
. Click Next to display the Specify Source Data Filter Criteria screen.
. Click Add and define the filter criteria to match a field on the source object (Quote/

Proposal, Proposal Line Item, Agreement, Agreement Line Item, Order, or Order Line
ltem) with a field on the Customer PO or PO Item, or to validate a field on the source
object against a field on the Customer PO or Customer PO Item:

a. Select a Field on the Source object (for example, Proposal Line Item).

b. Select an Operator.

c. Tomatch a field on the source object with a field on the Customer PO, click the
Value Type drop-down and select Field Value. Then select one or more values
from the Target Field drop-down.

d. To validate a field on the source object against a field on the Customer PO,
click the Value Type drop-down and select Constant. Enter the value for the
field on the target object.

Click Add to add another filter to the target and repeat step 12. You can remove
defined filter criteria by clicking the Delete icon ().

Click Save and Close to save the ruleset or click Next to display the Specify
Enrichment Rules screen.

. Define an Enrichment rule to set a value on the Customer PO or PO ltem to a value

from the selected Source Object field:
a. Select the Target Object Field (for example, Contract Item Number).
b. Select the Source Object Field (for example, Record ID).
c. Click the toggle to make the field a required field on the Customer Purchase
Order or PO Item.
d. Enter the Message to be displayed to the user when an error occurs (for
example, when either the target or source object field is not found).
Click Add to add another rule to the ruleset and repeat Step 15. You can remove a
rule by clicking the Delete icon (W),
Click Save and Close to save the ruleset or click Next to display the Specify
Validation Rules screen.

. Define a Validation rule to validate a value in the CPO or PO Item against the master

data in the Source object field:
a. Select the Target Object Field (for example, Quantity).
b. Select the Match Operator (for example, "less than or equal to").
c. Select the Source Object Field (for example, Quantity (2)).
d. Select the Error Type to be triggered when the rule does not evaluate to true:
Warning or Error.
e. Enter the Message to display to the user when an error occurs.



19.

20.

21.
22.

Click Add to add another rule to the ruleset and repeat step 18. You can remove a rule
by clicking the Delete icon ().

Click Next to display the Review screen. You can review the entire Data and
Enrichment Validation Rule Setup on this page. If you need to make any changes,

click Previous to return to the appropriate step.

Click Done to save the ruleset and return to the PO Admin page.

Click Activate to activate the ruleset.

When a rule is executed and any errors are found, they are recorded in the log.



Use Case: Creating a Data Enrichment/Validation Ruleset for
a Customer Purchase Order

Description: The requirement for this Customer Purchase Order is to create and apply Data
Enrichment and Validation rules as part of a ruleset that enriches the PO using data on the
quote line item. The ruleset then validates that the quantity entered in the PO is the same
as the quantity on the quote line item. This use case is an example of a ruleset that can be
applied to multiple purchase orders with varying combinations of products and services.

In the following example, an administrator or sales user/customer support representative
with appropriate permissions creates a Data Enrichment/Validation Ruleset and the
Enrichment and Validation rules that comprise it.

Prerequisites:

- The Customer Purchase Order and Purchase Order Admin user interfaces must be
configured.
- Data Enrichment/Validation Ruleset seed data must be configured.

Refer to Order Management on SFDC Administrator Guide for configuration steps.

To create a Data Enrichment/Validation Ruleset to enrich the Customer Purchase Order
and validate order quantities against quote line items

1. From the upper right-hand corner in the header, click Create New Rule. The Data
Enrichment and Validation Setup wizard is displayed.
Enter "Enrich PO and validate quantity” as the Ruleset Name.
Enter "1" in the Sequence field.
Click the Target Object To Validate drop-down and select Customer PO Item.
Click the Target Object Parent drop-down and select Customer Purchase Order.
Click the Source Data Object drop-down and select Proposal Line Item.
Enter the Description "Enrich PO and validate quantity against QLL."
Click Next to display the Specify Target Data Filter Criteria screen.
Click Add and define the following filter criteria:
a. Click the Field drop-down and select the field "Status.”
b. Click the Operator drop-down and select "in." Value type is "Constant.”
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c. Click the Value drop-down and select "In Amendment" and "Draft."
10. Click Next to display the Specify Source Data Filter Criteria screen.
11. Click Add and define the following filter criteria:
a. Click the Field drop-down and select the field "Line Item Id."
b. Click the Operator drop-down and select "equal to." Value type is "Field Value.'

c. Click the Value drop-down and select "Quote Line Item."



12.
13.

16.

18.
19.
20.

Click Next to display the Specify Enrichment Rules screen.
Click Add and define an Enrichment rule to set the value for the Product field on the
Customer PO Item to the value of the same field on the Proposal Line Item:
a. Click the Target Object Field drop-down and select Product.
b. Click the Source Object Field and select Product.
Click Add and define an Enrichment rule to set the value for the Ship To field on the
Customer PO Item to the value of the same field on the Proposal Line Item:
a. Click the Target Object Field drop-down and select Ship To.
b. Click the Source Object Field and select Ship To.
c. Click the toggle to make Ship To a required field on the Customer Purchase
Order or PO Item.
d. Enter the Message "Ship To not found at the source on the line item" (this
displays a message to the user when the Ship To field has no value on the
corresponding quote line item).

. Click Add and define an Enrichment rule to set the value for the Net Price field on the

Customer PO Item to the value of the same field on the Proposal Line Item:
a. Click the Target Object Field drop-down and select Net Price.
b. Click the Source Object Field and select Net Price.
Click Next to display the Specify Validation Rules screen.
Define a Validation rule to validate Quantity of the PO Item against master data in
the Proposal Line Item record:
Click the Target Object Field drop-down and select Quantity.
Click the Match Operator drop-down and select equal to.
Click the Source Object Field drop-down and select Quantity (2).
Click the Error Type drop-down and select Error.
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In the Message field, enter "PO quantity does not match the value on the
proposal line item."

Click Next to display the Review screen.

Click Done to save the ruleset and return to the PO Admin page.

Click Activate to activate the ruleset.

Result: A Data Enrichment/Validation Ruleset is created and activated. Any custom

purchase orders created in the system from this point forward will use the enrichment and
validation rules defined by the ruleset.

Next Step: Create a Customer Purchase Order and Purchase Order items for an accepted
quote.



Mitigating Data Validation Issues

Conga Order Management displays the data validation messages based on the data
validation rules that you set while configuring a ruleset.

For example,

If you have set proposal item quantity cannot be greater than PO Iltem quantity, then after
the data validation rule is executed, Conga Order Management maps the target and
source object fields for quantity.

Depending on the error type that you configured in the data validation rule, a warning or
an error is shown that you need to act upon in order to complete the operation.

Customer PO Issue Logs

For the In-Amendment orders, when you click Validate Customer PO Conga Order
Management generates all the PO related issue details in the Customer PO Issue Logs.

Error or Warning fields
Based on the below fields you can identify errors with your Customer PO and its items.

- Validation Errors
- Number Of Errors
- Number Of Warnings

To fix the errors, you can go to each ruleset using the issue log and amend the CPO that are
in Draft and In-Amendment states.

Creating Customer Purchase Orders

Before you can create a sales order from a purchase order, you must capture the details of
the customer purchase order by creating it manually using the Order Management Ul

Customer Purchase Orders can be created automatically through integration, as
long as the Purchase Order data comes to Conga in a machine-readable format
(for example, XML or JSON). For assistance with this procedure, contact Conga
Professional Services.

To create a customer purchase order

1. Navigate to the Customer Purchase Orders tab. The Customer Purchase Order page
is displayed.



2. Click New Purchase Order. The New Purchase Order page is displayed.

3. Enter the following fields in the Order Basic section of the page: Previous
Version, Account, Account Name, PO Date, Price List, and Price List Name. Enter
the Quote Number/Proposal number associated with the Price Agreement. Enter any
additional fields as required.

4. Enter the following fields in the Order Customer section of the page: Bill To, Ship
To, and Contact. Enter their corresponding reference fields to store the IDs. The
Account Reference field is the record Id received from the external system.

5. Add the Requested Delivery Date.

6. Click Save & Add Products. The PO Number is autogenerated. The Status of the
Customer Purchase Order is set to Draft.

7. Once the purchase order is created, click Add/Edit Line Items to modify existing
purchase order line items or add new line items to the customer purchase order. Click

Save to save line items.

You can Add/Edit Line Items only when the purchase order is in "Draft” or "In
Amendment" status.

Accepting Customer Purchase Orders User Guide

After you create a Customer Purchase Order, the status of PO and its line items changes to
"Draft.”

To accept a Customer PO

1. Navigate to the Customer Purchase Orders tab. The Customer Purchase Order page
is displayed.

2. Use the type ahead to filter the list of purchase orders. Click the PO Number for the
purchase order you want to view. The Customer Purchase Order detail page is
displayed.

3. If there are any errors or warnings in the purchase order, a warning icon is displayed
along with the number of errors and warnings. Click View Details to view the list of

errors and warnings.
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Click Accept. The status of the CPO and its PO Items changes to Accepted.

The Accept button is only enabled when the PO is in "Draft," "In Amendment,” or

"Pending Cancellation” status and at least one line item has been added.

Click the info (@) icon to view a list of warnings and errors. Click Correct Problem to

take mitigating action for any errors.

6. After you have corrected all errors, you can create a sales order.

Amending Customer Purchase Orders User Guide

Amend a Customer Purchase Order to create a new version after accepting a purchase

order and correcting any errors. You can only amend a CPO when the status is in

"Accepted” or "Partially Processed."

To amend a Customer PO

1.

Navigate to the Customer Purchase Orders tab. The Customer Purchase Orders page
is displayed.
Use the type-ahead to filter the list of purchase orders. Click the PO Number for the
purchase order you want to view. The Customer Purchase Order detail page is
displayed.
Click Amend. A confirmation dialog is displayed.
Click Yes to confirm the amend action:

- A new version of the CPO is created and assigned the "In Amendment" status.

- The Accept Button and Undo Amend buttons are enabled.

- The status of the previous version is updated to "Being Amended."
Add, Edit, or Delete a PO Item as required. For details, refer to Creating Customer
Purchase Orders. You can add a new PO item or edit the quantity of an existing PO item
as appropriate.
Click Accept. The status of the PO and its line items changes to "Accepted.” The status
of the previous version changes to "Superseded.”



Reverting Changes to an Amended Customer Purchase
Order

You can revert the changes that you made to the CPO by using Undo Amend Order action.
You can only revert Customer POs in the "In Amendment" status.

To undo an amendment to a Customer PO

1. From the Customer Purchase details, click Undo Amend Order:
- Any changes made to Customer PO and its line items are rolled back to the
previous version.
- The status of the previous Customer PO and its line items changes to
"Accepted.”

Cancelling Customer Purchase Orders User Guide

You can cancel a Customer PO when it is in the "Accepted"” status.

To cancel a Customer PO

1. Navigate to the Customer Purchase Orders tab. The Customer Purchase Order page
is displayed.

2. Use the type ahead to filter the list of purchase orders. Click the PO Number for the
purchase order you want to view. The Customer Purchase Order detail page is
displayed.

3. Click Cancel Order

- The Status of PO and its line items changes to Pending Cancellation.

- The Accept button is enabled.

- A new version of the PO is created.

- The status of previous version changes to Being Cancelled and the status of PO
items remains Accepted.

4. Click Accept. The status of the Customer PO and its line items changes to "Cancelled.
The status of previous version changes to "Superseded.”



Reverting Cancelled Customer Purchase Orders

You can revert cancelling a Customer PO and its items by using the Undo Cancel

Order action.

To undo cancel a customer PO

1. From the Customer Purchase Order details page, click Undo Cancel Order.
- The changes made to customer PO and its line items are rolled back to the old

version.
- The status of the previous Customer PO and its line items changes to

"Accepted.”

Creating Sales Orders from a Customer Purchase
Order

After a Customer Purchase Order is accepted and validated, you can create one or more

sales orders from the purchase order.
You can create a sales order from the purchase order in one of three ways as follows:

- Create Single Order: Create a single order for the whole customer PO.
- Split Multi Orders: Select one or more "split criteria” to create multiple orders
organized into groups based on the criteria (for example, group PO Line Items by

Contract Number).
- Create Partial Order: Create a partial order from one or more PO Items.

For more information about creating orders from Customer Purchase Orders APIs,
refer to the Order Management SOAP API Guide.

Creating a Single Order

After an order is accepted and any errors or warnings are resolved, you can create a single

order from the entire Customer PO.

Do not click Cancel to go back to the previous page as this will cancel the entire
Customer Purchase Order. Click the Home icon (%) icon to return to the list of

purchase orders.



To create a single order from the CPO

1. Navigate to the Customer Purchase Order tab.

2. Use the type-ahead to filter the list of purchase orders and click a PO Number to view

the purchase order details.

3. From the header in the upper right-hand corner of the page, click Create Sales Order

and select Create Single Order:

- The Order is generated under the Sales Orders tab.

- The status of the sales order generated from the customer purchase order is
updated to "Pending."

- The status of the purchase order is updated to "Processed."

Creating Multiple Sales Orders

After an order is accepted and any errors or warnings are resolved, you can split the
Customer PO into multiple orders based on split criteria. For example, PO Line Number,
Quantity, Net Price, End Date, and so on.

Do not click Cancel to go back to the previous page as this will cancel the entire
Customer Purchase Order. Click the Home icon () icon to return to the list of
purchase orders.

To create a split order from the Customer PO

. Navigate to the Customer Purchase Order tab.

. Use the type-ahead to filter the list of purchase orders and click a PO Number to view

the purchase order details.

. From the header in the upper right-hand corner of the page, click Create Sales Order

and select Split Multi Orders. The Create Multiple Sales Order screen is displayed.

. Click the drop-down to select one or more Split Criteria to group purchase order items

into multiple orders.

. Scroll to the bottom of the page to view a message indicating how many orders will

be created.

. Click Create Sales Order. Multiple sales orders are created based on Split Criteria:

- Each order is generated under the Sales Orders tab.

- The status of each sales order generated from the customer purchase order is
updated to "Pending.”



- The status of the purchase order is updated to "Processed."

Creating Partial Orders

After an order is accepted and any errors or warnings are resolved, you can create a
Partial Order from the Customer Purchase Order. Create a partial order when you only
need to order a partial quantity of the PO Items listed on the Customer PO.

Do not click Cancel to go back to the previous page as this will cancel the entire
Customer Purchase Order. Click the Home icon (@) icon to return to the list of
purchase orders.

To create a partial order from the Customer PO

1. Navigate to the Customer Purchase Order tab.

2. Use the type ahead to filter the list of purchase orders and click a PO Number to view
the purchase order details.

3. From the header in the upper right-hand corner of the page, click Create Sales
Order and select Create Partial Order. The Create Partial Order screen is displayed.

4. Use the type ahead to filter the list of PO Items.

5. For each PO Item, enter a Process Qty for the partial order. Process Qty must be less
than or equal to the difference between Remaining Qty and Processed Qty (also
displayed in the list).

6. Click Create Sales Order. The Partial Order is created:

- Each order is generated under the Sales Orders tab.

- The status of each sales order generated from the customer purchase order is
updated to "Pending.”

- The status of the purchase order is updated to "Partially Processed.”

You cannot create a partial order from a Customer PO if the status of the order is

"Partially Processed.”

Intelligent Order Assistant (Max for OM)

Intelligent Order Assistant is a conversational interface developed using Conga Max bot
technology. It is available embedded within web applications as well as on mobile devices
through channels Slack, Skype etc. This can help in various order management functions
including view orders, view order details, create order, amend order, cancel order among



others. There are standard conversational flows available which can be modified at the
project level.

© Max functionality is not currently supported in this release.

Order Management (Out-Of-the-Box) Max Flow

When User types, Hello or Hi, Max respond with the following options:

- View Orders

- View Order Details
- Create New Order
- Amend Order

- Cancel Order

- Clone Order

A user can choose an option to start the relevant conversation.



Order Management for SOAP API
Developers

The Conga Order Management SOAP API Guide provides a collection of SOAP (Simple
Object Access Protocol) service APIs to allow users to extend the feature functionality of
Conga Order Management. Use the SOAP APIs in this reference guide as a tool for designing
solutions to complex business needs. All APIs in the reference are defined using the SOAP,
WSDL, and WS-| standards.

Topic Description

What's This guide defines and provides examples of Order Web Service APIs that can be used
Covered to create and manage orders, including partial orders from price agreements and
customer purchase orders, as well as in-flight order changes and cancellation.

Primary - Order Management Administrators
Audience - Conga Professional Services
T Refer to the latest Order Management on Salesforce Release Notes for information on

Environm | System Requirements and Supported Platforms.
ent

Updates For a comprehensive list of updates to this guide for each release, see the What's New

in Order Management Documentation topic.

Other - Salesforce SOAP API Developer Guide
Resources - Order Management User Guide: Refer to this guide for installing and setting up
Order Management in your organization.
- Order Management Release Notes: Refer to this guide for the new feature,
enhancements, resolved, and known issues.
- Order Management SOAP API Guide: Refer to this guide for documentation of
public-facing SOAP APIs for Order Management.
- Order Management Administrator Guide: Refer to this guide for setting up Order
Management in your organization.
- CPQ on Salesforce Administrator Guide: Refer to this guide for setting up
products, price lists, and constraint rules.

This guide describes the following tasks:

- Implementing Order Management Web Service
- Implementing Customer Purchase Order Web Service


https://developer.salesforce.com/docs/atlas.en-us.api.meta/api/sforce_api_quickstart_intro.htm

Before using Order Management APIs, you must be familiar with the following:

- Basic Salesforce administration knowledge
- Conga CPQ and Conga CLM administration
- Salesforce and Conga terms and definitions
- Conga Order Management basics

- Experience with SOAP/WSDL API protocols

Select one of the following topics for more informaction:

- Getting Started

- APl Reference

- Scenarios

- Troubleshooting Order Management SOAP APIs

Getting Started

Execution of Conga Order Management requires a working knowledge of APl standards
and development platform, as well as the subset of supported data and field types in
Salesforce. Refer to the Conga Order Management Release Notes for the supported Order
Management package for the latest release.

Refer to the following topics:

- API Standards and Development Platforms
- Field Types

- Integrating Conga with External Systems

AP| Standards and Development Platforms

Conga APIs are based on Salesforce APIs and use the same standards and platforms.

Standards

Name Reference

Simple Object Access Protocol (SOAP) 1.1 http://www.w3.0rg/TR/2000/NOTE-SOAP-20000508


http://www.w3.org/TR/2000/NOTE-SOAP-20000508/

Name Reference
Web Service Description Language (WSDL) 1.1 | http://www.w3.0rg/TR/2001/NOTE-wsdl-20010315

WS- Basic Profile 1.1 http://www.ws-i.org/Profiles/
BasicProfile-1.1-2004-08-24.html

Development Platforms

Conga SOAP APIs work with standard SOAP development environments. For a list of
compatible development platforms, see Salesforce Developer Force API details.

Note

A later version of this content will contain sample code.

Field Types

Conga APIs use a subset of the supported data and field types on Salesforce.

The following table lists the APIs that Conga provides. For a comprehensive list of all field
types supported by Salesforce, see Salesforce Data Types.

Type Description
Boolean The Boolean field has atrue(or 1) orfalse(or 0) value.
Data object The Data Object field is an ID type and is represented by cpq. nnboin

this document.

Date The Date field contains date values only and does not contain
relevant time values. Time in a date field is always set to midnight
in the UTC time zone. If you want a timestamp you must use a
DateTime field.


http://www.w3.org/TR/2001/NOTE-wsdl-20010315
http://www.ws-i.org/Profiles/BasicProfile-1.1-2004-08-24.html
http://wiki.developerforce.com/page/Web_Services_API
http://www.salesforce.com/us/developer/docs/api/Content/primitive_data_types.htm

Type Description

Decimal The Decimal field provides an exact numeric value and you can
arbitrarily size the precision and scale of the value.

ID The ID field is an alphanumeric field that acts as the primary key
for a specific record associated with an object. The ID value includes
a three-character code that identifies which object the record is
associated with. The ID for a specific record does not change.

For some objects, this field may also be a reference type value,
which contains the ID value for a related record. They are identified
by field names ending in 'Id’, such aspriceListId. The ID field acts like
foreign keys and their values can be changed using an
update()call.

Integer The Integer field contains whole numbers only. There are no digits
after the decimal.

List The List field includes a fixed set of values from which you must
select a single value. Picklists are available as drop-down lists. If a
picklist is unrestricted, the APl does not limit entries to only currently
active values.

String The String field contains text and may have different length
restrictions based on the data you store in the specific field. For
instance, City may be limited to 50 characters, whileaddressLinelis
limited to 255 characters.

Integrating Conga with External Systems

Additional steps are required when you choose to integrate Order Management on
Salesforce with external applications, customer portals, or other critical business systems.
Because Order Management Web Services are hosted on Salesforce, you should familiarize
yourself with the Salesforce SOAP APl and processes surrounding integration and best
practices detailed here: https://developer.salesforce.com/docs/atlas.en-us.api.meta/api/

sforce_api_quickstart_intro.ntm

Best Practices


https://developer.salesforce.com/docs/atlas.en-us.api.meta/api/sforce_api_quickstart_intro.htm

Conga recommends that you work with Conga Professional Services to design and
implement your integration. Use this documentation for basic integration steps and
to reference Order Management Web Service calls.

The following basic steps are required to get started using the Conga Order Management
Web Services API.

1. Generate the Enterprise or Partner WSDL - Integration with data stored in Salesforce
requires you to first point your browser to the Salesforce Enterprise or Partner WSDL.
This WSDL is generally provided by Conga Professional Services. Refer to Salesforce
Documentation for complete instructions on generating the Web Service WSDL.

2. Generate the Conga Web Services WSDL - After you have connected to Conga Web
Service, go to your organization and download the WSDL for the appropriate Web
Service (Order Management Web Service, Batch Update, Proposal Web Service, and so
on).

3. Import the WSDL Files Into Your Development Platform - After you have generated
the WSDL files, you can import them into your development platform. Conga does not
provide instructions for the import process. Refer to Salesforce documentation or
documentation related to your development platform.

4. Connect to Conga - Before you can begin using Order Management Web Services, you
must first authenticate to Conga using the login() API.

- Generating the Conga Web Services WSDL
- To generate the Conga Web Services WSDL
- Connecting to Conga

- To connect to Conga Web Service using SoapUl

Generating the Conga Web Services WSDL

Before you can import Conga SOAP Web Service into your development or testing platform,
you must generate and download the Conga WSDL for the appropriate Web Service.

The example provided here uses SoapUl.

There a known bug in the WSDL Generator on Salesforce that does not include
several field types, so it is recommended to update the WSDL file after you have
generated it but before importing it into your development platform. You can find
the details for any workaround tasks here:
- https://success.salesforce.com/issues_view?
id=alp3A000000eatxQAA&title=generated-wsdl-for-apex-webservices-is-malformed
- https://success.salesforce.com/issues_view?id=alp300000008XKUAA2


https://developer.salesforce.com/docs/atlas.en-us.api.meta/api/sforce_api_quickstart_steps_generate_wsdl.htm
https://success.salesforce.com/issues_view?id=a1p3A000000eatxQAA&title=generated-wsdl-for-apex-webservices-is-malformed
https://success.salesforce.com/issues_view?id=a1p300000008XKUAA2

When updating generated WSDL, make sure that the target namespace for any
schema you add points to the correct Web Service (for example, schemas/class/
Conga_QPConfig/QPConfigWebService). If you are still having trouble, please ask
Conga Professional Services for a modified WSDL for the Web Services you are using.

To generate the Conga Web Services WSDL

1. Log in to the Salesforce organization that contains your Conga records and data
(sandbox or production).

2. Go to Setup > Develop > Apex Classes (on Lightning, go to Setup > Custom Code >
Apex Classes.

3. Find the Web Service you want to generate the WSDL for (for example,
OrderWebService).

4. Click the WSDL link to generate the WSDL. The WSDL XML is generated and displayed
in a new tab.

Edit ¥ CPQSystemOverviewController Apttus_Config2
Edit ¥ CPQSystemOverviewControllerTest Apttus_Config2
Edit | Security , CPQWebService Apttus_CPQApi
Edecumy ¥, CPQWebService Apttus_Config2
Edit ¥ CPQWebServiceSupport Aptius_CPQApI
Edit *, CPQWebServiceTest Aptius_CPQApI
Edit ¥, CPQWebServiceTest Apttus_Config2

5. Right-click on the page and select View Page Source. Copy the XML content to any
text editor.

6. Save the file with the extension .wsdl.

7. Open SoapUl (or wherever is required on your development platform).

8. Create a new SOAP project and import the Conga Web Services WSDL. All methods
under that Web Service are now available to call.

Refer to the Request/Response XML section for any APl in this reference to get
the structure of the request and any prerequisite calls required for any API.

Connecting to Conga

After you have downloaded the Enterprise or Partner WSDL, call the login() method to
obtain a session ID from your org that you can use when calling Order Management Web



Services. After authenticating, you can use the same session ID until it either expires or your

logout or login again.

The example provided here uses SoapUl, an API testing tool which can be downloaded for

free here: https://www.soapui.org/.

Prerequisite: To authenticate with Conga, please make sure to have your production or test

org credentials on hand (username and password).

To connect to Conga Web Service using SoapUI

1.
2.
3.

Open SoapUl. Go to File > New SOAP Project.

Enter a name for the project.

Click Browse. Navigate to the saved Enterprise or Partner WSDL file that you
downloaded and click Open.

Click OK to close the project window.

From the Navigation panel to the left, highlight the project folder and click to expand.
Click to expand the SoapBinding. The list of methods that comprise the Enterprise or
Partner services are displayed.

Scroll down and right click on login. Double-click on an existing Request. The request
window opens in the SoapUl interface.

If you are doing this for the first time, you need to right-click on the login
method and select New Request.

Select and delete all content following the <soapenv:Header> tag and the </
soapenv:Header> tag.

Enter the username for your org (must have appropriate privileges) between the
<urn:username> and </urn:username> tags.

Enter the username for your org (must have appropriate privileges) between the
<urn:password> and </urn:password> tags.

The request should look like the following:

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/"
xmlns:urn="urn:partner.soap.sforce.com">
<soapenv:Header>
</soapenv:Header>
<soapenv:Body>
<urn:login>

<urn:username>username@example.com</urn:username>


https://www.soapui.org/

<urn:password>password</urn:password>
</urn:login>
</soapenv:Body>

</soapenv:Envelope>

10. From the upper-Lleft corner of the window, click the Run (") icon. The response is
generated in the right-hand window.

1. Make note of the serverURL and the sessionld returned by the server. You will use the
information to make Conga Web Service calls.

APl Reference

The following set of Conga Order Management APIs are divided into two main web service
categories:

- Order Web Service: Use Order Web Service APIs to create and manage orders and
execute order workflow automation rules.

- Customer Purchase Order (CPO) Web Service: Use the CPO Web Service APIs to manage
the customer purchase order lifecycle and create sales orders from purchase orders.

- DataValidattionService: Use Data validation web service APl to execute the data
validation and enrichment rules.

Order Web Service

Use the Order Web Service APIs to manage the order lifecycle, create direct orders, and
create partial orders from Price Agreements.

You can invoke APIs in Order Web Service (Conga_Config2) from the following command.

Apttus_Config2.CPQStruct.<Name of the Function>

where the name of the function is API Name and it parameters.

Use the Order Web Service APIs to complete the following tasks:

- Creating an Order

- Creating a Cart for an Order

-+ Synchronizing a Cart to an Order

- Accepting an Order

- In-Flight Order Changes and Cancellation
+ Cloning an Order using SOAP API



+ Fetching Price Agreements

- Fetching Price Agreement Items

- Creating a Partial Order from a Quote or Agreement
- Creating a Direct Order

- Executing Order Workflow

- Splitting an Order using API

Creating an Order

This APl creates an order for a specific Account and Price List.

API Details

API Signature

createOrder webService static
Apttus_Config2.CPQStruct.CreateOrderResponseDO
createOrder(Apttus_Config2.CPQStruct.CreateOrderRequ
estDO)

Parameters

Name Type Description

request CPQStruct.CreateOrderRequestDO The request data object.

Request Data Object - CPQStruct.CreateOrderRequestDO

Field Type Required ' Description
?

Account| | ID Yes The Id of the Account to be associated with the order.
d



Request Data Object - CPQStruct.CreateOrderRequestDO

Field Type Required ' Description

?
PriceListl | ID Yes The Id of the Pricelist to be associated with the order. Only the
d products associated with the Price List appear on the cart.
PricingD | Datetim | No Date and time associated with the order and represent the
ate e date when the order will be priced.

APl Response

Response Data Object - CPQStruct.CreateOrderResponseDO

Field Type Description
orderld ID The Id of the newly created order object
Code Sample

The following code sample enables you to create an order for a valid account with an
Account Id and a Price List with a valid Price List Id. Using the sample, you can search for a
valid account using an account number. If an account exists with the account number
entered, you can create an order using the createOrder() API. You can invoke this APl in use
cases when you want to create an order based on the account and price list.

public void createOrder()

{
// Create the request

A W N R

Apttus_Config2.CPQStruct.CreateOrderRequestDO request = new
Apttus_Config2.CPQStruct.CreateOrderRequestDO();

// Add request parameters
request.AccountId = accountId;

request.PricelListId = pricelListId;

O 00 N O U

request.PricingDate = Datetime.now();
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11
12

13
14
15
16

// Create a new order
Apttus_Config2.CPQStruct.CreateOrderResponseDO result =
Apttus_Config2.0rderWebService.createOrder (request);

// Assign orderId to local variable
orderId = result.OrderSO.Id;

Integration Detaiils

Use the following information in your integrations with Conga CPQ Web Services API. Refer

to Integrating Conga with External Systems for information on how to get started.

API Prerequisites

None.

Request and Response XML

Example Request

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmlns:ord="

http://soap.sforce.com/schemas/class/Apttus_Config2/0OrderWebService" xmlns:cpg="http:

//soap.sforce.com/schemas/class/Apttus_Config2/CPQStruct">

<soapenv:Header>

<ord:SessionHeader>
<ord:sessionId>00D7A00000O9QITI!

ARUAQFmpeBOmMsYS2JcADxYc4PxWoOkAHIP1JiNo5vtvnDBCEVfnWWWmO7pgbEXY7WadiCmm_Vib6MjhmgUbRS
321tI01NQRg</ord:sessionId>

</ord:SessionHeader>

</soapenv:Header>

<soapenv:Body>

<ord:createOrder>

<ord:request>

<cpq:AccountId>0017A00000WWOPZQAT</cpq:AccountId>

</ord:request>

</ord:createOrder>

</soapenv:Body>

</soapenv:Envelope>



Example Response

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmlns="ht
tp://soap.sforce.com/schemas/class/Apttus_Config2/OrderWebService"
xmlns:CreateOrderResponseDO="http://soap.sforce.com/schemas/class/Apttus_Config2/
CPQStruct" xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance">
<soapenv:Body>
<createOrderResponse>
<result>
<CreateOrderResponseD0:0rderSO xsi:type="Apttus_Config2__Order__c">
<Id>a2n7A0000002tviQAA</Id>
<Apttus_Config2__AutoActivateOrder__c>false</
Apttus_Config2__AutoActivateOrder__c>
<Apttus_Config2__BillToAccountId__c>0017A00000WWOpPZQAT</
Apttus_Config2__BillToAccountId__c>
<Apttus_Config2__BillingPreferenceld__c>a2d2f0000000hOYAAQ</
Apttus_Config2__BillingPreferenceld__c>
<Apttus_Config2__OrderDate__c>2020-07-06T06:33:53.000Z</
Apttus_Config2__OrderDate__c>
<Apttus_Config2__PricingDate__c>2020-07-06T06:33:53.000Z</
Apttus_Config2__PricingDate__c>
<Apttus_Config2__ShipToAccountId__c>0017A00000WWOpPZQAT</
Apttus_Config2__ShipToAccountId__c>
<Apttus_Config2__SoldToAccountId__c>0017A00000WWOPZQAT</
Apttus_Config2__SoldToAccountId__c>
<Apttus_Config2__SoldToAccountId__r xsi:type="Account">
<Id>0017A00000WWOPZQAT</Id>
<Name>OM_Account</Name>
</Apttus_Config2__SoldToAccountId__r>
<Apttus_Config2__Source__c>Account</Apttus_Config2__Source__c>
<Apttus_Config2__Status__c>Draft</Apttus_Config2__Status__c>
<Apttus_Config2__Type__c>New</Apttus_Config2__Type__c>
<Name>0-00005958</Name>
<OwnerId>0052f000000j6YUAAY</OwnerId>
</CreateOrderResponseD0:0rderS0O>
</result>
</createOrderResponse>
</soapenv:Body>

</soapenv:Envelope>



Creating a Cart for an Order

This APl creates a cart for the order referenced by Orderld.

API Details

API Signature

createCart webService static
Conga_Config2.CPQStruct.CreateCartResponseDO
createCart(Apttus_Config2.CPQStruct.CreateCartRequestDO)

Parameters

Name Type Description

request CPQStruct.CreateCartRequestDO The request data object.

Request Data Object - CPQStruct.CreateCartRequestDO

Field Type

Orderld ID

Propertie | List<Config2.Propert
s y>

Required? Description

Yes The Id of the order to be associated with
the cart.

No The list of properties applicable to the
cart.



Data Object - Config2.Property

Fiel Typ Required Description

d e ?

Nam | Strin | Yes Specify the features applicable to the cart. Applicable values are:

© 9 - useAdvancedApproval: Enables Advanced Approval for a cart.
- useDealOptimizer: Enables Deal Optimizer for a cart.

Valu | Strin | No The applicable values are true or false. Specifying the value as true

e g enables the feature for a cart.

APl Response

Response Data Object - CPQStruct.CreateCartResponseDO

Field Type Description
Cartld ID The Id of the newly created cart object.
Code Sample

The following code sample enables you to create a cart for a valid order with an Order Id.
Using the sample, you can search for a valid order using an order number. If an order exists
with the order number entered, you can create a cart using createCart(). You can invoke
this APl in use cases when you want to show a cart page based on the order.

public void createCart()

{
if(String.isNotBlank(orderId))

{

// Create config properties

o b~ W N

List<Apttus_Config2.Property> configProps = new
List<Apttus_Config2.Property>();



Apttus_Config2.Property prop = new Apttus_Config2.Property();

9
10 prop.Name = 'useAdvancedApproval';
11 prop.Value = 'false';
12 configProps.add(prop);
13
14 prop = new Apttus_Config2.Property();
15 prop.Name = 'useDealOptimizer';
16 prop.Value = 'false';
17 configProps.add(prop);
18
19 // Create the request
20 Apttus_Config2.CPQStruct.CreateCartRequestDO request = new

Apttus_Config2.CPQStruct.CreateCartRequestDO();
21
22 // Add request parameters
23 request.OrderId = orderId;
24 request.Properties.addAll(configProps);
25
26 // Create a new cart for Order
27 Apttus_Config2.CPQStruct.CreateCartResponseD0 result =
Apttus_Config2.0rderWebService.createCart(request);
28
29 // Get the cart Id
30 cartId = result.CartId;
31 } else {
32 ApexPages.addMessage (new
ApexPages.Message (ApexPages.severity.info, 'Invalid or Blank Order Id.'))
5

33 }
34 }

Integration Detaiils

Use the following information in your integrations with Conga CPQ Web Services API. Refer
to Integrating Conga with External Systems for information on how to get started.

API Prerequisites

None.



Request and Response XML

Example Request

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmlns:ord="
http://soap.sforce.com/schemas/class/Apttus_Config2/OrderWebService" xmlns:cpg="http:
//soap.sforce.com/schemas/class/Apttus_Config2/CPQStruct">
<soapenv:Header>
<ord:SessionHeader>
<ord:sessionId>00D7A0000009QITI!
ARUAQFmpeBOmsYS2JcADxYc4PxWoOkAHIP1JiNo5vtvnDBCEVfnWWWmO7pgbEXY7WadiCmm_Vib6MjhmgUbRS
321tI01NQRg</ord:sessionId>
</ord:SessionHeader>
</soapenv:Header>
<soapenv:Body>
<ord:createCart>
<ord:request>
<!--Optional:-->
<cpq:0rderId>a2n7A0000002tviQAA</cpq:0rderId>
</ord:request>
</ord:createCart>
</soapenv:Body>

</soapenv:Envelope>

Example Response

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmlns="ht
tp://soap.sforce.com/schemas/class/Apttus_Config2/OrderWebService"
xmlns:CreateCartResponseDO="http://soap.sforce.com/schemas/class/Apttus_Config2/
CPQStruct">
<soapenv:Body>
<createCartResponse>
<result>
<CreateCartResponseD0:CartId>alI7A000001IqcfUAC</CreateCartResponseD0O:Car
tId>
</result>
</createCartResponse>
</soapenv:Body>

</soapenv:Envelope>



Synchronizing a Cart to an Order

This API synchronize shopping cart line items with order line items. Before you synchronize
your cart add products using addMultiProducts(), add bundles using addBundle(). The API
will generally be invoked when the user clicks the Place Order action from the cart.

API Details

API Signature

synchronizeCart webService static
Conga_Config2.CPQStruct.SynchronizeCartResponseDO
synchronizeCart(Apttus_Config2.CPQStruct.SynchronizeCartR
equestDO request)

Parameters

Name Type Description

request CPQStruct.SynchronizeCartRequestDO | The request data object.

Request Data Object - CPQStruct.SynchronizeCartRequestDO

Name Type Required? Description

Cartld ID Yes The Id of the cart (Product Configuration)
you want to synchronize.



APl Response

Response Data Object - CPQStruct.SynchronizeCartResponseDO
Name Type Description

IsSuccess Boolean Indicates whether synchronizing the cart items
was successful.

Code Sample

The following code sample enables you to synchronize cart items with an order. When the
customer has finalized the cart, you can synchronize the products in the cart with the
order used to generate the cart. Invoke this API after the user has finalized the cart.

1 public void synchronizeCart()
2 {
3 if(String.isNotBlank(cartId))
4 {
5 // Create the request
6 Apttus_Config2.CPQStruct.SynchronizeCartRequestDO request2 = new
Apttus_Config2.CPQStruct.SynchronizeCartRequestDO();
7
// Add request parameters
g request2.CartId = cartId;
10
11 // Synchronize cart
12 Apttus_Config2.CPQStruct.SynchronizeCartResponseDO result2 =
Apttus_Config2.0rderWebService.synchronizeCart(request2);
13
14 1} else {
15 ApexPages.addMessage (new

ApexPages.Message (ApexPages.severity.info, 'Invalid or blank cart Id.'));
16 }
17 }



Request and Response XML

Example Request

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmlns:ord="
http://soap.sforce.com/schemas/class/Apttus_Config2/OrderWebService" xmlns:cpg="http:
//soap.sforce.com/schemas/class/Apttus_Config2/CPQStruct">

<soapenv:Header>

<ord:SessionHeader>

<ord:sessionId>00D7AOOOEOO9QII!
ARUAQFmpeBOmsYS2JcADxYc4PxWoOkAHIP1JiNo5vtvnDBCEVfnWWWmO7pgbEXY7WadiCmm_Vib6MjhmgUbRS
321tI01NQRg</ord:sessionId>

</ord:SessionHeader>

</soapenv:Header>

<soapenv:Body>

<ord:synchronizeCart>

<ord:request>

<cpq:CartId>alI7A000001IqcfUAC</cpq:CartId>

</ord:request>

</ord:synchronizeCart>

</soapenv:Body>

</soapenv:Envelope>

Example Response

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmlns="ht
tp://soap.sforce.com/schemas/class/Apttus_Config2/0OrderWebService"
xmlns:SynchronizeCartResponseDO="http://soap.sforce.com/schemas/class/Apttus_Config2/
CPQStruct">
<soapenv:Body>
<synchronizeCartResponse>
<result>
<SynchronizeCartResponseD0:IsSuccess>true</SynchronizeCartResponseD0:IsSu
ccess>
</result>
</synchronizeCartResponse>
</soapenv:Body>
</soapenv:Envelope>



Accepting an Order

This API finalizes a draft order on customer confirmation. Accepting an order performs the
following functions:

- IF Auto Activate Order = False

- Order and Order Line Item status is set to “Pending”.

- Asset Line Items are created in “Pending” status.

- If “Ready for Billing Date” is set, the billing schedule generation is initiated.
- IF Auto Activate Order = True

- Order and Order Line Item status is set to “Activated”.

- Asset Line Items are created in “Activated” status.

- If “Ready for Billing Date” is set, the billing schedule generation is initiated.

API Details

API Signature

acceptOrder webService static
Apttus_Config2.CPQStruct.AcceptOrderResponseDO
acceptOrder(Apttus_Config2.CPQStruct. Accept OrderRequestDO)

Parameters

Name Type Description

Request Apttus_Config2.CPQStruct.AcceptOrderR | The request data object.

equestDO



Request Data Object -
Apttus_Config2.CPQStruct.AcceptOrderRequestDO

Field Type R Description

ui
re

Orderld | ID Y | Theld of the Order to be finalized.
es

APl Response
Response Data Object - CPQStruct.AcceptOrderResponeDO
Field Type Description

IsSuccess boolean Specifies whether the order is
finalized successfully.

Assetlineltems List<Apttus_Config2__AssetLinelt | List of Asset Line Items
em__c>

Code Sample

The following code sample enables you to finalize an order for a valid order with an Order
Id.

public void acceptOrder() {

N

Apttus_Config2.CPQStruct.AcceptOrderRequestDO request = new
Apttus_Config2.CPQStruct.AcceptOrderRequestDO();

5 request.OrderId = orderId;



7 Apttus_Config2.CPQStruct.AcceptOrderResponseDO response =
Apttus_Config2.0rderWebService.acceptOrder(request);

ApexPages.addMessage (new
ApexPages.Message (ApexPages.severity.info, 'acceptOrder :' +
response.IsSuccess));
10 ApexPages.addMessage (new
ApexPages.Message (ApexPages.severity.info, 'List of Assets :' +
response.AssetItems));
11
12 }

Integration Detaiils

Use the following information in your integrations with Conga CPQ Web Services API. Refer
to Integrating Conga with External Systems for information on how to get started.

Request and Response XML

Example Request

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmlns:ord="
http://soap.sforce.com/schemas/class/Apttus_Config2/OrderWebService" xmlns:cpg="http:
//soap.sforce.com/schemas/class/Apttus_Config2/CPQStruct">
<soapenv:Header>
<ord:SessionHeader>
<ord:sessionId>00D7AQOOOOO9QITI!
ARUAQFmpeBOmsYS2JcADxYc4PxWoOkAHIP1JiNo5vtvnDBCEVfnWWWmO7pgbEXY7WadiCmm_Vib6MjhmgUbR8
321tI01INQRg</ord:sessionId>
</ord:SessionHeader>
</soapenv:Header>
<soapenv:Body>
<ord:acceptOrder>
<ord:request>
<cpq:0rderId>a2n7A0000002tviQAA</cpq:0rderId>
</ord:request>
</ord:acceptOrder>
</soapenv:Body>

</soapenv:Envelope>



Example Response

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmlns="ht
tp://soap.sforce.com/schemas/class/Apttus_Config2/OrderWebService"
xmlns:AcceptOrderResponseDO="http://soap.sforce.com/schemas/class/Apttus_Config2/
CPQStruct" xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance">
<soapenv:Body>
<acceptOrderResponse>
<result>
<AcceptOrderResponseDO:AssetItems xsi:nil="true"/>
<AcceptOrderResponseD0:IsSuccess>true</AcceptOrderResponseD0:IsSuccess>
</result>
</acceptOrderResponse>
</soapenv:Body>

</soapenv:Envelope>

In-Flight Order Changes and Cancellation

In-Flight Order Changes and Cancellation allows you to change or cancel orders after
order confirmation and before fulfillment. Changes to orders come in the form of versioned
amendments, to existing order line items that include modification of quantity, subscription
dates, discounts, and other pricing parameters. You can achieve the following using the
APls:

- Add a new order line item

- Change an existing order line item

- Revert the changes if required

- Cancel an order and its order line items
- Revert cancellation of an order

Using the AmendOrder() API, you can make subscription date changes on order line items of
an "In Flight" order (an order with the status Pending, In Fulfillment, or Partially Fulfilled).
For example, you may want to amend an order in a scenario when there is a delay in
provisioning or fulfillment of the subscription after the order has been confirmed by the
customer and before it is fulfilled.

The following diagram visually represents the workflow for In-Flight Order Changes
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Refer to the Order Management on Salesforce Administrator Guide for complete
steps to configure In-Flight Order Changes and Cancellation. At a minimum, the
“Enable In-Flight Changes and Cancellation” custom setting must be enabled for
any of the following APIs to function. You can also create workflow automation
rules for in-flight order changes and cancellation using the execWorkflow() API.

In-Flight Changes and Cancellation APIs

Invoke the following APIs to make In-Flight Order Changes to orders (amendments) or to
cancel an order.

- Amending an Order using API
- Reverting an Amendment to an Order
- Cancelling an Order using API

- Reverting a Cancelled Order



Order and Order Line Item Behavior on Amendment

Action

In-flight Order changes allowed

Order Versioning

Delayed Asset Creation

Behavior

- Change to Start Date and/or End Date
- Change the term as needed based on new

start date/end date

- Recalculate Net Price as needed
- Add a new Product (order line) for the existing

order:

For instance, after placing an order for
salesforce licenses, you can add more
products for the SFDC Admin Training.

- Cancel an order line:

Cancel a particular order line from an existing
order and keep rest of the order lines
unchanged.

- Change an existing order line for the existing

order:

Change the quantity or start/end date for a
particular order line on an existing order.
Price and Term are recalculated after
changing quantity and dates (start/End)
respectively.

- New order and order line version created to

make the in-flight change

- The previous version superseded once the new

change is confirmed

- Option added to “Create Assets on Order

Activation” in Order System Properties. This
option needs to be enabled for In-flight
change capability.

- With this option, assets are created and

activated only when the order/order line is
activated

- For bundles / multi-charge types, assets

created/updated when last related option or
charge type is fulfilled



Action

Billing Changes

Revenue Recognition

DRAFT or IN AMENDMENT Order

Setting Ready for Activation Date or
(Ready for Billing Date) on Order Line Item
on orders in Draft / In Amendment Order

Behavior

- Billing can only be initiated after order/order
line activation

- “Initiate Billing on Order Activation” is not
relevant for In-flight Order changes and is
always treated as if the property is enabled.

- No impact on Revenue Recognition as
scheduled, after activation

When the orders are in "Draft" or "In Amendment"
status, users can set "Ready for Activation Date" or
"Ready for Billing Date" on the order or order line
item Llevel. This will not initiate order/order line item
activation or billing while order stays in "Draft" or "In
Amendment” status.

If "Ready for Activation Date" is set on the order or
order line item then this will become a trigger to
activate order or order line item respectively when
the order is accepted.



Action

ACCEPT ORDER / QUOTE

Order line item activation on Accept Order
or Quote

Behavior

When the order or quote is accepted, the system
uses the following behavior on the order line items
irrespective of delayed asset creation flag.

READY FOR ACTIVATION DATE ON THE ORDER
HEADER

Mark all the line items as Fulfilled

Initiate Llogic for order line item activation, which will
activate all the line items as well as order header. It
will also create and activate assets.

INDEPENDENT LINE ITEM:

If ready for activation date is set on the order line
item and status of the order line is in “In
Amendment” or “Draft”, then system will mark the
line item as “Fulfilled” and initiate “order line item
activation logic

BUNDLES OR MULTI-CHARGE TYPES WHEN Create
Asset on Order Activation = TRUE

If ready for activation date is set and status of the
order line is in “In Amendment” or “Draft”, then
system will mark the line item as “Fulfilled”

Initiate activation logic, if the current fulfilled item is
the last item in the bundle or multi-charge items

BUNDLES OR MULTI-CHARGE TYPES WHEN Create
Asset on Order Activation = FALSE

If ready for activation date is set and status of the
order line is in “In Amendment” or “Draft”, the system
will mark the line item as “Fulfilled”

Initiate activation even if there are other items in the
bundle or multi-charge types that are still NOT in
“Fulfilled” status



Action

PENDING / IN FULFILLMENT / PARTIALLY
FULFILLED ORDERS

Activating Order Line Items

Behavior

READY FOR ACTIVATION DATE ON THE ORDER
HEADER

- Mark all the line items as Fulfilled
- Initiate logic for order line item activation

INDEPENDENT LINE ITEM:

- If ready for activation date is set on the order
line item and status of the order lineis in
“Pending” or “In Fulfillment”, then the system
will mark the line item as “Fulfilled” and
initicite “order line item activation logic

- If Fulfilled Quantity >= Delta Quantity and
status of the order line is in “Pending” or “In
Fulfillment” or “Partially Fulfilled”, then mark
the line item as “Fulfilled” and initiate “order
line item activation logic

BUNDLES OR MULTI-CHARGE TYPES WHEN Create
Asset on Order Activation = TRUE

- If ready for activation date is set and status
of the order line is in “Pending” or “In
Fulfillment”, then mark the line item as
“Fulfilled”

- If Fulfilled Quantity >= Delta Quantity and
status of the order line is in “Pending” or “In
Fulfillment” or “Partially Fulfilled”, then mark
the line item as “Fulfilled”

- Initiate activation logic, if the current fulfilled
item is the last item in the bundle or multi-
charge items

BUNDLES OR MULTI-CHARGE TYPES WHEN Create
Asset on Order Activation = FALSE

- If ready for activation date is set and status
of the order line is in “Pending” or “In
Fulfillment”, then mark the line item as
“Fulfilled”



Action

Behavior

- If Fulfilled Quantity >= Delta Quantity and
status of the order line is in “Pending” or “In
Fulfillment” or “Partially Fulfilled”, then mark
the line item as “Fulfilled”

- Initiate activation logic, even if there are other
items in the bundle or multi-charge types that
are still NOT in “Fulfilled” status.

Use Cases for Changing In-Flight orders

This section highlights the use cases when you would make changes to an In-Flight order,

For example, delay in the provisioning of Subscription from a confirmed order, impacts the

subscription effective dates, duration, and Price. Accordingly on provisioning, change In-

Flight order, order line item, asset, and other related data.

New Subscription

Change in subscription dates without
changing Term/Duration or Quantity

Amend Subscription

Change amendment start date without
changing the End Date and Quantity

Terminate Subscription

Change termination date of subscription

New subscription start is delayed by a month due to
provisioning delay.

Ordered subscription: 01-Jan-2017 to 31-Dec-2017

Provisioned subscription: 01-Feb-2017 to 31-Jan-2018

Provisioning of an add-on order on an existing
subscription is delayed by a month.

Ordered subscription: 01-Aug-2017 to 31-Jan-2018

Provisioned subscription: 01-Sep-2017 to 31-Jan-2018

Termination of an existing subscription is delayed by a
month due to provisioning delay

Ordered subscription Termination: End Date: 31-
Oct-2017

Provisioned subscription Termination: End Date: 30-
Nov-2017



Swap Subscription

Change start date of upgrade and thus
change termination date of original
subscription

Add a new order line

Addition of n number of products to the
existing order

Cancel an existing Order Line

Change an existing order line

Start date of the upgrade of an existing subscription is
delayed by a month due to provisioning delay.
Accordingly, termination of existing subscription also
need to be delayed

Ordered subscription Upgrade:

Gold Warranty: End Date: 31-July-2017
Platinum Warranty: 01-Aug-2017 to 31-Jan-2018
Provisioned subscription Upgrade:

Gold Warranty: End Date: 31-Aug-2017

Platinum Warranty: 01-Sep-2017 to 31-Jan-2018

Addition of Dimond Warranty to the existing order

Add new order line to the existing order by adding
Dimond warranty

Canceling Gold Warranty for the existing order

Gold Warranty Status is Cancelled.

Provisioning of an add-on order on an existing
subscription is shifted by a month and quantity needs
to be increased from 1to 2

Ordered subscription: 01-Aug-2017 to 31-Jan-2018

Provisioned subscription: 01-Sep-2017 to 31- Feb -2018
(Quantity: 2)



Calculate the end date by providing a Provide your input for start date, selling term, selling

start date, selling term and selling frequency to the order line item and ensure that the
frequency end date on order line item must be null while passing
the API.

Code Sample:

for(Apttus_Config2_OrderLineltem_c oli:
orderLinelist) { oli.Apttus_Config2__EndDate__c =
null; oli.Apttus_Config2__StartDate__c =
oli.Apttus_Config2__StartDate__c.addMonths(4);
oli.Apttus_Config2__SellingTerm__c = 24;
oli.Apttus_Config2__SellingFrequency__c = 'Monthly’;
oli.Apttus_Config2__Quantity__c =
oli.Apttus_Config2__Quantity__c; }

Calculate the selling term by providing | Provide your input for start date, end date, selling

a start date, end date, and selling frequency to the order line item and ensure that the

frequency selling term on order line item must be "0" while
passing the API.

Code Sample:

for(Apttus_Config2_OrderLineltem_c oli:
orderLinelList) { oli.Apttus_Config2__SellingTerm__c =
0O; oli.Apttus_Config2__EndDate__c =
oli.Apttus_Config2__EndDate__c.addMonths(4);
oli.Apttus_Config2__StartDate__c =
oli.Apttus_Config2__StartDate__c;
oli.Apttus_Config2__SellingFrequency__c = 'Monthly/;
oli.Apttus_Config2__Quantity__c =
oli.Apttus_Config2__Quantity__c; }

Amending an Order using API

Make In-Flight order changes. Use this APl to make the following changes to Order Line
ltems (OLI):

- Change the start date or end date of subscription on one or more order line items that
are in "Pending", "In Fulfillment", or "Partially Fulfilled" status.

- Make subscription date changes on the standalone item, bundles, and multiple
charge line items.

- Cancel order line items in "Pending," "In Fulfillment," or "Partially Fulfilled" status. This
changes their status to "Pending Cancellation.”



- Override the "Base Price" field.
- Change the Quantity.
- Change the Selling Term, Selling Frequency, and/or Selling Unit-of-Measure (Selling

Uom).

- Modify Contract Numbers
- Change the Adjustment Type/Adjustment Amount.

The following changes to an order occur after it has been amended:

- The change in subscription start and/or end date recalculates the price for the line

item or bundle after the changes are applied.

- The changes to the order line items are also reflected in the corresponding assets.
- Assets are only created on activation of the order line item.
- Creates a new version of the order to make and track changes and has reference to

the previous version. The previous version of the order and order line items are
"Superseded”, once the work-in-progress (In Amendment) changes are confirmed on
"Accept"” of the "In Amendment"” order.

Cancelled order line items are assigned the "Pending Cancellation” status. The order
must be accepted to confirm cancellation.

- Order line items that are added from catalog (line status = "New") or created
through ABO actions (line status In "Amended"”, "Cancelled", "Renewed",
"Upgraded") can be amended.

- Any order configured directly or generated from quote or eCommerce can be
amended.

For more information on amending an order, refer to the topic "Managing In-Flight
Changes and Cancellation" in the Order Management on Salesforce User Guide.

API Details
API Signature
amendOrder webService static

Conga_Config2.CPQStruct. AmendOrderResponseDO
amendOrder(Apttus_Config2.CPQStruct. AmendOrderRequestDO)



Parameters

Name Type Description
request Apttus_Config2.CPQStruct. AmendOrderR | The request data object.
equestDO

Request Data Object - Apttus_Config2.CPQStruct. AmendOrderRequestDO

Field Type Required? Description
Orderld | ID Yes Reference to the order. Order Id can be any one of the
following:

- Order in "Pending, In Fulfillment, Partially
Fulfilled" status that requires amendment.

- Order in "In Amendment" status for which
additional line item changes are required.



Request Data Object - Apttus_Config2.CPQStruct. AmendOrderRequestDO

Field Type Required?

Orderlte | List No
ms

APl Response

Description

List of order line items and changes to make:

- Order line item id: Reference to the order line

item

- Start Date: New Start date for the order line

item. Not needed for the order line item if the
termination date for existing subscription needs
to be changed.

- End Date: New end date for the order line item. If

the termination date needs to be changed on
existing subscription then just specify the new
end date.

- Contract Numbers: If the termination date needs

to be changed on existing subscription then set
this value to null or same as End Date.

- Base Price: New base price for the order line

item.

- Quantity: New quantity for the order line item

(see sample below).

- Selling Term / Selling Frequency: The new Selling

Term or Selling Frequency for an order line item.

- Selling Unit-of-Measure: The new Selling Uom for

an order line item.

- Adjustment Type / Adjustment Amount: The new

price Adjustment Type and/or Adjustment
amount for the order line item.

Response Data Object - CPQStruct.AmendOrderResponeDO

Field Type Description
AmendedOrderltems List List of amended order items
AmendOrderSO Standard Data Object The fields of the AmendOrder

Object.



Code Sample

The following code sample enables you to amend an order for a valid order with an Order

Id.

A W N R
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23
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26

Id orderid = 'a2n4COO000O7NFpQAM';
List<Apttus_Config2__OrderLineItem__c> lineitemlist =

[ Select Id, Name, Apttus_Config2__StartDate__c,Apttus_Config2__EndDate__c
from Apttus_Config2__OrderLineItem__c

where

Id IN ('a2k4C000000D7yt', 'a2k4COO0O00OD7yu', 'a2k4COOOOOOD7YV','a2k4COOO00
OD7yw')];

lineitemlist[0].Apttus_Config2__StartDate__c=date.newInstanc
e(2017, 10, 01);

lineitemlist[0].Apttus_Config2__EndDate__c=date.newInstance(2
018, 8, 31);

/*x*xxxFor line item, where cancellation date needs to be
changed, provide the end date and set Contract Numbers field to
NULT**x*xx%xx /

lineitemlist[1].Apttus_Config2__EndDate__c=date.newInstance
(2018, 9, 30);
lineitemlist[1].Apttus_Config2__ContractNumbers__c=null;

/***xto change the quantity of line item #**xxx/
lineitemlist[2].Apttus_Config2__Quantity__c=3;

/***xCanceling the 1line item by changing the status of line
item to Pending cancellation **xx/
lineitemlist[3].Apttus_Config2__Status__c='Pending

Cancellation';

Apttus_Config2.CPQStruct.AmendOrderRequestDO request = new
Apttus_Config2.CPQStruct.AmendOrderRequestDO();

request.OrderId = orderid; request.OrderItems =
lineitemlist;

Apttus_Config2.CPQStruct.AmendOrderResponseDO
Amend_response = Apttus_Config2.0rderWebService.amendOrder (request);

system.debug('OrderID_Of_New_Version -'+Amend_response.Amend
OrderS0.1id); /*xThis ID should be passed While Processing Undo Amend

request *x*/

[**xxxkx Accepting new order xkxkxkkxkkkkkkkkkkkkkk*k* /



27 Apttus_Config2.CPQStruct.AcceptOrderRequestDO requestl =
new Apttus_Config2.CPQStruct.AcceptOrderRequestDO();

28

29

30 /*Apttus_Config2__Order__c newOrder = [ Select Id, Name,
Apttus_Config2__ActivatedDate__c from Apttus_Config2__Order__c

31 where Apttus_Config2__PreviousVersion__c = :orderid];

32

33 requestl.OrderId = newOrder.Id; /** you can either use 1id
for above query *x*/

34 OR */

35 requestl.OrderId=Amend_response.AmendOrderS0O.id // you can
use the id of new orderversion from above response

36

37

38 /* x*x*kkx*xkxx*x*x updating ready for activation date on the
order or order line items for auto activation of the amended lines x*xxx%xx/

39

40 //newOrder.Apttus_Config2__ActivatedDate__c = system.now();

41

42 List<Apttus_Config2__OrderLineItem__c> lineitemlistl =

43

44 [Select Id, Name, Apttus_Config2__ActivatedDate__c from
Apttus_Config2__OrderLineItem__c where Apttus_Config2__OrderId__c =

45 .Id and Apttus_Config2__Status__c = 'In Amendment'];

46 lineitemlistl[0].Apttus_Config2__ActivatedDate__c =
system.now() ;

47 lineitemlistl[1].Apttus_Config2__ActivatedDate__c =
system.now() ;

48

49 update lineitemlistl;

50

51 Apttus_Config2.CPQStruct.AcceptOrderResponseDO response =

Apttus_Config2.0rderWebService.acceptOrder(requestl);

Reverting an Amendment to an Order

This APl enables you to revert an amendment to an order. For example, you can roll back
the changed order date to the previous date. UndoAmendOrder is a composite API.



For more information on how an order and its line items are affected when you
revert an amendment to order, refer to the Order Management on Salesforce User

Guide.
API Details

API Signature

undoAmendOrder webService static
Apttus_Config2.CPQStruct.UndoAmendOrderResponseDO
undoAmendOrder(Apttus_Config2.CPQStruct.UndoAmendOrde
rRequestDO)

Parameters

Name Type Description

request Apttus_Config2.CPQStruct.UndoAmendOr | The request data object.

derResponseDO

Request Data Object - Apttus_Config2.CPQStruct.UndoAmendOrderRequestDO

Field Type Required? Description
orderld 1D Yes Unique identifier of the amended
order.

APl Response

Response Data Object - CPQStruct.UndoAmendOrderResponseDO

Field Type Description
PreviousOrderSO Standard Data Object The fields of the Previous Order
Object.
Code Sample

Use the following code sample to revert an amendment to an order.



Apttus_Config2.CPQStruct.UndoAmendOrderRequestDO Undo_Amend_request = new
Apttus_Config2.CPQStruct.UndoAmendOrderRequestDO() ;
Undo_Amend_request.orderid = 'a2n4CO000007NGI'; /xx This is the Id of the
order whose status is 'In Amendment' x*x/
Apttus_Config2.CPQStruct.UndoAmendOrderResponseDO UndoAmend_response =
Apttus_Config2.0rderWebService.undoAmendOrder (Undo_Amend_request) ;
system.debug('Order_OLD_Version - ' +
UndoAmend_response.PreviousOrderS0.id); /** returns the OrderId of the

previous version *x/

Cancelling an Order using API

This APl cancels an order. The status of the order and its line items changes to Pending

Cancellation and a new version is created. The status of the previous order is set to Being

Cancelled. Please note the following:

- If you decide to revert (undo) the cancelled order, the new order version is deleted and

the previous order version shows Pending status.

- If you decide to cancel the order, you must accept the cancellation of the order. After

accepting the cancellation, a new version is created showing with Cancelled status

for the order as well as its line items. In this case, the previous version shows the

Superseded status for the order and its line items.

For more information on how an order and its line items are affected when you
cancel an order, refer to the Order Management on Salesforce User Guide.

API Details
API Signature
cancelOrder webService static

Apttus_Config2.CPQStruct.CancelOrderResponseDO

cancelOrder(Apttus_Config2.CPQStruct.Cancel OrderRequestDO)



Parameters

Name Type Description
request Apttus_Config2.CPQStruct.CancelOrder | The request data object.
RequestDO

Request Data Object - Apttus_Config2.CPQStruct.CancelOrderRequestDO
Field Type  Required?  Description

orderld ID Yes Unique identifier of the order to be cancelled.

APl Response

Response Data Object - CPQStruct.CancelOrderResponseDO

Field Type Description

cancelOrderSO | Standard Data Object | The fields of the Cancel Order Object.

Code Sample

The following code sample allows you to cancel an order.

ID Orderid = 'a2n4COOOOOO7NFpQAM';

Apttus_Config2.CPQStruct.CancelOrderRequestDO CancelRequest = new
Apttus_Config2.CPQStruct. CancelOrderRequestDO();

CancelRequest.orderid=0rderid;

Apttus_Config2.CPQStruct.CancelOrderResponseDO Cancel_Response =

Apttus_Config2.0rderWebService.cancelOrder (CancelRequest);
system.debug('OrderID_New_Version - '+Cancel_Response.CancelOrderS0.1id); /**This ID

should be passed While Processing Undo Cancel request *x*/



Integration Details

Use the following information in your integrations with Conga CPQ Web Services API. Refer
to Integrating Conga with External Systems for information on how to get started.

API Prerequisites

None.

Request and Response XML

Example Request

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmlns:ord="
http://soap.sforce.com/schemas/class/Apttus_Config2/0OrderWebService" xmlns:cpg="http:
//soap.sforce.com/schemas/class/Apttus_Config2/CPQStruct">
<soapenv:Header>
<ord:SessionHeader>
<ord:sessionId>00D7A0000009QITI!
ARUAQFmpeBOmsYS2JcADxYc4PxWoOkAHIP1JiNo5vtvnDBCEVfnWWWmO7pgbEXY7WadiCmm_Vib6MjhmgUbRS8
321tI01NQRg</ord:sessionId>
</ord:SessionHeader>
</soapenv:Header>
<soapenv:Body>
<ord:cancelOrder>
<ord:request>
<cpq:0rderId>a2n7A0000002tviQAA</cpq:0rderId>
</ord:request>
</ord:cancelOrder>
</soapenv:Body>

</soapenv:Envelope>

Example Response

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmlns="ht
tp://soap.sforce.com/schemas/class/Apttus_Config2/OrderWebService"
xmlns:CancelOrderResponseDO="http://soap.sforce.com/schemas/class/Apttus_Config2/
CPQStruct" xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance">

<soapenv:Body>



<cancelOrderResponse>
<result>
<CancelOrderResponseD0:CancelOrderSO xsi:type="Apttus_Config2__Order__c">
<Id>a2n7AQ000002twXQAQ</Id>
<Apttus_Config2__AutoActivateOrder__c>false</
Apttus_Config2__AutoActivateOrder__c>
<Apttus_Config2__BillToAccountId__c>0017A00000WWOPZQAT</
Apttus_Config2__BillToAccountId__c>
<Apttus_Config2__BillingPreferenceld__c>a2d2f0000000hOYAAQ</
Apttus_Config2__BillingPreferenceld__c>
<Apttus_Config2__ConfigurationSyncDate__c>2020-07-06T08:43:16.000Z</
Apttus_Config2__ConfigurationSyncDate__c>
<Apttus_Config2__IsTaskPending__c>false</
Apttus_Config2__IsTaskPending__c>
<Apttus_Config2__OrderAmount__c>300.00000</
Apttus_Config2__OrderAmount__c>
<Apttus_Config2__OrderDate__c>2020-07-06T06:33:53.000Z</
Apttus_Config2__OrderDate__c>
<Apttus_Config2__OriginalOrderNumber__c>0-00005958</
Apttus_Config2__OriginalOrderNumber__c>
<Apttus_Config2__PreviousVersion__c>a2n7A0000002tviQAA</
Apttus_Config2__PreviousVersion__c>
<Apttus_Config2__PricelListId__c>al73C000000fHFQQA2</
Apttus_Config2__PriceListId__c>
<Apttus_Config2__PricingDate__c>2020-07-06T06:33:53.000Z</
Apttus_Config2__PricingDate__c>
<Apttus_Config2__ReadyForWorkflow__c>false</
Apttus_Config2__ReadyForWorkflow__c>
<Apttus_Config2__ShipToAccountId__c>0017A00000WWOPZQAT</
Apttus_Config2__ShipToAccountId__c>
<Apttus_Config2__SoldToAccountId__c>0017A00000WWOPZQAT</
Apttus_Config2__SoldToAccountId__c>
<Apttus_Config2__SourceChannel__c>Direct</
Apttus_Config2__SourceChannel__c>
<Apttus_Config2__Source__c>Account</Apttus_Config2__Source__c>
<Apttus_Config2__Status__c>Pending Cancellation</
Apttus_Config2__Status__c>
<Apttus_Config2__Type__c>New</Apttus_Config2__Type__c>
<Apttus_Config2__VersionNumber__c>1</Apttus_Config2__VersionNumber__c>
<CurrencyIsoCode>USD</CurrencyIsoCode>
</CancelOrderResponseD0:CancelOrderS0O>
</result>
</cancelOrderResponse>

</soapenv:Body>



</soapenv:Envelope>

Reverting a Cancelled Order

This APl reverts the cancellation of an order.

For more information on how the order and its line items are affected when you
revert a cancelled order, refer to the Order Management on Salesforce User Guide.

API Details

API Signature

undoCancelOrder webService static
Apttus_Config2.CPQStruct.UndoCancelOrderResponseDO
undoCancel Order(Apttus_Config2.CPQStruct.UndoCancelOrde
rRequestDO)

Parameters

Name Type Description

Request Apttus_Config2.CPQStruct.UndoCancelOr | The request data object.

derRequestDO

Request Data Object - Apttus_Config2.CPQStruct.UndoCancelOrderRequestDO

Field Type Required? Description
orderld ID Yes Unique identifier of the cancelled
order.

APl Response



Response Data Object - CPQStruct.UndoCancelOrderResponseDO
Field Type Description

PreviousOrderSO | Standard Data Object | The fields of the Previous Order Object.

Code Sample

The following API lets you undo or revert the cancelled order.

Apttus_Config2.CPQStruct.UndoCancelOrderRequestDO UndoCancelrequest = new
Apttus_Config2.CPQStruct. UndoCancelOrderRequestDO();
UndoCancelrequest.orderid=Cancel_Response.CancelOrderS0.1id;
Apttus_Config2.CPQStruct.UndoCancelOrderResponseDO UndoCancel_Response=
Apttus_Config2.0rderWebService.undoCancelOrder (UndoCancelrequest);
system.debug('OrderID_OLD_Version - '+UndoCancel_Response.PreviousOrderS0.id);/**

returns the OrderId of the previous version *x/

Integration Details

Use the following information in your integrations with Conga CPQ Web Services API. Refer
to Integrating Conga with External Systems for information on how to get started.

API Prerequisites

None.

Request and Response XML

Example Request

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmlns:ord="
http://soap.sforce.com/schemas/class/Apttus_Config2/0OrderWebService" xmlns:cpg="http:
//soap.sforce.com/schemas/class/Apttus_Config2/CPQStruct">
<soapenv:Header>
<ord:SessionHeader>
<ord:sessionId>00D7A0000009QITI!

ARUAQFmpeBOmsYS2JcADxYc4PxWoOkAHIP1JiNo5vtvnDBCEVfnWWWmO7pgbEXY7WadiCmm_Vib6MjhmgUbRS
321tI01NQRg</ord:sessionId>

</ord:SessionHeader>



</soapenv:Header>
<soapenv:Body>
<ord:undoCancelOrder>
<ord:request>
<cpq:0rderId>a2n7A0000002twXQAQ</cpq:0rderId>
</ord:request>
</ord:undoCancelOrder>
</soapenv:Body>

</soapenv:Envelope>

Example Response

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmlns="ht
tp://soap.sforce.com/schemas/class/Apttus_Config2/OrderWebService"
xmlns:UndoCancelOrderResponseDO="http://soap.sforce.com/schemas/class/Apttus_Config2/
CPQStruct" xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance">
<soapenv:Body>
<undoCancelOrderResponse>
<result>
<UndoCancelOrderResponseD0O:PreviousOrderSO xsi:type="Apttus_Config2__Orde
r__c'"
<Id>a2n7A0000002tviQAA</Id>
<Apttus_Config2__AutoActivateOrder__c>false</
Apttus_Config2__AutoActivateOrder__c>
<Apttus_Config2__BillToAccountId__c>0017A00000WWOpZQAT</
Apttus_Config2__BillToAccountId__c>
<Apttus_Config2__BillingPreferenceld__c>a2d2f0000000hOYAAQ</
Apttus_Config2__BillingPreferenceld__c>
<Apttus_Config2__ConfigurationSyncDate__c>2020-07-06T08:43:16.000Z</
Apttus_Config2__ConfigurationSyncDate__c>
<Apttus_Config2__IsTaskPending__c>false</
Apttus_Config2__IsTaskPending__c>
<Apttus_Config2__OrderAmount__c>300.00000</
Apttus_Config2__OrderAmount__c>
<Apttus_Config2__OrderDate__c>2020-07-06T06:33:53.000Z</
Apttus_Config2__OrderDate__c>
<Apttus_Config2__OriginalOrderNumber__c>0-00005958</
Apttus_Config2__OriginalOrderNumber__c>
<Apttus_Config2__PriceListId__c>al73CO00000fHFQQA2</
Apttus_Config2__PriceListId__c>



<Apttus_Config2__PricingDate__c>2020-07-06T06:33:53.000Z</
Apttus_Config2__PricingDate__c>
<Apttus_Config2__ReadyForWorkflow__c>false</
Apttus_Config2__ReadyForWorkflow__c>
<Apttus_Config2__ShipToAccountId__c>0017A00000WWOPZQAT</
Apttus_Config2__ShipToAccountId__c>
<Apttus_Config2__SoldToAccountId__c>0017A00000WWOPZQAT</
Apttus_Config2__SoldToAccountId__c>
<Apttus_Config2__SourceChannel__c>Direct</
Apttus_Config2__SourceChannel__c>
<Apttus_Config2__Source__c>Account</Apttus_Config2__Source__c>
<Apttus_Config2__Status__c>Draft</Apttus_Config2__Status__c>
<Apttus_Config2__Type__c>New</Apttus_Config2__Type__c>
<CurrencyIsoCode>USD</CurrencyIsoCode>
<Name>0-00005958</Name>
</UndoCancelOrderResponseD0:PreviousOrderS0>
</result>
</undoCancelOrderResponse>
</soapenv:Body>

</soapenv:Envelope>

Cloning an Order using SOAP API

This APl performs a deep clone of an order. Creates a new copy of the order along with its
related objects rather than creating a new version. Deep clone can only be performed for

orders where all order line items have the status "New." Any order with ABO (Asset-Based

Ordering) line items cannot be cloned in this way.

The following applies when the CloneOrder() API is invoked:

- Cloning an existing order sets the status of the order header and order line items to
"Draft".

- Cloning an existing order resets the following fields: Asset Line Item, Ready for
Activation Date, and Ready for Billing Date.

- Clones the corresponding cart and cart line items. Cart line items can then be
configured and change similar to new draft order.



API Details

API Signature

cloneOrder webService static
Apttus_Config2.CPQStruct.CloneOrderResponseDO
cloneOrder(Apttus_Config2.CPQStruct.CloneOrderRequestDO)

Parameters
Name Type Description
request Apttus_Config2.CPQStruct.CloneOrderRe | The request data object.

questDO

Request Data Object -

Apttus_Config2.CPQStruct.CloneOrderRequestDO

Field Type Required? Description

Orderld ID Yes The order Id to clone. This is the order
number that remains constant from version
to version and is referred by the customer.



APl Response

Response Data Object - CPQStruct.CloneOrderResponeDO

Field Type Description

Orderltems List List of cloned order items.

CloneOrderSO Object The fields of the Clone Order object.
Code Sample

The following code sample enables you to clone an order for a valid order with an Order Id.

[x*kkxkk Clone an order xxkkkkkkkkkkkkkkkkkkx/

Id orderid = 'a2n3COOOOOOCTAC';
Apttus_Config2.CPQStruct.CloneOrderRequestDO request = new
Apttus_Config2.CPQStruct.CloneOrderRequestDO();
request.OrderId = orderid;

w N =

~N o o b

Apttus_Config2.CPQStruct.CloneOrderResponseDO response
=Apttus_Config2.0rderWebService.cloneOrder (request);

Integration Details

Use the following information in your integrations with Conga CPQ Web Services API. Refer
to Integrating Conga with External Systems for information on how to get started.

API Prerequisites

None.



Request and Response XML

Example Request

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmlns:ord="
http://soap.sforce.com/schemas/class/Apttus_Config2/OrderWebService" xmlns:cpg="http:
//soap.sforce.com/schemas/class/Apttus_Config2/CPQStruct">
<soapenv:Header>
<ord:SessionHeader>
<ord:sessionId>00D7A0000009QITI!
ARUAQFmpeBOmsYS2JcADxYc4PxWoOkAHIP1JiNo5vtvnDBCEVfnWWWmO7pgbEXY7WadiCmm_Vib6MjhmgUbRS
321tI01NQRg</ord:sessionId>
</ord:SessionHeader>
</soapenv:Header>
<soapenv:Body>
<ord:cloneOrder>
<ord:request>
<cpq:0rderId>a2n7A0000002tviQAA</cpq:0rderId>
</ord:request>
</ord:cloneOrder>
</soapenv:Body>

</soapenv:Envelope>

Example Response

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmlns="ht
tp://soap.sforce.com/schemas/class/Apttus_Config2/0OrderWebService"
xmlns:CloneOrderResponseDO="http://soap.sforce.com/schemas/class/Apttus_Config2/
CPQStruct" xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance">
<soapenv:Body>
<cloneOrderResponse>
<result>
<CloneOrderResponseD0:CloneOrderS0O xsi:type="Apttus_Config2__Order__c">
<Id>a2n7A0000002tvsQAA<L/Id>
<Apttus_Config2__AutoActivateOrder__c>false</
Apttus_Config2__AutoActivateOrder__c>
<Apttus_Config2__BillToAccountId__c>0017A00000WWOpPZQAT</
Apttus_Config2__BillToAccountId__c>



<Apttus_Config2__BillingPreferenceld__c>a2d2f0000000hOYAAQ</
Apttus_Config2__BillingPreferenceld__c>
<Apttus_Config2__ConfigurationSyncDate__c>2020-07-06T07:29:47.000Z</

<Apttus_Config2__IsTaskPending__c>false</

Apttus_Config2__ConfigurationSyncDate__c>

Apttus_Config2__IsTaskPending__c>
<Apttus_Config2__OrderDate__c>2020-07-06T06:33:53.000Z</

Apttus_Config2__OrderDate__c>
<Apttus_Config2__PricelListId__c>al73CO00000fHFQQA2</

Apttus_Config2__PriceListId__c>
<Apttus_Config2__PricingDate__c>2020-07-06T06:33:53.000Z</

Apttus_Config2__PricingDate__c>
<Apttus_Config2__ReadyForWorkflow__c>false</

Apttus_Config2__ReadyForWorkflow__c>
<Apttus_Config2__ShipToAccountId__c>0017A00000WWOPZQAT</

Apttus_Config2__ShipToAccountId__c>
<Apttus_Config2__SoldToAccountId__c>0017A00000WWOPZQAT</

Apttus_Config2__SoldToAccountId__c>
<Apttus_Config2__SourceChannel__c>Direct</

Apttus_Config2__SourceChannel__c>
<Apttus_Config2__Source__c>Account</Apttus_Config2__Source__c>
<Apttus_Config2__Status__c>Draft</Apttus_Config2__Status__c>
<Apttus_Config2__Type__c>New</Apttus_Config2__Type__c>
<CurrencyIsoCode>USD</CurrencyIsoCode>

</CloneOrderResponseD0:CloneOrderS0O>
</result>
</cloneOrderResponse>
</soapenv:Body>

</soapenv:Envelope>

Fetching Price Agreements

This API fetches price agreements based on proposals or agreements.



API Details

API Signature
GetPriceAgreements webService
static

CPQApiStruct.GetPriceAgreementsResponseDOGetPriceAgre
ements(CPQApiStruct.GetPriceAgreementsRequestDO)

Parameters
Name Type Description
request CPQApiStruct.GetPriceAgreementsRequ The request data object.

estDO

Request Data Object - CPQApiStruct.GetPriceAgreementsRequestDO

Field Type Required? Description

PriceAgreemen | String Yes The type of price agreement. Valid Values:

tType Proposal, Agreement.

Criteria CPQApiStruct | No The criteria details like APl agreement name
.FilterDo and proposal. This is based on FilterDo object.

Fields List<String> No The list of fields to be displayed in the

response data object based on the price
agreement type.

Accountlds List<Id> No The account IDs passed to fetch the price
agreements. This field narrows down the price
agreements based on the filter of account IDs.

CPQApiStruct.FilterDO

This is an APl object that feeds to criteria variable of below request objects:



- CPQApiStruct.GetPriceAgreementsRequestDO
- GetPriceAgreements CPQApiStruct.GetPriceAgreementltemsRequestDO

Request Data Object - CPQApiStruct.FilterDO

Field Type Required? Description
SObjectN | String Y APl name of the subject valid values are:
ame Apttus_Proposal__Proposal__c,

Apttus__APTS_Agreement__c

Predicates | List<CPQApiStruct. | Y List of conditions in where clause
PredicateDO>

Condition | String N To define the complex logic among multiple
Expr conditions.

Example for 2 conditions (1 OR 2)

CPQApiStruct.PredicateDO

This APl defines a filter based on which criteria specifications are set. List of this needs to
feed Predicates variable of FilterDO object type variable.

Parameters
Name Type Description
request CPQApiStruct. PredicateDO The request data object.

Request Data Object - CPQApiStruct.PredicateDO

Field Type Required? Description

RowNum Integer Y The row numbers.

FieldName | String Y The API name of the field.



Request Data Object - CPQApiStruct.PredicateDO

Field Type Required? Description
CompOper | String Y The type of query comparator. Valid values:
equal to,

not equal to,

less than,

less than or equal to,
greater than,
greater than or equal to,
in,

not in,

like,

not like,

includes,

excludes,

starts with,

ends with,

contains,

does not contaiin.

FieldValue | String Y The value based on which data should be fetched.

APl Response

Response Data Object - CPQApiStruct.GetPriceAgreementsResponseDO
Field Type Description

PriceAgreements List<sObject> The list of price agreements fetched based on the
specified input fields.



Code Sample

The following sample enables you to create an order for a valid account with an Account
Id and a Price List with a valid Price List Id. Using the sample below, you can search for a
valid account using an account number. If an account exists with the account number
entered, you can create an order using the createorder() API. You can invoke this APl in use
cases when you want to create an order page based on the account and price list.

1 Apttus_Config2.CPQApiStruct.GetPriceAgreementsRequestDO request = new
Apttus_Config2.CPQApiStruct.GetPriceAgreementsRequestDO();

2

3 // possible values Proposal,Agreement

4 request.PriceAgreementType = 'Proposal';

5

6 Apttus_Config2.CPQApiStruct.FilterDO criteriaSpec = new
Apttus_Config2.CPQApiStruct.FilterDO();

7

// Proposal,Agreement sobjectApi name
9 criteriaSpec.SObjectName = 'Apttus_Proposal__Proposal__c';
10
11 // setup predicates
12 Apttus_Config2.CPQApiStruct.PredicateDO predicate = new
Apttus_Config2.CPQApiStruct.PredicateDO();

13 predicate.RowNum = 1;

14 predicate.FieldName = 'Name';

15 predicate.CompOper = '="';

16 predicate.FieldValue = 'Q-11122"';

17 criteriaSpec.Predicates.add(predicate);
18 request.Criteria = criteriaSpec;

19

20 List<String> fieldNames = new List<String>{'Id','Name'};

21 request.Fields.addAll(fieldNames);

22

23

24 List<Id> accIds = new List<Id>();

25 accIds.add('0015000000FN6mO") ;

26

27 request.AccountIds.addAll(accIds);

28

29 //select Id, Name From Apttus_Proposal__Proposal__c Where
Apttus_Proposal__Approval_Stage__c =:Accepted

30



31 Apttus_CPQApi.PriceAgreementApiCallback apiCall = new
Apttus_CPQApi.PriceAgreementApiCallback();

32 Apttus_Config2.CPQApiStruct.GetPriceAgreementsResponseDO result =
apiCall.getPriceAgreements(request);

33 List<SObject> PriceAgreements = new List<SObject>();

34

35 if (!result.PriceAgreements.isEmpty())

36 PriceAgreements = result.PriceAgreements;

37 system.debug(PriceAgreements);

Fetching Price Agreement Items

GetPriceAgreementltems()

This API fetches price agreement items for a specified price agreement type.

API Details

API Signature

createOrder webService static
CPQApiStruct.GetPriceAgreementitemsResponseDOGetPriceAgree
mentltems(CPQApiStruct.GetPriceAgreementitemsRequestDO)

Parameters

Name Type Description

request CPQApiStruct.GetPriceAgreementltemsR The request data object.

equestDO

Request Data Object - CPQApiStruct.GetPriceAgreementltemsRequestDO

Field Type Required? Description

PriceAgreement | String Yes The type of price agreement. Valid Values:
Type Proposal, Agreement.

Criteria CPQApiStruct. | No The criteria details like APl agreement name

FilterDo and proposal. This is based on FilterDo object.



Request Data Object - CPQApiStruct.GetPriceAgreementltemsRequestDO
Field Type Required? Description

fieldNames List<String> No The Llist of fields to be displayed in the response
data object based on the price agreement type.

priceAgreement | List<String> No The list of price agreements numbers.
Numbers

CPQApiStruct.FilterDO
This is an APl object that feeds to criteria variable of below request objects:

- CPQApiStruct.GetPriceAgreementsRequestDO
- GetPriceAgreements CPQApiStruct.GetPriceAgreementltemsRequestDO

Request Data Object - CPQApiStruct.FilterDO

Field Type Required? Description
SObjectNa | String Y APl name of the subject valid values are:
me Apttus_Proposal__Proposal__c,

Apttus__APTS_Agreement__c

Predicates | List<CPQApiStructP | Y List of conditions in where clause
redicateDO>

ConditionE | String N To define the complex logic among multiple
Xpr conditions.

Example for 2 conditions (1 OR 2)

CPQApiStruct.PredicateDO

This API defines a filter based on which criteria specifications are set. List of this needs to
feed Predicates variable of FilterDO object type variable.



Parameters

Name

request

Request Data Object - CPQApiStruct.PredicateDO

Field

RowNu
m

FieldNa
me

CompO
per

Type

Integer

String

String

CPQApiStruct. PredicateDO

Required?

Description

The request data object.

Description

The row numbers.

The APl name of the field.

The type of query comparator. Valid values:
equal to,

not equal to,

less than,

less than or equal to,
greater than,

greater than or equal to,
in,

not in,

Like,

not like,

includes,

excludes,

starts with,

ends with,

contains,

does not contain.



Request Data Object - CPQApiStruct.PredicateDO

Field Type Required? Description
Fieldval | String Y The value based on which data should be
ue fetched.

API Response

Response Data Object - CPQApiStruct.GetPriceAgreementltemsResponseDO

Field Type Description
PriceAgreementlte | List<sObject> The list of price agreement items fetched based on the
ms specified input fields.

Code Sample

1 Apttus_Config2.CPQApiStruct.GetPriceAgreementItemsRequestDO request = new
Apttus_Config2.CPQApiStruct.GetPriceAgreementItemsRequestDO ();

2 // possible values Proposal,Agreement

3 request.PriceAgreementType = 'Proposal';

4

5 Apttus_Config2.CPQApiStruct.FilterDO criteriaSpec = new
Apttus_Config2.CPQApiStruct.FilterDO();

6 // sobject name

7

8 criteriaSpec.SObjectName = 'Apttus_Proposal__Proposal_Line_Item__c';

9 // setup predicates

10 Apttus_Config2.CPQApiStruct.PredicateDO predicate = new
Apttus_Config2.CPQApiStruct.PredicateD0();

11 predicate.RowNum = 1;

12 predicate.FieldName =
'"Apttus_Proposal__Proposal__r.Apttus_Proposal__Approval_Stage__c';

13 predicate.CompOper = 'equal to';

14 predicate.FieldValue = 'Accepted';

15

16 Apttus_Config2.CPQApiStruct.PredicateDO predicate2 = new
Apttus_Config2.CPQApiStruct.PredicateD0();

17 predicate2.RowNum = 1;



18 predicate2.FieldName =
'"Apttus_Proposal__Proposal__r.Apttus_Proposal__ExpectedStartDate__c';
19 predicate2.CompOper = '=';

20 predicate2.FieldValue = ':Apttus_QPConfig__StartDate__c';
21

22 criteriaSpec.Predicates.add(predicate2);

23

24 criteriaSpec.ConditionExpr = '1 AND 2';

25

26 List<String> fieldNames = new List<String>{'Id','Name'};

27 request.Fields.addAll(fieldNames);

28

29 List<String> priceAgreementNumbers = new List<String>();

30 priceAgreementNumbers.add('Q-00002175");

31

32 // contract numbers

33 request.PriceAgreementNumbers.addAll(priceAgreementNumbers) ;

34

35

36

37 Apttus_CPQApi.PriceAgreementApiCallback apiCall = new
Apttus_CPQApi.PriceAgreementApiCallback();

38 Apttus_Config2.CPQApiStruct.GetPriceAgreementItemsResponseDO result =
apiCall.getPriceAgreementItems(request);

39 system.debug(result.PriceAgreementItems);

Creating a Partial Order from a Quote or Agreement

This APl creates a partial order from a quote or agreement.

For detailed information on partial orders, refer to the Order Management on
Salesforce User Guide.

API Details
API Signature
CreateOrderRequest webService static

CPQApPI.CPQ.CreateOrderResponseDOCreateOrderRequest(
CPQApi.CPQ.CreateOrderRequestDO)



Parameters

Name Type

request CPQApi.CPQ.CreateOrderRequestDO

Request Data Object - CPQApi.CPQ.CreateOrderRequestDO

Field Type

CustomField | List<String>
s

Orderlnput Apttus_Config2__Order__c

Orderltems List<Apttus_CPQApI.CPQ.Selecte
dProductDO>

OrderltemSo | String
urce

Properties List<Apttus_Config2.Property>

Required?

No

Yes

No

Yes

No

Request Data Object - CPQAPpi.CPQ.SelectedProductDO

Field Type

Description

The request data object.

Description

List of custom fields on
orderSO

OrderSO

List of order items

Source of order items

List of properties for cart
created for order

Required? Description

AttributeValues List<Apttus_Config2__Product | No

AttributeValue__c>

Comments String No
CopyBundleConfigurat | Boolean No
ionFromSource

CustomData Apttus_Config2__Lineltem__c | No
CustomFields List<String> No
EndDate Date No

The product attribute
value for the product

Comments

For bundles, to copy
bundle configuration

Custom data line item

List of custom fields

End date



Request Data Object - CPQAPpi.CPQ.SelectedProductDO

Field
Productld
Quantity

RelatedLineltems

SellingTerm

SourceFields

Sourceld

StartDate

Code Sample

Type

Id

Decimal

List<Apttus_Config2__Related
Lineltem__c>

Decimal

List<String>

Date

Required?

No

No

No

No

No

No

No

Description

Product |d

Quantity

List of related line items

Selling term

List of source custom
fields to be copied

Id of a source item

Start Date

The following sample uses an explicit product definition for order items while creating

partial order from quote/agreement.
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// order item source

// create order [dinput

Apttus_CPQApi.CPQ.CreateOrderRequestDO request
= new Apttus_CPQApi.CPQ.CreateOrderRequestDO();

request.OrderItemSource = Apttus_CPQApi.CPQ.ITEMSOURCE_QUOTE_LINEITEM;

Apttus_Config2__Order__c inputSO = new Apttus_Config2__Order__c();

inputSO.Apttus_Config2__SoldToAccountId__c = '0014C00000F9Zz3";

inputSO.Apttus_Config2__PricelListId__c = 'al74C0000001MQ1"';
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36
37
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inputSO.Apttus_Config2__PricingDate__c = Datetime.now();
inputSO.Apttus_Config2__OrderDate__c = Datetime.now();
inputSO.Apttus_Config2__OrderStartDate__c = Date.today();

inputSO.Apttus_Config2__OrderEndDate__c = Date.today().addMonths(12);

// add custom fields to orderSO (optional)

inputSO.put('Apttus_QPConfig__Proposalld__c','a0Y4C0000021Cm5");

request.OrderInput = inputSO;

request.CustomFields.add('Apttus_QPConfig__Proposalld__c');

// add order +items (optional)

// selected -item

Apttus_CPQApi.CPQ.SelectedProductDO productDO
= new Apttus_CPQApi.CPQ.SelectedProductDO();

productDO.Comments = 'Test Create Order API';

productDO.CopyBundleConfigurationFromSource = false;

productDO.StartDate = Date.today();

productDO.EndDate = Date.today().addMonths(12);

productDO.SellingTerm = 12;

productDO.Quantity = 1;

productDO.ProductId = '01t4C000001pB1J]';

// add attributes to the selected product (optional)
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Apttus_Config2__ProductAttributeValue__c
attVal = new Apttus_Config2__ProductAttributeValue__c();

attVal.APTS_TestAttColor__c = 'Black';

productDO.AttributeValues.add(attVal);

// add related line +items to selected product (optional)

Apttus_Config2__RelatedLineltem__c
lineltem = new Apttus_Config2__RelatedLineItem__c();

lineItem.Apttus_Config2__RelationType__c = 'Wallet';

productDO.RelatedLineItems.add(lineItem);

// source 1id and the explicit product definition are mutually exclusive

// productDO.Sourceld = 'aOW4COOOOO1IMRRF';

request.OrderItems.add(productDO);

// order properties (optional)

// request.Properties.add(new

Apttus_Config2.Property('useAdvancedApproval' 'false'));

// request.Properties.add(new Apttus_Config2.Property('useDealOptimizer'
'false'));
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// request.Properties.add(new Apttus_Config2.Property('retId',
'a0Y4C0000021Cm5")) ;

// request.Properties.add(new Apttus_Config2.Property('cntrNbr_1"',
'Q-00004442'));

// create order api call

Apttus_CPQApi.CPQ.CreateOrderResponseDO result
= Apttus_CPQApi.CPQWebService.createOrder (request);

Code Sample

This sample uses an explicit product definition for order items while creating partial order

from quote/agreement.
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Apttus_CPQApi.CPQ.CreateOrderRequestDO request
= new Apttus_CPQApi.CPQ.CreateOrderRequestDO();

// order ditem source

request.OrderItemSource = Apttus_CPQApi.CPQ.ITEMSOURCE_QUOTE_LINEITEM;

// create order 1dinput

Apttus_Config2__Order__c inputSO = new Apttus_Config2__Order__c();

inputSO.Apttus_Config2__SoldToAccountId__c = '0014C00000F9Zz3"';

inputSO.Apttus_Config2__PricelListId__c = 'al74C0000001MQ1"';

inputSO.Apttus_Config2__PricingDate__c Datetime.now();
inputSO.Apttus_Config2__OrderDate__c = Datetime.now();

inputSO.Apttus_Config2__OrderStartDate__c = Date.today();

inputSO.Apttus_Config2__OrderEndDate__c = Date.today().addMonths(12);
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// add custom fields to orderSO (optional)

inputSO.put('Apttus_QPConfig__Proposalld__c','a@Y4C0000021Cm5");

request.OrderInput = inputSO;

request.CustomFields.add('Apttus_QPConfig__Proposalld__c');

// add order qitems (optional)

// selected item

Apttus_CPQApi.CPQ.SelectedProductDO productDO

= new Apttus_CPQApi.CPQ.SelectedProductDO();

productDO.Comments = 'Test Create Order API';

productDO.CopyBundleConfigurationFromSource = false;

productDO.StartDate = Date.today();

productDO.EndDate = Date.today().addMonths(12);

productDO.SellingTerm = 12;

productDO.Quantity = 1;

//productDO.ProductId = '01t4C000001pB1J';

// add attributes to the selected product (optional)

Apttus_Config2__ProductAttributeValue__c
attVal = new Apttus_Config2__ProductAttributeValue__c();

attVal.APTS_TestAttColor__c = 'Black';

productDO.AttributeValues.add(attVal);
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// add related line +items to selected product (optional)

Apttus_Config2__RelatedLineltem__c

lineItem = new Apttus_Config2__RelatedLineItem__c();

lineIltem.Apttus_Config2__RelationType__c = 'Wallet';

productDO.RelatedLineItems.add(lineItem);

// source id and the explicit product definition are mutually exclusive

productDO.Sourceld = 'aOW4COOOOO1IMRRF';

request.OrderItems.add(productDO);

// add order properties to use contract pricing (optional)

// order properties (optional)

// request.Properties.add(new

Apttus_Config2.Property('useAdvancedApproval' 'false'));

// request.Properties.add(new Apttus_Config2.Property('useDealOptimizer'
'false'));

// request.Properties.add(new Apttus_Config2.Property('retId',
'a0Y4C0000021Cm5")) ;

request.Properties.add(new Apttus_Config2.Property('cntrNbr_1"',
'Q-00004442'));

// Q-00004442 s the contract number in this example (Contract Number



112
113
114
115
116
117
118
119

field on Pricelist object)

// create order api call

Apttus_CPQApi.CPQ.CreateOrderResponseD0O result
= Apttus_CPQApi.CPQWebService.createOrder (request);

Creating a Direct Order

This API creates a direct order without source Id.

CPQApPI.CPQ.CreateOrderResponseDOCreateOrderRequest(
CPQApi.CPQ.CreateOrderRequestDO)

API Details
API Signature
CreateOrderRequest webService static
Parameters
Name Type
request CPQApIi.CPQ.CreateOrderRequestDO

Request Data Object - CPQAPpi.CPQ.CreateOrderRequestDO

Field

CustomFiel
ds

Orderlnput

Orderltems

Type

List<String>

Conga_Config2__Order__c

List<Apttus_CPQApi.CPQ.Selecte
dProductDO>

Required?

No

Yes

No

Description

The request data object.

Description

List of custom fields on
orderSO

OrderSO

List of order items



Request Data Object - CPQApi.CPQ.CreateOrderRequestDO

Field Type Required?
OrderltemS | String Yes

ource

Properties List<Apttus_Config2.Property> No

Request Data Object - CPQAPpi.CPQ.SelectedProductDO

Field

AttributeValues

Comments

CopyBundleConfigurat
ionFromSource

CustomData

CustomFields

EndDate

Productld

Quantity

RelatedLineltems

SellingTerm

SourceFields

Sourceld

Type

List<Apttus_Config2__Product
AttributeValue__c>

String

Boolean

Apttus_Config2__Lineltem__c

List<String>

Date

Id

Decimal

List<Apttus_Config2__Related
Lineltem__c>

Decimal

List<String>

Required?

No

No

No

No

No

No

No

No

No

No

No

No

Description

Source of order items

List of properties for cart
created for order

Description

Product attribute value
for the product

Comments

For bundles, to copy
bundle configuration

Custom data line item

List of custom fields

End date

Product |d

Quantity

List of related line items

Selling term

List of source custom
fields to be copied

Id of a source item



Request Data Object - CPQAPpi.CPQ.SelectedProductDO

Field Type Required? Description
StartDate Date No Start Date
Code Sample
1 Apttus_CPQApi.CPQ.CreateOrderRequestDO
2 request = new Apttus_CPQApi.CPQ.CreateOrderRequestDO();
3
4
5 // order -ditem source
6
7 request.OrderItemSource = Apttus_CPQApi.CPQ.ITEMSOURCE_QUOTE_LINEITEM;
8
9
10 // create order 1dinput
11
12 Apttus_Config2_Orderc
13 inputSO = new Apttus_Config20rder_c();
14
15
16 inputSO.Apttus_Config2_SoldToAccountId_c
17 = '0014C0O0000F9Zz3";
18
19 inputSO.Apttus_Config2_PricelListId_c
20 = 'al74C0000001MQ1"';
21
22 inputSO.Apttus_Config2_PricingDate_c
23 = Datetime.now();
24
25 inputSO.Apttus_Config2_OrderDate_c
26 = Datetime.now();
27
28 inputSO.Apttus_Config2_OrderStartDate_c
29 = Date.today();
30
31 inputSO.Apttus_Config2_OrderEndDate_c
32 = Date.today().addMonths(12);

w
w
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inputSO.put('Apttus_QPConfig_Proposalld_c','a@Y4C0000021Cm5");

request.OrderInput = dinputSO;

request.CustomFields.add('Apttus_QPConfig_Proposalld_c');

// add order qitems (optional)

// selected -item

Apttus_CPQApi.CPQ.SelectedProductDO productDO = new
Apttus_CPQApi.CPQ.SelectedProductDO();

productDO.Comments = 'Test Create Order API';

productDO.CopyBundleConfigurationFromSource = false;

productDO.StartDate = Date.today();

productDO.EndDate = Date.today().addMonths(12);

productDO.SellingTerm = 12;

productDO.Quantity = 1;

productDO.ProductId = '01t4C000001pB1J"';

Apttus_Config2_ProductAttributeValuec

attVal = new Apttus_Config2ProductAttributeValue_c();

attVal.RY_Color__c = 'Black';

productDO.AttributeValues.add(attVal);

// productDO.SourceIld = 'aOW4COOOOO1MRRF';

request.OrderItems.add(productDO);

// create order



79 Apttus_CPQApi.CPQ.CreateOrderResponseD0O result =
80 Apttus_CPQApi.CPQWebService.createOrder (request);

Executing Order Workflow

This APl executes an Order Workflow Ruleset (Composite API).

API Details

API Signature

execOrderWorkflow static
Apttus_Config2.CPQStruct.ExecOrderWorkflowResponseDO
execOrderWorkflow(Apttus_Config2.CPQStruct.ExecOrderWo
rkflowRequestDO)

Parameters

Name Type Description

request Apttus_Config2.CPQStruct.ExecOrderWor | The request data object.

kflowRequestDO

Request Data Object - Apttus_Config2.CPQStruct.ExecOrderWorkflowRequestDO
Field Type Required? Description

Orderld | ID Yes Reference to the order. Order iD can be any one of the
following:

- Order in "Pending, In Fulfillment, Partially Fulfilled"
status that requires amendment

- Order in "In Amendment" status for which additional line
item changes are required



APl Response

Response Data Object - Apttus_Config2.CPQStruct.ExecOrderWorkflowResponseDO

Field Type Description
IsSucces | Boolean | Workflow is a success true/false
s
Jobld Id of asynchronous apex thread. The status of this job can be tracked as a
Salesforce Apex Job
Code Sample

The following sample enables you to execute an order workflow.
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// id of an order record where status is Pending or In Fulfillment or
Partially Fulfilled
Id orderId = 'a2n2f0000008Swz';

// request

Apttus_Config2.CPQStruct.ExecOrderWorkflowRequestDO request = new
Apttus_Config2.CPQStruct.ExecOrderWorkflowRequestDO() ;
request.OrderId = orderId;

// response

response =
Apttus_Config2.0rderWebService.execOrderWorkflow(request);
system.debug('Success = '+response.IsSuccess);

system.debug('Async Job Id = '+response.JobId);

Splitting an Order using API

This API divides an existing order (parent order) into multiple orders (child orders) during the

provisioning process. You can split any large order that was created from a Quote,

Agreement, or Direct order that has not been amended.



API Details

API Signature

SplitOrder webService static
Apttus_Config2.CPQStruct.SplitOrderResponseDO
splitOrder(Apttus_Config2.CPQStruct.SplitOrderRequestDO)

Parameters
Name Type Description
request CPQStruct.SplitOrderRequestDO The request data object.

Request Data Object - CPQStruct.SplitOrderRequestDO

Field Type Required? Description

Orderld ID Yes The parent order ID to create a split
order.

OrderLineNumbers ID Yes order line numbers to be part of new
split order.

API Response

Response Data Object - CPQStruct.SplitOrderResponseDO
Field Type Description

SplitOrderSO ID The Id of the newly created split order.



Code Sample

The following code sample enables you to split an existing valid order into multiple orders

using Orderld and OrderLineNumbers.

Sample snippet:

1 // split the order
Apttus_Config2.CPQStruct.SplitOrderRequestDO request = new
Apttus_Config2.CPQStruct.SplitOrderRequestDO();
3 request.OrderId = 'a2n7A0000002jnWQAQ'; // order id to create split
order from
5 request.OrderLineNumbers = new List<Integer>{1}; //add order line
numbers to be part of new split order
6
Apttus_Config2.CPQStruct.SplitOrderResponseDO result =
Apttus_Config2.0rderWebService.splitOrder(request);
9 Apttus_Config2__Order__c splitOrderSO = result.SplitOrderSoO;

Integration Details

Use the following information in your integrations with Conga CPQ Web Services API. Refer
to Integrating conga with External Systems for information on how to get started.

Request and Response XML

Example Request

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmlns:ord="
http://soap.sforce.com/schemas/class/Apttus_Config2/OrderWebService" xmlns:cpg="http:
//soap.sforce.com/schemas/class/Apttus_Config2/CPQStruct">
<soapenv:Header>
<ord:SessionHeader>
<ord:sessionId>00D7A0000009QII!

ARUAQFmpeBOmsYS2JcADxYc4PxWoOkAHIP1JiNo5vtvnDBCEVfnWWWmO7pgbEXY7WadiCmm_Vib6MjhmgUbR8
321tI01INQRg</ord:sessionId>

</ord:SessionHeader>

</soapenv:Header>



<soapenv:Body>
<ord:splitOrder>
<ord:request>
<cpq:0rderId>a2n7A0000002tviQAA</cpq:0rderId>
<cpq:0rderLineNumbers>2</cpq:0rderLineNumbers>
</ord:request>
</ord:splitOrder>
</soapenv:Body>

</soapenv:Envelope>

Example Response

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmlns="ht
tp://soap.sforce.com/schemas/class/Apttus_Config2/OrderWebService"
xmlns:SplitOrderResponseDO="http://soap.sforce.com/schemas/class/Apttus_Config2/
CPQStruct" xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance">
<soapenv:Body>
<splitOrderResponse>
<result>
<SplitOrderResponseD0:SplitOrderSO xsi:type="Apttus_Config2__Order__c">
<Id>a2n7A0000002tvxQAA</Id>
<Apttus_Config2__AutoActivateOrder__c>false</
Apttus_Config2__AutoActivateOrder__c>
<Apttus_Config2__BillToAccountId__c>0017A00000WWOPZQAT</
Apttus_Config2__BillToAccountId__c>
<Apttus_Config2__BillingPreferenceld__c>a2d2f0000000hOYAAQ</
Apttus_Config2__BillingPreferenceld__c>
<Apttus_Config2__ConfigurationSyncDate__c>2020-07-06T08:39:40.000Z</
Apttus_Config2__ConfigurationSyncDate__c>
<Apttus_Config2__IsTaskPending__c>false</
Apttus_Config2__IsTaskPending__c>
<Apttus_Config2__OrderAmount__c>500.00000</
Apttus_Config2__OrderAmount__c>
<Apttus_Config2__OrderDate__c>2020-07-06T06:33:53.000Z</
Apttus_Config2__OrderDate__c>
<Apttus_Config2__OriginalOrderNumber__c>0-00005958</
Apttus_Config2__OriginalOrderNumber__c>
<Apttus_Config2__ParentOrderId__c>a2n7A0000002tviQAA</
Apttus_Config2__ParentOrderId__c>
<Apttus_Config2__PricelListId__c>al73C000000fHFQQA2</
Apttus_Config2__PriceListId__c>



<Apttus_Config2__PricingDate__c>2020-07-06T06:33:53.000Z</
Apttus_Config2__PricingDate__c>
<Apttus_Config2__ReadyForWorkflow__c>false</
Apttus_Config2__ReadyForWorkflow__c>
<Apttus_Config2__ShipToAccountId__c>0017A00000WWOPZQAT</
Apttus_Config2__ShipToAccountId__c>
<Apttus_Config2__SoldToAccountId__c>0017A00000WWOPZQAT</
Apttus_Config2__SoldToAccountId__c>
<Apttus_Config2__SourceChannel__c>Direct</
Apttus_Config2__SourceChannel__c>
<Apttus_Config2__Source__c>Account</Apttus_Config2__Source__c>
<Apttus_Config2__Status__c>Draft</Apttus_Config2__Status__c>
<Apttus_Config2__Type__c>New</Apttus_Config2__Type__c>
<CurrencyIsoCode>USD</CurrencyIsoCode>
</SplitOrderResponseD0:SplitOrderSO>
</result>
</splitOrderResponse>
</soapenv:Body>

</soapenv:Envelope>

Splitting an Order by criteria

This API divides an existing order (parent order) into multiple orders (child orders) based on
the defined criteria. Criteria should be added while calling the API. You can split any large
order that was created from a Quote, Agreement, or Direct order that has not been

amended.
API Details
API Signature
splitOrder webService static
Conga_Config2.CPQStruct.SplitOrderResponseDO
splitOrder(Apttus_Config2.CPQStruct.SplitOrderRequestDO)
Parameters
Name Type Description

request CPQStruct.SplitOrderRequestDO The request data object.



Request Data Object - CPQStruct.SplitOrderRequestDO

Field Type Required? Description

Orderld ID Yes The parent order ID to create a split
order.

ProductID ID Yes The product ID added in the parent
order.

API Response

Response Data Object -
CPQStruct.SplitOrderResponseDO

Field Type Description
SplitOrderSO | ID The Id of the newly created split
order.
Code Sample

The following code sample enables you to split an existing valid order into multiple orders
using Orderld and OrderLineNumbers.

Sample snippet:

1 Apttus_Config2.CPQStruct.SplitOrderRequestDO request = new
Apttus_Config2.CPQStruct.SplitOrderRequestDO();
request.OrderId = 'a2n7A0000002mSo"';
//split based on product
request.SplitCriteriaFields.add('Apttus_Config2__ProductId__c');
Apttus_Config2.CPQStruct.SplitOrderResponseD0 result =

a A W N

Apttus_Config2.0rderWebService.splitOrder(request);



Integration Details

Use the following information in your integrations with Conga CPQ Web Services API. Refer
to Integrating Conga with External Systems for information on how to get started.

Request and Response XML

Example Request

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmlns:ord="
http://soap.sforce.com/schemas/class/Apttus_Config2/0OrderWebService" xmlns:cpg="http:
//soap.sforce.com/schemas/class/Apttus_Config2/CPQStruct">
<soapenv:Header>
<ord:SessionHeader>
<ord:sessionId>00D7A0000009QII!
ARUAQHamHUdKQgPNeSQPZdo719RxuQc_XBiAYgTnBaswMACJulz.5fL1ZYpOP6kNf1jKKe4tVrdBb7HNO9Nge
PMYF.s.rdq8</ord:sessionId>
</ord:SessionHeader>
</soapenv:Header>
<soapenv:Body>
<ord:splitOrder>
<ord:request>
<cpq:0rderId>a2n7A0000002tvs</cpq:0rderId>
<cpq:SplitCriteriaFields>product</cpq:SplitCriteriaFields>
</ord:request>
</ord:splitOrder>
</soapenv:Body>

</soapenv:Envelope>

Example Response

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmlns="ht
tp://soap.sforce.com/schemas/class/Apttus_Config2/0OrderWebService"
xmlns:SplitOrderResponseD0O="http://soap.sforce.com/schemas/class/Apttus_Config2/
CPQStruct" xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance">
<soapenv:Body>
<splitOrderResponse>
<result>
<SplitOrderResponseD0:SplitOrderSO xsi:nil="true"/>
</result>



</splitOrderResponse>
</soapenv:Body>

</soapenv:Envelope>

Splitting an Order by threshold

This API divides an existing order (parent order) into multiple orders (child orders) based on
the threshold defined in the Order System Properties.

Important

The split threshold can not be defined independently. Criteria should be added while
calling the API. Apttus Order Management recommends you select the common

fields like a price list id.

API Details
API Signature
splitOrder webService static
Apttus_Config2.CPQStruct.SplitOrderResponseDO
splitOrder(Apttus_Config2.CPQStruct.SplitOrderRequestDO)
Parameters
Name Type Description

request CPQStruct.SplitOrderRequestDO The request data object.



Request Data Object - CPQStruct.SplitOrderRequestDO

Field Type Required? Description

Orderld ID Yes The parent order ID to create a split
order.

OrderLineNumbers ID Yes order line numbers to be part of a

new split order.

APl Response

Response Data Object - CPQStruct.SplitOrderResponseDO

Field Type Description
SplitOrderSO ID The Id of the newly created split order.
Code Sample

The following code sample enables you to split an existing valid order into multiple orders
using Orderld and OrderLineNumbers.

Sample snippet:

1 Apttus_Config2.CPQStruct.SplitOrderRequestDO request = new
Apttus_Config2.CPQStruct.SplitOrderRequestDO();
request.OrderId = 'a2n7A0000002tRi"';
//Split based on threshold which is defined in the order system
properties.Split Order Threshold

4 //Must add a common criterion like price list id while splitting with a
threshold
5 request.SplitCriteriaFields.add('Apttus_Config2__PricelListId__c');

Apttus_Config2.CPQStruct.SplitOrderResponseDO result =
Apttus_Config2.0rderWebService.splitOrder(request);

Integration Details

Use the following information in your integrations with Conga CPQ Web Services API. Refer
to Integrating Conga with External Systems for information on how to get started.



Request and Response XML

Example Request

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmlns:ord="
http://soap.sforce.com/schemas/class/Apttus_Config2/0OrderWebService" xmlns:cpg="http:
//soap.sforce.com/schemas/class/Apttus_Config2/CPQStruct">
<soapenv:Header>
<ord:SessionHeader>
<ord:sessionId>00D7A0000009QII!
ARUAQHamHUdKQgPNeSQPZdo719RxuQc_XBiAYgTnBaswMACJulz.5fL1ZYpOP6kNf1jKKe4tVrdBb7HNO9Nge
PMYF.s.rdq8</ord:sessionId>
</ord:SessionHeader>
</soapenv:Header>
<soapenv:Body>
<ord:splitOrder>
<ord:request>
<cpq:0rderId>a2n7A0000002tvs</cpq:0rderId>
<!Adding price list ID>
<cpq:SplitCriteriaFields>al73CO00OOOTHFQ</cpq:SplitCriteriaFields>
</ord:request>
</ord:splitOrder>
</soapenv:Body>

</soapenv:Envelope>

Example Response

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" xmlns="ht
tp://soap.sforce.com/schemas/class/Apttus_Config2/OrderWebService"
xmlns:SplitOrderResponseDO="http://soap.sforce.com/schemas/class/Apttus_Config2/
CPQStruct" xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance">
<soapenv:Body>
<splitOrderResponse>
<result>
<SplitOrderResponseD0:SplitOrderSO xsi:nil="true"/>
</result>
</splitOrderResponse>
</soapenv:Body>
</soapenv:Envelope>



Use Case

Use Case - A Manufacturing company quotes 450 hardware items on quote Ql. An order Ol
has been generated with 450 line items. The back-office ERP system leveraged for the
fulfillment of hardware items can only process 100 lines in a given order. Hence, the order
needs a split.

The splitOrder API allows the users to split an order based on the threshold defined in the
Order System Properties.

The Split result- The split operation creates five new orders where four orders with 100 lines
and one with 50 lines. The original order will be empty. However, there is no impact on the
configuration defined in the quote. on the quote is not impacted.

Customer Purchase Order (CPO) Web Service

You can invoke APIs in Order Web Service (Apttus_Config2) from the following command.

Apttus_Config2.CPQStruct.<Name of the Function>

where the name of the function is API Name and it parameters.
Use CPO Web Service APIs to complete the following tasks:

- Accepting Customer Purchase Orders

« Amending Customer Purchase Orders

- Reverting Amended Customer Purchase Orders
- Cancelling Customer Purchase Orders

- Reverting Cancelled Customer Purchase Orders

- Creating Orders from PO

While capturing a Customer Purchase Order for Purchase Order and Purchase Order
ltems, refer to standard Salesforce SOQL APIs.

Accepting Customer Purchase Orders

This APl accepts a Customer Purchase Order in Draft status. Changes the status of the
Customer Purchase Order and Purchase Order Items to Accepted.



API Details

API Signature

acceptOrder webService static
Apttus_Config2.CPQStruct.AcceptCustomerPOResponseDO
acceptOrder(Apttus_Config2.CPQStruct. AcceptCustomerPORequ

estDO)
Parameters
Name Type Description
request Apttus_Config2.CPQStruct.AcceptCustom | The request data object.
erPORequestDO

Request Data Object -
Apttus_Config2.CPQStruct.AcceptCustomerPORequestDO

Field Type Re | Description
qui
red
?
Customer | ID Yes @ The ld of the Order to be finalized.

POId



APl Response

Response Data Object - CPQStruct.AcceptCustomerPOResponseDO
Field Type Description
CustomerPurchaseOrderSO Standard Object The response data object.

Response Data Object - CustomerPurchaseOrderSO

Field Type Description
IsSuccess boolean Specifies whether the order is finalized
successfully.
Code Sample

The following enables you to accept an order for a valid customer purchase order with an
Order ID.

// accept the order

CPQStruct.AcceptCustomerPORequestDO request = new
CPQStruct.AcceptCustomerPORequestDO() ;
3 request.CustomerPOId = customerPO.Id;

5 CPQStruct.AcceptCustomerPOResponseDO result =

CustomerPOWebService.acceptOrder (request);

6 system.debug(result.CustomerPurchaseOrderSo0)

Amending Customer Purchase Orders

This APl modify or amend a Customer Purchase Orders without changing the value of the
order line items (Composite API).

API Details



API Signature

amendCustomerPO webService
static

Apttus_Config2.CPQStruct. AmendCustomerPOResponseDOam
endCustomerPO(Apttus_Config2.CPQStruct. AmendCustomerP

ORequestDO)
Parameters
Name Type Description
request Apttus_Config2.CPQStruct. AmendCustom | The request data object.
erPORequestDO

Request Data Object - Apttus_Config2.CPQStruct. AmendCustomerPORequestDO

Field Type Required? Description
Custome | ID Yes Reference to the order. Order Id can be any one of the
rPOId following:

- Order in "Accept, Partially Processed" status that
requires amendment

- Orderin "In Amendment" status for which
additional line item changes are required

Custome | List<Custome | No CPO ltems to be amended
rPOltem | rPOltem__C>
s

API Response
Response Data Object - CPQStruct.AmendCustomerPOResponseDO
Field Type Description

AmendCustomerPOS | Standard Data The fields of the AmendOrder Object
@) Object



Response Data Object - CPQStruct.AmendCustomerPOResponseDO

Field Type Description
AmendedCustomerP List List of amended order items
Oltems

Code Sample

The following sample enables you to amend an order for a valid order with an Order Id.

1 // create the amend request CPQStruct.AmendCustomerPORequestDO request =
new CPQStruct.AmendCustomerPORequestDO() ;
request.customerP0Id = customerP0.ID;
request.CustomerPOItems = CustomerPOItems;
CPQStruct.AmendCustomerPOResponseD0O result =
CustomerPOWebService.amendCustomerPO(request) ;

5 system.debug(result.AmendCustomerP0S0) ;
system.debug(result.AmendedCustomerPOItems) ;

Reverting Amended Customer Purchase Orders

This APl undo or revert an amended Customer Purchase Order (Composite API). For example,
You can roll back the changed order date to the previous date using this API.

API Details
API Signature
undoAmendCustomerPO webService

static

Apttus_Config2.CPQStruct.UndoAmendCustomerPORespons
eDOundoAmendCustomerPO(Apttus_Config2.CPQStruct.Un
doAmendCustomerPORequestDO)



Parameters

Name Type Description
request Apttus_Config2.CPQStruct.UndoAmendCu | The request data object.
stomerPORequestDO

Request Data Object - Apttus_Config2.CPQStruct.UndoAmendCustomerPORequestDO
Field Type Required? Description

CustomerPOId | ID Yes Unique identifier of the amended order.

API Response

Response Data Object - CPQStruct.UndoAmendCustomerPOResponseDO
Field Type Description

PreviousCusto | Standard Data The fields of the Previous Order Object.
merPurchaseO | Object
rderSO

Code Sample

The following sample allows you to roll back an amendment to an order.

//undoamend customerPurchaseOrder
CPQStruct.UndoAmendCustomerPORequestDO request
CPQStruct.UndoAmendCustomerPORequestDO() ;

N B

new

3 request.CustomerPOId = CustomerPOId;

5 CPQStruct.UndoAmendCustomerPOResponseD0O result

CustomerPOWebService.undoAmendCustomerPO(request) ;



6 system.debug(result.PreviousCustomerPurchaseOrderSo0)

Cancelling Customer Purchase Orders

This APl cancels a Customer Purchase Order.

API Details

API Signature

cancelCustomerPO webService static
Apttus_Config2.CPQStruct.CancelCustomerPOResponseDOca
ncelCustomerPO(Apttus_Config2.CPQStruct.CancelCustomerP
ORequestDO)

Parameters

Name Type Description

request Apttus_Config2.CPQStruct.CancelCustom | The request data object.

erPORequestDO

Request Data Object - Apttus_Config2.CPQStruct.CancelCustomerPORequestDO

Field Type Required? Description
CustomerP ID Yes Unique identifier of the Latest version of the customer purchase
Old order to be cancelled.

API Response

Response Data Object - CPQStruct.CancelCustomerPOResponseDO
Field Type Description

CancelCustomerPOSO | Standard Data Object | The fields of the Cancel Order Object.



Code Sample

The following sample allows you to cancel a customer purchase order.

// Create the Cancel Request Data Object

CPQStruct.CancelCustomerPORequestDO request = new
CPQStruct.CancelCustomerPORequestDO() ;
3 request.CustomerPOId = customerP0.Id;
5 CPQStruct.CancelCustomerPOResponseDO result = new
CPQStruct.CancelCustomerPOResponseDO() ;
6 result = CustomerPOWebservice.cancelCustomerPO(request);

// returns next version of customerpurchaseOder

8 system.debug(result.CancelCustomerP0S0) ;

Reverting Cancelled Customer Purchase Orders

This APl reverts the cancellation of a customer purchase order.

API Details

API Signature

undoCancelCustomerPO webService static
Apttus_Config2.CPQStruct.UndoCancelCustomerPORespons
eDOundoCancelCustomerPO(Apttus_Config2.CPQStruct.Und
oCancelCustomerPORequestDO)

Parameters

Name Type Description

request Apttus_Config2.CPQStruct.UndoCancelC | The request data object.

ustomerPORequestDO



Request Data Object - Apttus_Config2.UndoCancelCustomerPORequestDO
Field Type Required? Description

CustomerPOId ID Yes Unique identifier of the latest version
of cancelled customer purchase order.

APl Response

Response Data Object - CPQStruct.UndoCancelOrderResponseDO

Field Type Description
PreviousCustomerPurchase | Standard Data The fields of the previous customer purchase
OrderSO Object order object.

Code Sample

The following sample allows you to roll back cancellation of a customer purchase order.

//undocancel customerPurchaseOrder

CPQStruct.UndoCancelCustomerPORequestDO request
CPQStruct.UndoCancelCustomerPORequestDO() ;

new

request.CustomerP0Id = CustomerPOId;

CPQStruct.UndoCancelCustomerPOResponseDO result =

CustomerPOWebService.undoCancelCustomerPO(request);

system.debug(result.PreviousCustomerPurchaseOrderSo0) ;

Creating Orders from PO

This APl creates a sales order from a Customer Purchase Order: single order, multiple order
using split criteria, or partial order.



You must enable the Split Group Properties field on PO item in order to consume
this functionality. Refer to the Order Management on Salesforce Administrator
Guide for steps.

API Details
API Signature
createOrderForPO webService

static Apttus_CPQApI.CPQ.CreateOrderfForPOResponseDO
createOrderForPO(Apttus_ CPQApI.CPQ.CreateOrderForPORe
questDQO)

Parameter 1: Create Order for Customer Purchase Order Data Object

Name Type Description
request Apttus_CPQApi.CPQ.CreateOrderForPO | The request data object.
RequestDO

Request Data Object - CreateOrderForPORequestDO

Field Type Description
orderlnputSO Standard Object To create the order inputs.
PurchaseOrderld ID To create a single order.
SplitGroupFields List<String> To group by orders

Request Standard Object - orderlnputSO

Field Type Required? | Description

SoldToAccoun | ID Yes The id of the Account to which the order is placed.
tid



Request Standard Object - orderlnputSO

Field

PriceListld

PricingDate

OrderDate

OrderStartDa
te

OrderEndDate

useAdvanced
Approval

useDealOptim
izer

Type
ID

Datetime

Datetime

Datetime

Datetime

Boolean

Boolean

Required?

Yes

No

No

No

No

No

No

Description

The id of the Pricelist to be associated with the order.

Date and time associated with the order and
represent the date when the order will be priced.

Date and time when the order is created.

Date and time when the order fulfillment starts.

Date and time when the order fulfillment ends.

Whether to use advanced approval. The default value
is False.

Whether to use the Deal Optimizer. The default value
is False.

Parameter 2: Create Selected Purchase Order Item Data Object

Name

request

Type

Description

Apttus_CPQApIi.CPQ.SelectedPOltemDO | The request data object.
poltemDO

Request Data Object - poltemDO (Required for partial order only)

Field

POltemld

Productld

Quantity

StartDate

Type

ID

ID

Integer

Datetime

Required?

Yes

Yes

Yes

No

Description

Customer PO item number.

Customer Product item number.

Quantity of the order.

Date and time when the PO fulfillment starts.



Request Data Object - poltemDO (Required for partial order only)

Field Type Required? Description

EndDate Datetime | No Date and time when the PO fulfillment ends.
Selling Term Integer No Duration of the customer PO.

Comments Text No Any notes.

Sourceld ID Yes Source ID of the order. For example, Quote,

Contract, or Agreement ID.

Comments Text No Comments about the agreement.
ContractNum | Text No Contract number from the agreement.
bers

APl Response

Response Data Object - Apttus_CPQAPpi.CPQ.CreateOrderForPOResponseDO
Name Type Description

Orderld ID Order number which is created for customer PO.

Code Sample

String ACCOUNT_NAME = 'RY_Account_002"';

String PRICELIST_NAME = 'RY_PricelList';

Integer SELLING_TERM = 12;

Id CUSTOMER_PO_ID = 'a440R0000002Tif';

String SPLIT_ORDER_FIELD = 'RY_GroupingTest__c';
Id PO_ITEM_ID = 'a430R00000002tC';

Id SOURCE_ITEM_ID = 'aOWOROOOOOOITIF';

© oo N oo oA WN B

Account myAccount = [SELECT Id FROM Account WHERE Name =: ACCOUNT_NAME];
Apttus_Config2__PricelList__c myPricelList = [SELECT Id FROM
Apttus_Config2__PricelList__c WHERE Name =: PRICELIST_NAME];

=
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Apttus_Config2__CustomerPOItem__c poItem = [SELECT Id, RY_GroupingTest__c,
Apttus_Config2__ProductId__c, Apttus_Config2__Quantity__c,
Apttus_Config2__StartDate__c, Apttus_Config2__EndDate__c FROM
Apttus_Config2__CustomerPOItem__c WHERE Apttus_Config2__PurchaseOrderId__c
=: CUSTOMER_PO_ID AND Id =: PO_ITEM_ID LIMIT 1];

/*

Create Order for Customer Purchase Order Data Object x/
Apttus_CPQApi.CPQ.CreateOrderForPORequestDO request = new
Apttus_CPQApi.CPQ.CreateOrderForPORequestDO() ;

// Create the Order Input
Apttus_Config2__Order__c orderInputSO = new Apttus_Config2__Order__c();

orderInputSO.Apttus_Config2__SoldToAccountId__c = myAccount.Id;
orderInputSO.Apttus_Config2__PricelistId__c = myPricelList.Id;
orderInputSO.Apttus_Config2__PricingDate__c = Datetime.now();
orderInputSO.Apttus_Config2__OrderDate__c = Datetime.now();
orderInputSO.Apttus_Config2__OrderStartDate__c = Date.today();
orderInputSO.Apttus_Config2__OrderEndDate__c =
Date.today () .addMonths (SELLING_TERM) ;

request.OrderInput = orderInputSO;

// Add Order Properties (Optional)

request.Properties.add(new Apttus_Config2.Property('useAdvancedApproval',
'false'));

request.Properties.add(new Apttus_Config2.Property('useDealOptimizer',
'false'));

// Assign the Customer Purchase Order (For single order)
request.PurchaseOrderId = CUSTOMER_PO_ID;

// Add Order Items (Optional)

// Selecting Items
// Create Selected Purchase Order Item Data Object



48 Apttus_CPQApi.CPQ.SelectedPOItemDO poItemDO = new
Apttus_CPQApi.CPQ.SelectedPOItemDO(); (For partial order)

49

50 //webService Apttus_Config2__LineItem__c CustomData

51 //webService List CustomFields

52

53 poItemDO.POItemId = poltem.Id;

54 poItemDO.ProductId = poItem.Apttus_Config2__ProductId__c;

55 poItemDO.Quantity = poItem.Apttus_Config2__Quantity__c;

56 poItemDO.StartDate = poItem.Apttus_Config2__StartDate

57 poItemDO.EndDate = poItem.Apttus_Config2__EndDate__c;

58 poItemDO.SellingTerm =
Apttus_Config2.CPQWebService.computeTerm(poIltemDO.StartDate,poIltemDO.EndDa
te, 'Monthly');

S

59 poItemDO.Comments = 'Purchase order -item test';

60

61

62

63 // Set Additional Parameters From Source Line Item

64 poItemDO.Sourceld = SOURCE_ITEM_ID;

65 poItemDO.SourceFields.add('Apttus_QPConfig__Comments__c');

66 poItemDO.SourceFields.add('Apttus_QPConfig__ContractNumbers__c');

67 request.OrderItems.add(poItemDO);

68

69

70

71 // Split Order Criteria

72 //request.SplitGroupFields.add(SPLIT_ORDER_FIELD); (For group by orders)

73

74

75

76 // Create the Order(s)

7 Apttus_CPQApi.CPQ.CreateOrderForPOResponseD0O result =
Apttus_CPQApi.CPQWebService.createOrderForPO(request);

78 system.debug('Order Id = ' + result.OrderId);

Data Validation Service

You can invoke APIs in Data Validation Web Service (Apttus_Config2) from the following
command.



Apttus_Config2.CPQStruct.<Name of the Function>

where the name of the function is API Name and it parameters.
Use Data Validation Service APl to complete the following task:

- validateAndEnrich

validateAndEnrich

This API validates and enriches data for a Customer Purchase Order.

API Details

API Signature

acceptOrder webService static
Apttus_Config2.CPQStruct.DataValidateEnrichResult
validateAndEnrichSO(ld bObjectld)

Parameters

Name Type Description

request Apttus_Config2.CPQStruct.DataValidateEn | The request data object.

richResult validateAndEnrichSO

Request Data Object -

Apttus_Config2.CPQStruct.DataValidateEnrichResult

validateAndEnrichSO
Field Type  Required? Description
bObjectld 1D Yes Customer Purchase Order ID,

Order Item ID to enrich and
validate.

APl Response



Response Data Object - DataValidateEnrichResult

Field Type
IsSuccess boolean
Issuelogs List<Apttu
s_Config2
__Custom
erPOlssue
Log__c>
ModifiedSO | Map<ID,
bjects SObject>
NumErrors | Map<ID,
ByObject Integer>
NumWarni | Map<ID,
ngsByObje Integer>
ct
Code Sample

Description

Validation and Enrichment is a success.

True- If there are no issue logs created for validation error as part of the
execution.

False- If there are issue logs create for validation error as part of the
execution.

List of Issue logs generated for a given PO Item / PO while running the
validation rule and enrichment rule against it.

Objects Modified as Part of Enrichment rule. Key-Value Pair where Key is ID of
modified record and Value is record SObject with modified Value.

The number of Validation/Enrichment Error for each record. Key is record Id
and value is the number of Error Issue logs created for that record.

The number of Validation/Enrichment Warning for each record. Key is record Id
and value is the number of Warning Issue logs created for that record.

The following enables you to validate and enrich the data in the customer purchase order.

N
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Id customerPOId = 'a6PWOOOOOOO8WGY';
Apttus_Config2.CPQStruct.DataValidateEnrichResult response =
Apttus_Config2.DataValidationService.validateAndEnrichSO(customerPOId);

system.debug('IsSuccess=>"'+response.IsSuccess);

system.debug('Issuelogs=>"'+response.Issuelogs);

system.debug('NumErrorsByObject=>"'+response.NumErrorsByObject) ;

system.debug('NumWarningsByObject=>"'+response.NumWarningsByObject);



Scenarios

This section covers the following scenarios.

« Working with orders in Order Management.

Working with orders in Order Management

Once the purchase is confirmed, you (sales and customer support representatives) can
create an order as a confirmation before delivering goods and services.

To create a successful order:

In an Order page, create an order using Creating an Order.
In an order page, create a cart for an order using Creating a Cart for an Order.
Synchronize a new cart to order using Synchronizing a Cart to an Order.
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If you want to make the changes to the order, amend the order using Amending an
Order.
After all, reviewers have reviewed the order, accept the order using Accepting an Order.

o o

If the order is large and you want to divide the order based on different criteria, split
the order using Splitting an Order.

Troubleshooting Order Management SOAP
APIs

Refer to this topic for descriptions of APl error messages thrown by Salesforce and
suggested actions to take. An exception is an error caused during code execution. There are
a number of built-in Apex exceptions as well as custom exceptions provided by Conga.

The following exceptions are thrown by Salesforce that can be handled by Conga and
converted to custom error messages:

- System.Exception: Exception thrown under most circumstances.

- System.CalloutException: Exception thrown when communicating with external
systems.

- DMLException: Exception thrown when performing CRUD ('Create’, 'Read’, 'Update’,
'Delete’) actions.

Refer to the following table for a list of custom error messages provided by Conga for some
SOAP APIs, included suggested actions to take to resolve the exception.


https://documentation.apttus.com/display/OMSFSUM20APIG/Creating+an+Order
https://documentation.apttus.com/display/OMSFSUM20APIG/Creating+a+Cart+for+an+Order
https://documentation.apttus.com/display/OMSFSUM20APIG/Amending+an+Order
https://documentation.apttus.com/display/OMSFSUM20APIG/Accepting+an+Order
https://documentation.apttus.com/display/OMSFSUM20APIG/Splitting+an+Order

API

Apttus_Config2.
CustomerPOWe
bService.
acceptOrder

Apttus_Config2.
CustomerPOWe
bService.
amendCustome
rPO

Apttus_Config2.
CustomerPOWe
bService.
cloneCustomerP
O

Error Message

Add one or more PO Items to accept PO

You do not have the level of access
necessary to perform the operation you
requested. Contact the owner of the record
or your administrator if access is
necessary.

Customer Purchase Order with id: customer
PO Id Does not exist -

Accept is only allowed when Customer
Purchase order status is Draft, In
Amendment, or Pending Cancellation.

Amend is only allowed when Customer
Purchase order status is Accepted or
Partially Processed.

Only customer purchase orders in Accepted
status can be canceled.

You do not have the level of access
necessary to perform the operation you
requested. Contact the owner of the record

or your administrator if access is necessary.

You do not have the level of access
necessary to perform the operation you
requested. Contact the owner of the record

or your administrator if access is necessary.

Suggested Action

Ensure that you have added at
least one PO item.

Authentication or access (system
permissions) issue. Contact an
administrator or check the
appropriate topic for
authentication instructions.

Ensure that you have provided
the correct PO Id.

Ensure that your customer
purchase order status is Draft, In
Amendment, or Pending
Cancellation to accept the order.

Ensure that the status of the
Customer Purchase Order is
Accepted or Partially Processed.

Ensure that the status of the
Customer Purchase Order is
Accepted status to cancel the
order.

Authentication or access (system
permissions) issue. Contact an
administrator or check the
appropriate topic for
authentication instructions.

Authentication or access (system
permissions) issue. Contact an
administrator or check the
appropriate topic for
authentication instructions.



API

Apttus_Config2.
CustomerPOWe
bService.
UndoAmendCus
tomerPO

Apttus_Config2.
CustomerPOWe
bService.
cancelCustome
rPO

Apttus_Config2.
OrderWebServic
e.amendOrder

Error Message

You do not have the level of access
necessary to perform the operation you
requested. Contact the owner of the record
or your administrator if access is
necessary.

Only customer purchase order in Pending
Cancellation or In Amendment status can
be undone

You do not have the level of access
necessary to perform the operation you
requested. Contact the owner of the record
or your administrator if access is
necessary.

You do not have the level of access
necessary to perform the operation you
requested. Contact the owner of the record
or your administrator if access is
necessary.

Inflight Order Change is not enabled in
Order System Properties

Amend is only allowed when delayed
asset creation is enabled for the orders.

Assets are already created/updated for
this order so it cannot be amended.

Suggested Action

Authentication or access (system
permissions) issue. Contact an
administrator or check the
appropriate topic for
authentication instructions.

Ensure that the status of the
Customer Purchase Order is
either Pending Cancellation or In
Amendment status to undone the
Customer PO.

Authentication or access (system
permissions) issue. Contact an
administrator or check the
appropriate topic for
authentication instructions.

Authentication or access (system
permissions) issue. Contact an
administrator or check the
appropriate topic for
authentication instructions.

Ensure that you have enabled the
“Inflight Order change" in Order
System Properties.

Ensure that you have enabled the
"Create Asset On Order
Activation"in Order System
Properties.

Ensure that Assets are not
created for the order in case of
amend operation.



API

Apttus_Config?2.
OrderWebServic
e.cancelOrder

Apttus_Config?2.
OrderWebServic
e.undoCancelOr
der

Error Message

Only order in Pending, In Fulfillment, and
Partially Fulfilled status can be amended.

You do not have the level of access
necessary to perform the operation you
requested. Contact the owner of the record
or your administrator if access is
necessary.

Inflight Order Change is not enabled in
Order System Properties

Amend is only allowed when delayed asset
creation is enabled for the orders.

Assets are already created/updated for
this order so it cannot be amended.

You do not have the level of access
necessary to perform the operation you
requested. Contact the owner of the record

or your administrator if access is necessary.

Undo Cancel is available for orders in
Pending Cancellation status.

Inflight Order Change is not enabled in
Order System Properties.

Suggested Action

Ensure that the status of the
Order is Pending, In Fulfillment,
and Partially Fulfilled before
amending an order.

Authentication or access (system
permissions) issue. Contact an
administrator or check the
appropriate topic for
authentication instructions.

Ensure that you have enabled the
“Inflight Order change" in Order
System Properties.

Ensure that you have enabled the
"Create Asset On Order
Activation" in Order System
Properties.

Ensure that Assets are not
created for the order in case of
cancel operation.

Authentication or access (system
permissions) issue. Contact an
administrator or check the
appropriate topic for
authentication instructions.

Ensure that the status of the
order is Pending Cancellation.

Ensure that you have enabled the
“Inflight Order change" in Order
System Properties.



API

Apttus_Config2.
OrderWebServic
e.splitOrder

Apttus_Config2.
OrderWebServic
e.createRollupD
ata

Apttus_Config?2.
OrderWebServic
e.deleteRollupD
ata

Apttus_Config2.
OrderWebServic
e.commitincenti

veData

Apttus_Config2.
OrderWebServic
e.commitincenti

veLimitData

Error Message

You do not have the level of access
necessary to perform the operation you
requested. Contact the owner of the record
or your administrator if access is necessary.

Split is only allowed when order is in Draft
or Pending status with a Finalized Cart.

- Invalid input parameter(s) -
Orderld=orderld

- Invalid input parameter(s) -
Orderld=[]

- Invalid input parameter(s) -
OrderLineNumbers=[]

- Invalid input parameter(s) -
OrderLineNumbers= orderLineNumber

You do not have the level of access
necessary to perform the operation you
requested. Contact the owner of the record
or your administrator if access is necessary.

You do not have the level of access
necessary to perform the operation you
requested. Contact the owner of the record
or your administrator if access is necessary.

You do not have the level of access
necessary to perform the operation you
requested. Contact the owner of the record
or your administrator if access is necessary.

You do not have the level of access
necessary to perform the operation you
requested. Contact the owner of the record
or your administrator if access is necessary.

Suggested Action

Authentication or access (system
permissions) issue. Contact an
administrator or check the
appropriate topic for
authentication instructions.

Ensure that the status of the
order is draft or Pending with a
finalized cart or provide valid
input parameters.

Authentication or access (system
permissions) issue. Contact an
administrator or check the
appropriate topic for
authentication instructions.

Authentication or access (system
permissions) issue. Contact an
administrator or check the
appropriate topic for
authentication instructions.

Authentication or access (system
permissions) issue. Contact an
administrator or check the
appropriate topic for
authentication instructions.

Authentication or access (system
permissions) issue. Contact an
administrator or check the
appropriate topic for
authentication instructions.



API

Apttus_Config2.
OrderWebServic
e.commitincenti

veBenefitData

Apttus_Config?2.
OrderWebServic
e.createConfigu
rationRequest

Error Message

You do not have the level of access
necessary to perform the operation you
requested. Contact the owner of the record

or your administrator if access is necessary.

You do not have the level of access
necessary to perform the operation you
requested. Contact the owner of the record

or your administrator if access is necessary.

Suggested Action

Authentication or access (system
permissions) issue. Contact an
administrator or check the
appropriate topic for
authentication instructions.

Authentication or access (system
permissions) issue. Contact an
administrator or check the
appropriate topic for
authentication instructions.

The following are standard Salesforce exceptions that cannot be handled or changed:

- LimitException

- UnexpectedException

- AssertException

- NoAccessException

- NoDataFoundException

- SerializationException

- VisualforceException

You can learn more about these exceptions and recommended actions to take by

consulting Salesforce documentation.


https://developer.salesforce.com/docs/atlas.en-us.apexcode.meta/apexcode/apex_classes_exception_methods.htm

Order Management Feature by Release

Review the latest Order Management Features by Release document.

- Features by Release

Features by Release

This document contains an overview of features introduced in each major release of Conga
Order Management. For more information, see Order Management Features by Release.


https://documentation.conga.com/features-by-release/order-management-features-by-release-165937772.html

Conga Customer Community & Learning
Center Resources

The Conga Customer Community is your one-stop shop for success!

After registering as a new member, you’ll gain access to a wide variety of resources, from a
personalized onboarding checklist to free expert-led webinars, to our thought-leadership blog! It's
also your portal to manage your Conga account, access the Install Center, and submit
support tickets.

You can also access the Conga Learning Center. All customers get access to a limited
catalog of getting started courses. Consider upgrading to the Conga Learning Pass to
unlock the premium training subscription.

Ready to get started?

Log into the Conga Customer Community with your credentials.

Not yet registered? No problem. Set up an account to receive your login credentials via our

registration page.
After you log in, there are 2 ways to access the Conga Learning Center:

- On the main page, click the Learning Center tile.
- Navigate to the “Resources” dropdown menu at the top, then click the “Learning

Center” option.


https://community.conga.com/s/get-started
https://community.conga.com/s/webinars
https://community.conga.com/s/blog
https://community.conga.com/s/learning-center
https://community.conga.com/
http://community.conga.com/s/registration

Conga Copyright Disclaimer

Copyright © 2023 Apttus Corporation (“Conga”) and/or its affiliates. All rights reserved.

No part of this document, or any information linked to or referenced herein, may be reproduced, distributed, or
transmitted in any form or by any means, including photocopying, recording, or other electronic or
mechanical methods, without the prior written consent of Conga.. All information contained herein is subject
to change without notice and is not warranted to be error free.

This document may describe certain features and functionality of software that Conga makes available for
use under a license agreement containing restrictions on use and disclosure and are protected by intellectual
property laws. Except as expressly permitted in your license agreement or allowed by law, you may not, in
any form, or by any means, use, copy, reproduce, translate, broadcast, modify, license, transmit, distribute,
exhibit, perform, publish, or display any part of the software. Reverse engineering, disassembly, decompilation
of, or the creation of derivative work(s) from, the software is strictly prohibited. Additionally, this document
may contain descriptions of software modules that are optional and for which you may not have purchased
a license. As a result, your specific software solution and/or implementation may differ from those described
in this document.

U.S. GOVERNMENT END USERS: Conga software, including any operating system(s), integrated software, any
programs installed on the hardware, and/or documentation, delivered to U.S. Government end users are
“commercial computer software” pursuant to the applicable Federal Acquisition Regulation and agency-
specific supplemental regulations. As such, use, duplication, disclosure, modification, and adaptation of the
programs, including any operating system, integrated software, any programs installed on the hardware,
and/or documentation, shall be subject to license terms and license restrictions applicable to the programs.
No other rights are granted to the U.S. Government.

Neither the software nor the documentation were developed or intended for use in any inherently dangerous
applications, including applications that may create a risk of personal injury. If you use this software or
hardware in dangerous applications, then you shall be responsible to take all appropriate fail-safe, backup,
redundancy, and other measures to ensure its safe use. Conga and its affiliates disclaim any liability for any
damages caused by use of this software or hardware in dangerous applications.

Apttus, Al Analyze, Conga, Conga Al, Conga Al Discover, Conga Batch, Conga Collaborate, Conga Composer,
Conga Conductor, Conga Connect, Conga Courier, Conga Grid, Conga Mail Merge, Conga Merge, Conga
Orchestrate, Conga Sign, Conga Trigger, Digital Document Transformation, True-Up, and X-Author are
registered trademarks of Conga and/or its affiliates.

The documentation and/or software may provide links to web sites and access to content, products, and
services from third parties. Conga is not responsible for the availability of, or any content provided by third
parties. You bear all risks associated with the use of such content. If you choose to purchase any products or
services from a third party, the relationship is directly between you and the third party. Conga is not
responsible for: (@) the quality of third-party products or services; or (b) fulfilling any of the terms of the
agreement with the third party, including delivery of products or services and warranty obligations related to
purchased products or services. Conga is not responsible for any loss or damage of any sort that you may
incur from dealing with any third party.

For additional resources and support, please visit https://community.conga.com.
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